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[TpbAoyoq

Tic TeheuTaieq OekaeTieq €xel avadeixtel w¢ npéPAnpa peiovoc onpaciag n
npoofoAr Tou Toniou and Ta PETAMEUTIKG €pya. AVTIKEINEVO TNG OINAWMATIKAG
gival n dnpioupyia evog eUxpNoTou gpyaleiou yia TOV NOCOTIKO NPOOdIOPIoUS
TNG peTaBOAG Tou avayAdpou and eniPpavelakés ekPeTaAeUoEIG, a&lonolwvTag
Tn pebodoAoyia LETOPID.

H AinAwpatikn Epyaoia dopeitar wg akoholdwg:

e 2710 1° Kepdhaio TnG epyaciag, avapépovral Bacikd oToIxela yia Tnv
aMoiwon Tou Toniou and Tn PeTaAeuTIKA dpPaoTNPIGTNTA, KABWGE KAl yia
Tn peBodoloyia npoodiopiopold TG PeTABOANG Mou MPOkKaAAsiTal oTo
avayAugpo and unaidpieg ekpeTaleloelg oUppwva pe TNV pebodoAoyia
“LETOPID”.

e 210 2° Kepdlaio napouocidlovrar Ta TewypaPikd ZuoTApaTta
MAnpogopiwy, To Aoyiopikd ArcGlIS kal n diadikaoia nou akoAoubribnke
yla Tnv avdntuén Tou epyaleiou autopatonoinong tng Oladikaoiag
unohoylopoU TnG peTaBoArg Tou avayAdgou.

e 210 3° Kepdhalo napoucidletal n  yAwooa Python (10TOpIKG,
XAPAKTNPIOTIKA) - N onoia XPNoIgonoindnke yia Tnv dnuioupyia KwoIka
nou anoTeAel HEPOG TOU epyaleiou — kal N doPN TOU KWOIKA.

e 210 4° KepdAaio napouoidovrar Ta anoTeAéopaTa epappoyrig Tou

gpyaleiou nou avanTuxdnke.

e 2710 5° KepdAaio n epyacia ohokAnpwveral pge Ta oupnepdopaTa.

H oAokAripwon Tng napoudoag dinAwpaTikiAG epyaciag, 0g Ba nTav duvaTti xwpig
Tnv  BoriBeia  opiopévwv  npoownwyv, n oupPfoAl Twv onoiwv unnipée

kaBopioTikA npokelpgévou va dieknepalwdel autn n gpyaocia.

Apxikd, 6a nBeha va euxapiotnow Tnv enifAénouca TNG gpyaociag kupia
Meveydkn Mapia, Enikoupn KaOnyritpia EMII, yiati xwpic Tnv yevvaiddwpn
OuVvOpPOMN TNG TN ouvexn kabodrynon Kkal TIG EMNIOTNPOVIKEG YVWOEIG MOU JOU
napeixe, ¢ Oa nrav duvatdé va npaypatonoin®si n gpyaocia autd. Tnv
EUXAPIOTW aKOMPN yIa TNV egnioTooUvn nou pou €3e1ée kab’ dAn Tn didpkeia TNG

eknévnong TNG OIMAWPATIKAG.



‘Eva peydho euxapiotwy opeihw kar otov kUplo Aapiyo Anuntpn, Enikoupo
Kabnynti EMIT kai péhog Tng TpigeAolq emTponmng, yia TNV OUVEPYAOIa Mou
avéntuée padi pou kal yia TIGC NOAUTIMEG YVWOEIC NMOU POU Mapeixe Katd Tn
dIdpKEIa TwV oNoudWY Pou, ONwE eNiONG yia TN CUPPETOXA TOU OTNV TPIPEAR

enmiTponn.

EniBupw va euxapiothow enionc Tov Nwpyo [lMavayiwténouAo, unoyneio
d10dkTopa TNG oxoA¢ Mnxavikwyv MetaMeiwv - MeTalMoupywv kal péAog Tou
gpyaoTnpiou MeTaMeuTikiG Texvohoyiac & MepiBarrovTiking MeTAMEUTIKAG, yia

TIG MOAUTIMEG OUMPBOUAEG MOU poU Napeixe oTov Topéa Tou Aoylopikou ArcGlS.

Téhog, aioBdvopal Tnv avdykn va guxapioTiow OpIoPéva PEAN TNG KOIVOTNTAG
GIS StackExchange nou ritav noAd npdbupa va pereTnioouv KOPPATIO TOU
KWOIKa nou avanTtuxOnke oe nepiBdMov Python kar va pe oupPouievoouv
ndvw oTnV owoTA anoo@PAAPdTwon Tou. XTa nAaiocla autd, €UXapioTwW TOUG

xprioTeg PolyGeo, Joseph, fluidmotion kar HavardMoe.



[MepiAnyin

AvTikeipevo TNG napouoag dINAwPATIKAG epyaciag eival n avdntuén kwdIka o€
nepiBdAov GIS, pe otéxo TNV autopaTtonoinon Tng d1adIkaoiag ekTiuNoNG Kal
unohoylopoU TnG peTaBoAng Tou avayAugpou oe unaidpieg ekueTaAMeUoelg, nou

anoTeAel p€pog Tng peBodohoyiag “LETOPID".

Na To okond autd, avantuxonke €va gpyaleio oupPatd pe 1o Aoyiopiké ArcGlIS
10.71 (A vedtepn €kdoon) Tng ESRI, nou ovopdotnke “TRAC” (Topographic Relief
Alteration Calculator - Ynohoyiopdg MetaBoAri¢ AvayAdgpou). To gpyaleio autd
avantuxdnke péoa and Tnv dnpioupyia evog poviéAdou nou anoTeAeitar and
POEC epyaoiwv yewenegpyaoiag kar oTaTioTiKAG avAAuong Kai eNITPENEl TNV
NOOOTIKA EKTIUNON TwV EMNNTWOEWY NOoU MNpPokaAouvral and Tn PETAMEUTIKA
dpaotnpidtnTa oT0 apxIkd avdyAugo Tng neploxng. 1o ouykekpipéva,
anoteAeitar  andé (i) eikool  Téooegpa  napapeTpononuéva  gpyaleia
Yewene&epyaoiag yia TNV dnuIoupyia Twv EMNIPAVEIDV PE TNV ANAITOUPEVN
nAnpogopia kar (i) €vav kwdika 750 ypappwy, dounuévo oe yAwooa
npoypappatiopgou Python. Méoa and Tnv ektéheon piag oglpds pabnpaTtikwy
ouvaptioewy, Odlevepyeltal N oTamioTikA  avdAuon  TwV  YEWYPAPIKWY
XAPOAKTNPIOTIKWY  TWV  ENIPAVEIDY KAl unoloyi¢etal o Babudg petafoAng

avayAdgou.

ZupnepaopaTikd, npokuntel nw¢ péoa and tnv avdntuén Tou epyaleiou
“TRAC”, autopatonolgitar o npoodlopdinds Tou Babuolu MetaBoAig Tou
apxikoU avayhigou and eniPavelakeg ekpeTaMevoeic. O xprioTng Tou
epyaleiou xwpic 1d1aiTepn epneipia oe AoyiopikG TZIN pnopel va e&dyer Tnv
OXETIKA NANPOPOPIa VW TAUTOXPOVA MEIWVETAI OPAOTIKA O ANAITOUHPEVOG
xpoévog ekTéAeonc TnG peBodoloyiag. Téhog, diaopaAidetal n enavaAnyiudérnTta
KAl QVTIKEIMEVIKOTNTA OoThV ekTéAeon Tng dladikaoiag, apou 6Aa Ta evdidpeoa

oTddlIa €ival TunonoiNuéva.



Abstract

Aim of the present thesis is the development of a code in GIS environment, in
order to automate the process of assessing and calculating the alteration of
topographic relief due to surface mining operations, which is part of the
methodology "LETOPID".

To this end, a tool compatible with the software ArcGIS 10.1 (or later) of ESRI
was developed and named "TRAC" (Topographic Relief Alteration Calculator).
The tool was developed through the creation of a model consisting of
geoprocessing workflows and statistical analysis allowing the quantification of
the effects caused by the mining activity in the original landscape. More
specifically, it consists of (i) twenty-four parameterized geoprocessing tools for
creating surfaces with the required information, and (ii) a source code of 750
lines, structured in Python programming language, which by executing a series
of mathematical functions, performs statistical analysis of geographical
characteristics of surfaces and calculates the degree of topographic relief

alteration.

In conclusion, it appears that through the development of the tool "TRAC", the
quantification of the degree of TRA from surface mining activities is automated.
The user of the tool, without much experience in GIS software, can obtain the
relative information of the change in the landscape. Simultaneously, the time
required for the implementation of the methodology is radically reduced.
Finally, the developed tool ensures repeatability and objectivity in performing

the procedure, since all intermediate stages are standardized.
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Eloaywyn

H alMoiwon Tou Tonfou and tn PeTAMeUTIKNA

dpaoTnpIdTNTA

Ané tnv apxaidétnta PEXPI Kal oNPEPA, N PETAANEUTIKA OPaoTNPIOTNTA €XEl
emteAéoel onpavTikd poAo oTnv avdnTuén kal otnv NPOodo TNG KOIVwVIag.
Mnopei va einwbel, nw¢ n  d1a n Unap&n TnG olyxpovng KoIvwviag eival
dppnkta ouvoedepévn kal e&apTdtal and Tnv Unapén TnG PETAMEUTIKAG
dpaoTnPIOTNTAG  KABWG o1  ouyxpoveG avdykeg (akOpa Kal AV QUTEQ
NeEPIOPIOTOUV OTIG OUCIAOTIKEG Kal analaxBoulv and Tig NePITTEG) anaitolv TNV
napaywyn OpUKTWV MNpwTwv Ulwv. [Map’ o6Aa autd, n petareuTiki

OpPaOTNPIOTNTA €XEI OPATEG ENNTWOEIG OTO PUOIKO NEPIBAAIOV.

Q¢ npéPAnpa peidovog onpaociag €xel avadelxTel TIGC TeAeuTaleq OEKAETIEC N
npoofoAri Tou Toniou and peTaMeuTikG €pya. XUppwva pe Toug¢ Down &
Stocks (1978), Sengupta (1993) «kar Balkau (1995), n peraMeuTikn
dpaoTnNPIOTNTA, ANd TIC NPWTEG OUOTNUATIKEG NPOoNAOeleq eE6PUENG OPUKTWV
NPWTWV  UAWYV, ouvodeleTal pe  To  nNpoBAnpa Tng  aMoiwong  Twv

XOPAKTNPIOTIKWY TOU Toniou.

O Gagen (1992) avagépel 611 n “oldyxpovn PeTAMeUTIKA dpaoTnpidTNTa €ival
IKavA va peTaBdAAer To @uoikd Tonio nepioodTepo and onoladnnote AN
dpaotnpidtnTa oe kalpd eprnvng”. O Sengupta (1993), xapaktnpiel Tn
METAAAEUTIKNA WG «...dia and TIG NAEOV OPATEG KAl KATAOTPOPIKEG OPACTNPIOTNTEG
AOYW TwV PUOIKWYV Kal A10ONTIKWY ENINTWOEWY NOU NPOKAAE» Kal yia TO AGyo
auTtd Bewpei 6T Npéner va NPoodideTal IDIAITEPN NMPOOCOXNA «OTNV KATAOTPOPN
TOoU TOmfou Kkal TNV unoBdOuion Tou onTikoU nePIBAMOVTOC».  AVTIOTOIXEQ
andyeic éxouv ekppaotei and Touc Marcus (1997) kar Danni (1997), o1 onoiol
Bewpouv TN PeETaMEUTIKA WG pIa «évTova opatr dpaotnpidtnTa». O MacDonell
(1997) unootnpiCer OTI 01 ENINTWOEIG OTO TONO EMNOPOUV DUOMEVWIC OTNV EIKOVA
nou oxnuaTidel To KoIVwVIKG oUvoho yia Tnv €{opukTIkA PBlopnxavia, evw o
Turner (1998) ToviCel 611 «oI QI0ONTIKEG €NINTWOEIC and Tn PETAMEeUTIKNA
opaotnpidTNTa Ogv MPEMEl va  UNOTIMWVTAI O€  KAWia nepintwon»  Kal

enionpaivel 70 O€pa TG «KAKAG KANPOVOPIAG» TwV €KATOVTAdWY  XIAIAdWY



AVeEVEPYWV eKPETAMEUOEWY, 01 OMNOIEC €xouv aPrioel ave&iTnAa Ta onpddia Toug

MExpl onpepa (Meveydkn, 2003).

Y0pgpwva pe Tous Kahiapndkog & Aapiyog (1998a), n onpacia Twv eNINTWOEWY
oTo Tonio eival avayvwpliopévn and 10 oUVOAO Tou PeTaMeuTIKOU KAGOOU Kal

anoteAel avandéonaoTo THNRPA TG oUyxpovng nepiarlovTikng vopodeoiag.

H e&opukTikin dpaotnpidtnta, Oev eival a priori enikivduvn oUTe a priori
nepifarrovtikd acUppopn. H avapevépevn «BAABN» onpepa oto Tonio, pnopef

va gival unod NPounobEoelg NEPIOPIOPEVN, MPOOWPIVA KAl AvAoTPEPIUN.

H Meveydkn (2003) ava@épel Nwg «n €peuva OTO OUYKEKPIPEVO nedio eival
MEXPI ONPEPQ  MEPIOPIOHPEVN, YEYOVOG MOu  €pxeral o€ avriBeon pe TO
evdlapEépov nou epgaviceTar yia autd, Je anotéheopa kdbe pia nepintwon va

avTigeTwni¢eTal ad hoc».

O1 Aoyor nou n kdBe nepintwon avripetwnidetal ad hoc kal Oxi Pe pia
yevikeupévn pebodoloyia eival didTI undpxouv pia ogipd and duokoAieg T6oo
OoTnV  EKTiUNON  Twv EMNNTWOEWV OTO Tomio, OO0 Kkal oTnv  e&elpeon

QNOTEAEOPATIKWVY KAl KOIVWV ANOJEKTWV AUOEWV.

O1 kup1OTEPEG OUOKOAIEG Nou evronidovTal OoTNV EKTINNON TWV EMINTWOEWY OTO
Tonio, €ival ol akOAoubec:

i.  Agv undpxouv PEXPI oNPEPa KoIVA anodekTéG heBodoAoyiEg, o1 onoies va
MNOPOUV VA EKTIMAOOUV ME QVTIKEIMEVIKO TPOMO TO MEyeBOC Twv
MeTaBoAwyv nou enipépel pia ekpeTdAeuon oTo Tonio.

i.  MoAovoTi n ouyxpovn nepiBalrovtikr vopoBeoia anaitel Tnv npootaocia
TOU Toniou o€ 100TIPN BAonN PE TOUG UNOAOINOUG PUOIKOUG NOPOUG, OeV
uNdPXoUV OAPWS NPOODIOPIOPEVA KAl VEVIKG anodekTd KPITAPIO Kal
peBodOoAoyiEG ekTiunoNg, dnw¢ ocupPaivel N.x. Je TNV NOIGTNTA TOU A€PQl,
TOU NOOIPOU VEPOU, K.AM.

iii. H aio0nTikn aMoiwon Tou ToOniou evrdooeTal OTNV KATNyopia Twv
npoPAnpdTwWY «gulwiag». Katd ouvéneia, eival e&aipetikd dUokoAo va
oploTel €va anodektd eninedo «punavong» Tou Toniou. (Meveydkn,

2003)



O1 duokohiec auTéq anoTeholv Tpoxonédn oTnv eEEUPEON ANOTEAEOPATIKWY KAl
KOIVA  anodekTwyv Adoewv. Opiopéveg, Opwg  Pacikée NapdPeTpol  TOu

npoPAnpaTog niECouv nNpog autn Tnv katelbuvon, AToI:

i.  Ta €10IKd XapaKTNPIOTIKA Tou peTaMeuTIKOU kKAGOOU, T onoia anokTouv
BapuTtnTa yia To NPORANUA, 1IBIAITEPA OTIC AVANTUYHEVEC XWPEC

i.  TO OlOpKWG au&éavopevo evolaPEPOV yia TO Tomio, andéppola Kal TNg
YEVIKOTEPNG NEPIBAAMOVTIKAG apUNVIONG TwV TEAEUTAIWY OEKAETIWV

iii. ol avayvwpIiohéveG MNAEOV  KOIVWVIKO-OIKOVOMUIKEG  OUVIOTWOEG  TOU
nPoPBAARPATOC TNG ONTIKAG PUNAVONG, Ol OMOIEG OE APKETEG NEPINTWOEIG
odriynoav otnv dpon Tn¢ Asimroupyiag Twv ekpeTaledoewv?’. (Meveydkn,
2003)

Me Bdon T1a napandvw, TO0 Epyaomipio MetaMeuTikig Texvoloyiag kal
MepiBarovtikig MeTaMeuTikiAG €xel avantu&el pia pebBodohoyia yia Tnv
NOOOTIKA €KTIMNON TWV €MNTWOEWY OTO Tonio and Ta PeETAMEeUTIKG €pya
yvwot  pe Tnv  ovopacia “LETOPID” (Meveydkn, 2003; Menegaki &
Kaliampakos, 2005; Menegaki & Kaliampakos, 2006; Menegaki & Kaliampakos,
2012). H pebodoloyia “LETOPID” éxel cav Paocikéc napapérpoug @ Tnv
eKTiINON TN¢ PETAROARC TNG POPPHC KAl TWV YPAUPWY Tou avayAdgou kar P

TOV NPOOdIOPIoPS TNG evalocbnoiag NnapaThPNONG.

H napodoa dinAwpatikh epyacia, oToxelel OTNV NPOCApPPOyR KAl oTnv
autoparonoinon pépouc TnG pebodoioyiag “LETOPID” doov agopd Tnv
ekTiynon  TnG  petaBoAnc avayAugou, péoa and  Tnv  agonoinon  Twv

dUVATOTATWY NOU NPOCPEPOUV Mo oUyxpova Aoylopikd MZI1.

2TIG endpevVeG evOTNTEG TOU KepaAlaiou, napouciddovTal ouvonTIKG BACIKESG
€vvoleq yia TNV avdAuon Ttoniou, aAd kal To BewpnTiké uNnéBabpo nou
anaiTeital yia Tnv katavénon Tou Tpénou Aeiroupyiag Tng pebodoloyiag
“LETOPID”.

''H ouvrpinTiki nAgloPN@ia Twv eNIGAVEIAKWDY PETAMEIWY EvavTl Twv unoyeiwy, n BapdTnta Twv
adpavwyv UAIKWV 070 oUvoAo TnG MPeTaMeuUTIKAG napaywyri¢ (énou n avdnTugn AaTopeiwv
adpavwyv yiveTal KUpiwg o€ yeiTovia pe Tov aoTikG 10TO) kal N Unapén onpavtikol apiBpou
AVEVEPYWV — YN ANOKATACTNPEVWY PETAMEIWV

2 O1 évioveg avmdPdoelc ToU KOOMOU yia TIC aIoBNTIKEC emMNTWOEIC oTo nePIBAMov Tng
euUpUTEPNG TOU AaTOMPEIOU MEPIOXAG KAl Ol OIKOVOMIKEG CUVEMEIEG OTNV a&ia Twv KATOIKIWY
(BeTIKEG N apvNTIKEG) AOyw TNG peTAPBOAG Tou nepifdAlovTog Toniou



KepdAaio T

YTOIXElO yIa TNV avAAuon TOU Tomniou KAl eKTiPNoN
TNG METABOANG TOU avayAu@ou oUppwva

pe Tnv pebodoloyia LETOPID

1.1 Opioyoi Kal avTIAMAYPEIC VIa Th OIAOXEIDION TOU TOMNiou

1.1.1 H iotopia Tng é€vvoiag Tou Toniou oTto AuTIKG KGGHO

H ayyAikin Aé€n landscape (yeppaviknig npoéAeuong) eival ouvBetn and TIg
ouoTaTikEG Aé&eig land kail scape. To ouoTtatiké land oripaive apxikd otn yoTOikn
yAwooa opyavwpevo 1 kaMiEpyNPEvo xwpd@r 1 akOPa Kal TIG AQUAAKIEG TOu
apdTpou OTo XWPJPIl. XTo Meoaiwva orpaive KaBOPIoOPEVO TUAPa TNG YAIVNG
ENIPAVEIAG, VW) apYOTEPQ YeVIKA €vav oploBeTNUEVO XxwPOo. TNa dUo XIANETNPIOES
TO0 ouoTaTikd land oTo Apegpikavikd Oikalo eEakoAouBei va onpaivel «Ténog /
Oéon kabopiopévwy  dlaotdoewv  nou  Bewpeitar  TUApG  TNG  yAIvng
ENIPAVEIAG...». 210 NOTO Twv H.M.A. kar To Hvwuévo Baoikeio land onpaivel
aképn unodiaipeon xwpa@iol N auldkl opywuatog nepinou 6 nédia papdu
EVW OTNV XKWTIa onpaivel Tunpa unodiaipodpevo o€ onimia 1 dlapepiopara.
Efval pavepd nw¢ n odyxuon nou enikpatel, nnydder and 1o noAudidoTaTto Tng
évvolag landscape. To deUtepo ouvleTikd Tou Opou, n AéEn scape, eival
ouvwvUpPn e Tn Aéén shape (oxripa, poperi), nou nahid onpaive «ouvBeon
and napdépola avTikeipeva» opiel ouloyikéc diaoTdoelg Tou nepIBAAAovTog
(Meveydkn, 2003).

H A€n landscape yia xihia xpdvia, oripaive aképa oTnv Kadnpepivii TNG xpron
«KOMMATI opyavwuévou eddpous (< 1 OTPEPPATOC)», apydTeEPA  «EKTAON
akivnTng neplouoiag evog xwploU» (eite daoikn, eite AiBadikni) kal TEAOG To D10
10 Hvwpévo Baoileio. And tov 17° oto 18° aiwva, n €vvoila Tou Toniou
EI0AYETAI OTOV EMIOTNPOVIKO XWPO. XUPPwva pe Tov Humboldt (1849) oiveral
oTov 0pO0 N €vvoia TNG PUOIKAG OVTOTNTAG OTO TOM{o, Nou anoTeAel To oUvolo
TWV XAPAKTNPIOTIKWY MIAG NeEPIOXAC. XTOo OgUTEPO MIod Tou 19° aiwva n
nohuoUvOeTn €vvola Tou Tomiou xdveTal, Kal Ogv ANOTEAEl QAVTIKEIUEVO

EMNIOTNPOVIKAG dlgpedvnong. Tnv auyn Tou 20% aiwva o Blache kar dAoi
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gpeuvNTEG (ONwe avagepetal anod Tress & Tress, 2001) enavelodyouv TNV €vvola

TOU ToMniou w¢ enoTnpovikou nediou (Meveydkn, 2003).

Autril n avadpopn otnv 1oTopia TG AéENG, nou odnyel oTnv avakdluyn SAwv
TWV EVVOIOAOYIKWV ANOXPWOEWY Tou VONPATog TNG, unoypaupidel 6T To Tonio
dev gival anAd €va @uoikd oToixeio Tou nepPIBAAovTog ald évag ouvOEeTIKOC

avBpwnoyevig xwpog (TepkevAn, 1996).
1.1.2 Opiopoi yia To Tonio kai TNV aiodnTikA Tou oTtov 20° aiwva

Y0pgpwva pe Tnv Meveydkn (2003) 1o «Tomio» w¢ 6pO¢ akdun Kal OAPEPQ,
dlapépel HeTAEU TwV €peuvNTWY, avdloya PE TIC MPOCWMIKEG EUNEIPIES, TIG
YVWOEIG Kal ToVv KAGOO TNG eNOTAPNG PE ToV onoio aoxolouvTal. Xe Ae€ikd TnG
EAANVIKAG yAwooag, wg tonio opidetar pia unai@pia Tonobeoia nou epgpavicel
oplopevn ouvoAikii B€a kal nou 10iw¢ kivel TO a10ONTIKG  evOlaPEPOV
(Anpntpdkou, 1964), evi) naipvel dIAPOPETIKEG EVVOIEC AVTIOTOIXAO O€ AEEIKA TNG
ayyAIknig kal yaAikng yA\wooag énou 1o tonio opi¢etal wg GUOIKA 1 GpavTaoTIKA
O¢a piag nepioxng nepidapPdvovrag pe autdév Tov TPOMO KAl MIVAKES
{wypagIkng, GwToypadiec 1 onoladnnote GAAN gikovik avanapdotaon evog
Toniou (Allen, 1990) kal wq «TO PEPOG PIAG NEPIOXNAG MOU N GpUON NAPOUOCIALEl
otov napatnpntri» (ROBERT). “Exouv Olatunwbei tov 20° aiwva noAhof
dlapopEeTIKOl opiopol yia To TOomio, npoonadwvrag va To NepiypdPouv e
dlapopeTikA npoogyyion, pebodoloyia kal yAwooa, and noAhouq epeuvnTEQ
onwg o Delpoux (1972), o Richard (1973), o1 Hull ka1 Revel (1989) k.a.

To Tonio BewpeiTal wG 0IkooUOTNHA, AVTIKEIUEVO WEAETNG KAl yVWONG, ONTIKA
€IkOva, PIOUPEVOC XWPOG, PECO IKAVONOINONG Twv avlpwnivwy avaykwy, K.Am.
XwPIiG va €xel npokUyel pia anodekt pebodoloyia kal yAwooa npoogyyiong
METAEU Twv JIAPOPWY EPEUVNTWY. 2ZUxvd 0 OpPIoPoG “noidétnta Tou Toniou”
(landscape quality) nepidapBdver €va nAnBog nepiBarlovTikwy - OIKOAOYIKWY,

KOIVWVIKWY - MOAITIOTIKWV Kal YuxoAoyikwv napayoviwy (Meveydkn, 2003).

H nAnBwpa Twv opiopgwyv kal avriAiPewv nou €xel va emodeifel n O1EOVAG
BiBAioypapia avdyetal ouoiaoTikd og OUO TPOMOUG MEAETNG TOU XWPOU MOU

nepIBAMer kal nepikAeiel Ta Tonia Ta onoia NPokahoUv To evOIAPEPOV:



- 0€ AQUTOV NoU €Xel WG KEVIPO avapopdc Tov dvBpwno, dnAadn peleTd
ToV TPONo pe Tov onoio ol dvBpwnol avriAapBdvovral To Tonio Kal
OUVIOTA TNV UMOKEIYEVIKNA NPOOCEYYION TOU TOMiou, Kal

- 0g QUTOV nou Oewpel TO XWPO WG QAVTIKEIMEVO  €MIOTNUOVIKNAG
napatipnong, OnAadn  aoxoAeiTar pE TN yvwon  Tou  puoikou
nePIBAANOVTOC KAl TwV PETPACIPHWY NAPAYOVTWY TOU KAl OuvioTd Tnv

aVTIKEIYEVIKNA Npoogyyion Tou Tonfou (Meveydkn, 2003).

To Tonio 6pw¢ dev eival ouTe oikooUoTnua, ouTte onTikA €Ikéva, oUTe BIoUPEVOG
XWPOG HOvo, aMd éva eviaio ouvolo, anotéheopa aMnAenidpaong kai
aMnAeédpTnong noMwv  enipépoug napayéviwy nou dgv  pnopoulv  va

e&eTaoBouv ave&dprtnta (Meveydkn, 2003).

2e éva OeOONEVO XWPO, UNApPXel Pia olkoAoyIkn NPAyuaTikOTNTA PE DIAPOPETIKO
Babpod eEENENg, 100pponiag kar avbpwnivng enéufaong, nou pnopei va
avaAuBei avTikelpyevikd kal n onofa divel oTov napatnpnti pia eikdéva pe
OUYKEKPIMEVA  XapakTnpEIoTikd. ‘Opwg, Tnv npaypankérnta auti o KE0e
napatnenTic 6a Tnv avriAngOei diapopeTIkG, unokelpevikd, avdloya HeE TIG
YVWOEIG TOU, TIG EMNEIPIEG KAI TO 100G TwV OXECEWV NOU dIATNPE( e auTd. KaTw
andé Tn Bewpnon aut To Tonio Ba pnopouoe va oplobel w¢ «To olkooUoTNua
MIaG NePIOXNG - KAIPa, €daPog, NETpwua, pualoypapia, xAwpida, navida kal ol
OUVAMIKEG TOUG OXEOEIG - enNpeacpévo oe noikido Babud and Tic avBpwniveg
OPAOTNPIOTNTEG KAI TA PUOIKG PAIVOPEVA, N EEWTEPIKN EPPAVION TOU OMoiou
yivetal avriAnnti ouvoAikd 11 anoonacpatikd kal Katd OlaPopPeTIKO TPONo and
Tov dvbpwno avdAoya He TO KOIVWVIKO - MOMTIOTIKO Tou  €NiNedo»

(Mnpdpag, 1989).

To Ttonio Aomndv, eival aQvTiKelyeEVO €NIOTNPOVIKAG NAPATAPNONG W¢ OMTIKA
epneipia kar o evepyog napdyovrag Bewpeitar o dvbpwnog dI6TI Opa Kal
peTaBdMer To Tonfo. H onTiki enintwon (visual impact) otnv noiétnta Tou
Toniou oxeTiCeTal pe TIC ahay€C nou npokaloUvral o€ Pia nepIoxn and Tnv

avdantuén piag véag dpaotnpidétntag (Amir kai Gidalizon, 1990).

MpdypaT 0 dvOpwnog IKavonoliwvtag TiIG (WTIKEG TOu avaAykes (Tpoen, EUAo yia
Oéppavon Kal KATAOKEUEG, EKXEPOWOEIG yia KaMiEpyeia kal BookdTonoug,

EKOKAQEG yIa UAIKA K.AM.) anoTtéAeoe otaBepd kal (wvravo oToIXelo Tou Toniou
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oupPBdMovTag ouyxpdvwg oTnv  enegegpyaoia  TnG @Quoloyvwpiag Tou. H
puoloyvwpia autn «n onoia dgv nTtav noté otabepri ald avribeta oe diapkn
e&€NEn», ouvdedTaV OTEVA pE TO €NiNedO TNG OIKOVOUIKAG, TEXVOAOYIKAG Kal
KOIVWVIKAG eEENENG Tou avBpwnou (Kahapndkog, 1995). ‘Etol, avdloya pe TIg
duVATOTNTEG KAl TNV €vTaon enéufaong dnuioupynonke pia kAjpaka Toniwv and

Ta napBéva péxpr Ta kabapd avBpwnoyevi Tonia (Meveydkn, 2003).

H aic0nTmikni €ival enfong pia évvola nou éxel npoAnuatiosl diaxpovikd kal nou
nAéov éxel avaxBei oe eniotiun. lMpdkerar yia éva @IAoocoPpikd KAddO nou
AOXOAEITAI PE TNV TEXVN EMNOIWKOVTAG VA NPoodIopioel To KAANOG, TNV ouaia, To
XAPAKTAPA KAl TIG OXEOEIG TOU PE TIC dMe¢ avBpwniveg dpaotnpidtnTeg. H
PIAoocoPIkn €peuva yUpw and Ta npofArpaTta Tou wpaiou eivar T6oo nalid,
600 kal n idia n gihoooPia. And Tous apxaioug Gihoocodpoug, Tov MNAdTwva, Tov
ApiototéAn, Tov MAwTivo, and Tn xpioTiaviki @IAocoPia Kal TOUG METENEITA
veonAaTwvikoUug gpiAoodé@ouc diaTunwdnkav did@opec andyYelg yia To wpaio,
EVW TO PaOCIKOTEPO £pWTNUA NMou NPofAnpdTIde nTav 1o Katd Néoo To wPAio
givar npaypatiké i @avraoTikd kal kat’ auti Tnv évvoia KaAd yia Tnv
nveupaTikn aviPwon Tou avBpwnou. EvOEIKTIKG avapépeTal 6TI oTn prAocopia
Tou [AdTwva, TO andéhuto kAMo¢ PpiokeTal OTIC UNEPOUPAVIEG IDEEG,
d1aPaIVOUEVO OTNV NPAyuaTikOTNTA TOU KOOPOU, O 0noiog eival yipnon autwy

TwV 10eWV Kal unvd otov AvBpwno To evdlapépov Kal TNy aydnn yia Ol gival

wpaio (Meveydkn, 2003).

Apyotepa, o Teppavog giAdoopog AAegdvrep TkOTAIpN MnaoupykdpTey, TO
1750 pe 10 BiIAio Tou «AloBNTIKA», €ival 0 NPWTOG Nou opidel Th pIAocoPia TNG
TEXVNG WG a100ONTIKA. Xe QUTA Tnv npaypateia 10 «kAGAog» opiletal wg n
TeAeIéTNTa TNG kAT  aiobnon yvwoews (evw n aAnBeia eival n TeAeidtnta TG
yVWone yia 1o vou). XUPpwva ndvra pe tov Mnaoupykdptey, oe kGOe €pyo
TEXVNG N TeAeldTnTa PBpioketal oto kAAMog, oTnv aioOnti popen kar Oxi oTn
¢IANaAnBeia, oTo vonTikd Tou OnAadn nepiexdpevo (Allen, 1990). O opiopodg
auTéq yia TNV alodnTikn, YoTepa and pia npwTtn duonioTia, enavaAn@onke kal
dleukpiviobnke @iAoocoPikd and Tov Kavr kar uioBetribnke and tn vedrtepn
¢pihoocopia. Kard tov Kavrt «wpaio eival ekeivo nou apéoer dixwg €vvola, dixwg

OUMPEPOV, WG AVTIKEIUEVO VEVIKNG APEOKEIOG». XApEPa, OTO KOIVO Ae€IAdyIO,



a100OnTIKA ovopddeTal kdBe OpaoTNPIGTNTA MOU AOXOAEITAl PE TO WPAI0 WG

a1oOnTri noidTNTA.
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H aioBnmikin Ttou Toniou eivar kaT’ enéktaon n Téxvn HPE TNV onoia
OnuIoupyouvTal OETIKEG KAl EUXAPIOTEG OMTIKEG EVTUNWOEIC and €va Tonio Kai
anoTeAel TO BAOIKO QVTIKEIMEVO TWV APXITEKTOVWY TONiou. H apXITEKTOVIKA TOU
Toniou, Nou w¢ emoTAPN aplIBpei Aiyec dekaeTiec (wNG, eMIdILKEI VO OUVOUAOEI
TN yvWon TNG GUoNG TWV OIKOOUOTNPATWY, TWV MEMOVWHEVWY OTOIXEIWY KAl
TwV ouvOAwv padl pe oToixeia TG TéxvNg, OnNw¢ noikiAia, apuovia, avriBeon,
NPokelyEvou va emreuxBel 1 va diatnpnOei n aiodnTikA appovia kar opgopPid

oTo onTIké nepifdAov (Kaooidg 1989).



1.2 Kdpia xapakrtnpioTikd TOU Toniou

1.2.1 Ta&vépnon Tou Toniou

To Tonio Ta&vopeiTal og dIAPOPEG kKaTNyopiec avdloya pe Tn olvBeon Tou, TNV
KAfOKa Twv OTOIXElwV TOu, TNV 0paTOTNTA TOU KAl TN diapdppwon Tou. ‘ETol,
w¢ Npog Tn ouvBeon Tou Olakpivetal oe PuoIkd, avBpwnoyeveg (aoTikd) N
MIKTO, WG NPo¢G TNV KAIHaKa Twv oToIXelwv Tou OlakpiveTal og Tonio pe peydAa
oToixeia (Bouvd, Alpveg, nediddeg) N pe pikpd otoixeia (Adgol, xefpappol,
K.AM.), evwy avdloya pe 1o nedio opatdTNTAC OIAKPIVETAI OE PAKPOTOMIO KAl

MIKpoTOmio.

‘Exouv yivel noAMéG npoondBeieg Ta&ivopnong wg npog To €i00¢ Tou Tomniou e
Mia and Tig Mo onpavTikéG va eival autn Tou Litton (1967, andé Smardon 1981).
O Litton Ta&vopnoe 1o TOMiO Of €nTd KATNyopieG avdAoya He TNV yevikn
dlapdppwon TOU (MAvVOPAPIKO TOMio, TOMIO XAPAKTNPIOTIKWY  HOPPWY,
nepIKAEIOpEVO TOMio, €0TIOKO N a&ovikd Tonio, TOMio AENTOPEPEIWY, EPHUEPO
Tonio, oTeyaopévo Tomio). MapdAnAa, €xouv yivel QpkeTéEC MPoonddeleg
Ta§ivopunong nou e&eldikelovTal O€ EMIPEPOUG €i0ON KAMOIAG OUYKEKPIPMEVNG
KaTnyopia¢ tonfou Onw¢ acTikO Tonio, aypoTikd Tonio, OpPeivO Tomio K.a.
(CDREE, 1969; Palmer, 1978; Smardon et al., 1986). Engidri dpw¢ and tnv pia
ol Ta&vopnoelic nou avantiooovTtal  eival  €0TIOOMEVEG  OTIGC  €KAOTOTE
IDIITEPOTNTEG TNG NEPIOXAG N TOU AVTIKEIPEVOU €peuvac kal and Tnv dAMn To
Tonio dlIaPOPONOIEITAl ONUAVTIKA and TOno ot TOno, éxel oupnepadel Nwg dev
pnopel pia povadikn Ta&ivopnon va epappodetal KaBoAIKd yia OAeG TIG

NEPINTWOEIG.

1.2.2 OnTikd oToixeia

1.2.2.1 Kupiapxa oToixeia Tou Toniou

Ta otoixefa nou eivar napévra ouvibBw¢ oe OAa Ta Tonmia eivar Téooepa,
dlapépovtac peTa&y Toug oto Babpd Tng onTikAg enidpaong, TNG dUVAPNG Kal

TNG KUpIapxiag Toug oto Tonio. Ta oTtoixeia auTtd eivar:



A If’fi?lf;r Chaeiy,
D 1¥4v1‘ “’{“ ’i"’z":f o

Yorsy

Ixnua 1-1 Kupiapxa otoixeia Toniou (USDA, 1973)

A) Mopori, dnAadn n pdda evdg avTIKEIWEVOU N O OUVOUAOMOG AVTIKEIPEVWY
nou epgavidovral ouvevwuéva kal he oa®n dIdKPIoN TNG OIANOUETAG TOUG OTO
XWPO.
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B) [pappn, eivar éva onpeio nou éxel enektadei npog pia karetbuvon n ot eival
dlaTaypévo oe pia oeglpd. H napoucia TnG ypapung oto Tonio eival 1600

€vtovn, Nou NPOOoeAKUEl TNV MPOCOXA TOU NAPATNPENTA.

N Xpwpa, nou givar n Baoiki ekdriAwon Tou pwTdC Kal eKPPAETAl PE TOV TOVO
(pwTeIvé - okoTevd), Tnv évraon 1 AapnpdTnta (kabBapdTnTa Tou XPWHATOC)
kar Tn xpoid 1 andéxpwon (kitpivo, npdoivo kTA.). To xpwua divel Tn
duvatéTnTa oTov dvOpwno va diapopPonoINoEl KAl Va EEXWPIOEI TO AVTIKE(YEVQ

nou BAEner kar 6Tav aképn ivar dPola 0T JOPEPA, TN yPAUMA Kal TNV UPA.

A) Y@ri Tou Tomiou mou avagéperal oTov TPOMO nou ouvapdpwvovTtal Ta
d1dpopa ouoTtaTikd Tou. H ugpn diakpivetal kar nepiypd@eral wg (i) Aentn 1
Aeia, (i) p€on kar (iii) Tpaxeia A avwpaAn. O avriBeoeic npokunTouv and Tnv
avrinapdBeon Aentri¢ kal Tpaxeia¢ upng. H avriAnyn TnG uPnig, noikiMel

avdAloya pe Tnv andotaon. ‘Oco nio pakpivé eival To onpeio and 1o onoio
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NapaATNPEEITal €va avTikeievo — €va Tonio — T6oo nio Aentrl yivetal n ugn Tou.
Eniong Aeieg, omIAnvég em@dveie¢ 6nw¢ avravakhouv nepIioodTePOo TO pw¢ and

TI TPAXEIEG, O1 ONOIEC ANOPPOPOUV TO PWE NEPICOOTEPO AVOPOIOPOPPA.

Katd tn didpkeia TG eE0PUKTIKAG OpaoTNPIGTNTAG NPOKAAOUVTAl HETABOAEC OTO
TOoNio pe TNV aAoiwon Twv akavovIoTwy PHOPPWY TOU PUOIKOU avayAupou Kal
TN ONMIOUPYIO KAVOVIKWYV VEWMPETPIKWY HOPPWY, TNV guPAvVION AKAPNTWY
eubUypappWY TUNPATWY O  aVTIKATAOTAON TWV OPOAWY  KAPNUAWY  TOUu
puoikoU Toniou, TNV EPPAVION AVOIXTWY KAl EVTOVWY XPWHATWY TWV EKOKAPWY
oe avrinapdbeon pe Ta OKOUPA XPWHATA TWV (QUOIKWY OTOIXEIWV KAl TNV
aMaynt TnG upn¢ Tou Quoikold Toniou. O avTiBEoEIC AUTEG eival EVTOVOTEPEG
otav, and Tn Béon napaTnpnong, PNoPEel va ouyKPIOEl 0 XWPOoG eEOPUENG PE TO

adlaTdpakTo puoikéd nepifdrrov. (Kahiapndkog, 2001)

1.2.2.2 Baoikoi napdyovreg aioOnTikAG TOU Toniou

O BaBpodg évraong pe Tov onofo gpgavidovral Ta Téooepa Kupiapxa oTOoIXEl
TOU ToMmiou €ival ouvdpTnon enTd oTaBepWV NAPAYOVTWY Nou anoTeholv Toug
faoikolc ouvteAeoTéG TNG a10ONTIKAG NPofoAri¢ Tou Tomiou. Autol kaTd

USDA (1973) eivar:

a. AvriBeon, [. Aiadoxn, vy. Afovag O. 2uykAhion, €. Xuykuplapxia,

oT. MAaioiwon, ¢. loopponia

1.2.2.3 MeTtaBAnTol napdyovreg nou ennPeddouV TIGC OMTIKEG EVTUNWOEIG TOU

Toniou

O Ttpéno¢ pe Tov onoio yivovralr avriANnNTd Ta xapakTNPIoTIKG OTOIXEla TOu
Toniou dev e&apTdTal pévo and Toug otabepouq (Baoikoug) napdyovreg, ald

kal and okTw PeTaBAnToug, ol onoiol cUppwva pe To USDA (1973) eivar:

a. Kivhon, (. Atpoo@aipikéG ouvlrikeg, y. Pwg . Enoxni Tou €r10UG, E.

AndoTtaon napatnpnong, or. Oéon napatpnong, ¢ KAipaka, n. Xpévog
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1.3 [NepiBalovTikn vouobeoia kal Tonio

And Ta TéAn Tn¢ dekaetiag Tou ‘50 n oikoAoyiki kpion, TNG onoiag Ta onpddia
ATav NON gavepd, €0TpePe onPAvTIKA PEPIdA enOTNPOVWY OTnV KaTayyeAia
TNG avdnTuéng xwpic tTnv dla@uAaén Tng noidétntag Tou nepifdAovToc.
MapdAAnAa, avanTuxOnke katd TI¢ dekaeTieq ‘60 - 70 nepiBarrovTikd kivhua,
nou eNEOPAOE ONPAVTIKG OTIG NPWTEG OAOKANPpwHEVEG NpoondOeieg yia BEonion
nepiBarrovrikig vopoBeoiag, apxikd oTig H.I.A. kar apydétepa otnv Eupwnn kai

OTIG UNOAOINEG AVENTUYHEVEG BIOPUNXAVIKG XWPEG.

H apxn éyive pe Tnv Mpdén EOvikng Mepifarovtikig MoAmikig (NEPA - National
Environmental Policy Act), n onoia 1€0nke oe epappoyn Tnv 1" lavouapiou Tou
1970 omic H.TT.A. kal gionyaye Tnv €vvola Tou Beopol Twv MeheTwyv EkTipnong
MepiBarrovrikwv Enintwoewv (MME). O vopog autdg anotéheoe Tn Bdon piag
oeIpd¢ dMwv €10IKWY 0dNYIWV Kal ano@doswy yia Tnv opBn diaxeipion Tou
nepiBdAhovrog kar eveénveuoe Tnv nepiBalovTiki vopoBeoia noAMwv kpaTwv.
‘Hrav, ouociaoTtikd, n npwtn olokAnpwpévn nepiBalrovriki npdén. Opide
0apwWe OTI 0 OXedIAOUOG evos €pyou Ba npénel va nepIAaPPAver pia ekTevh
avapopd OE TEXVIKEG, OIKOVOUIKEG, NEPIPBAMOVTIKEG, KOIVWVIKEG Kal  AAAEQ
napapéTpous kal 0T n Tehlikn andégaon Oa npénel va oTnpietar og pia
dladikaoia noIoTIKAG Kal MOOOTIKAG a&loAdynoncg Toug. AvrtioToixn pe tn NEPA
eival n Eupwnaikn Odnyia 85/337 (European Communities, 1985). Méoa and
Tnv Odnyia autn kaBopioTnke N onpaocia Tng agiag kar n avdykn npootaociag

TOU TOMiou.

Tov OktwPpen Tou 2000, otnv Eupwnaikn XupBaon Tou Toniou N ZUpPaon Tng
PAwpevriag, Tnv npwtn Aigbvi X0uyBaon yia TO TONiO, OIATUNWONKE O
akéAouBo¢ enionpog opIopdg yia To Tonio, Nou anoTelel éva onpavTikd Pripa
yla Tnv agipopikn diaxeipion kal npooTtacia Tou Toniou oTto oUvoAo Tou

Eupwnaikou xwpou.
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Katd tn ZupBaon, tonio onpaivel pia nepioxn, 6nwg yiverar avriAnnm and
avbpwnoug, Tou onoiou 0 XapakTAPaAg eival To anotéAeopa TNG dPAoNG Kal

AAMNAENI®PACNS TWV PUOIKWY Kal/fi avOpwnivwy napayoviwy.’

‘Ooov agopd Tnv EAGda Yneicetar o N. 1650/86 «lNa tnv npootacia Tou
nepifdrovrog» (PEK 160, 10-10-1986), otnv npoondBeia evappoviong Tou
eMnvikoU dikalou pe 10 KoIvoTIkG. XTov N. 1650/86 neprypdgovral yia npwrn
Popd He OAPNVEIO €VVOIEC KAl OPIOMOI OXeTIKG pE TO nepIfdAlov  kal
kwoikonomonkav npoundpxovra dedopéva. ‘Ooov apopd 1o Tonio, opiCeTal we
«KGOE dUVAMIKO 0UVOAO BIOTIKWV Kal PN BIOTIKWY NAPAyOVTWY Kal OTOIXEIWV TOU
nepIBGAAOVTOC NMou PePOVWHEVA N AMNAENIOPWVTAG O OUYKEKPIMEVO XWPEO
ouvbétouv pia  onmikA  gpneipia». O  OUYKEKPINEVOG VOPOG  OUCIAOTIKG
evepyonoleital pe Tnv KYA 69269/5387/1990, 6eonidovrag 1i¢ MIE. X1a nAaioia
epappoyng TNG andpaong anaiteitar N oupnAnpwon eidIkoU pWTNUATOAOYIOU,
TO onoio ava@éperal HeTa&U dAAwv kal otnv aioOnTikA Kkal €6eTAdel €dv: «TO
npoteivopevo €pyo Ba npokaAéoel napepnddion onolaocdrinote B€ag Tou
opidovra i onolaodnnote koIvig Béag 1 Oa kataAnéer otn dnuioupyia evog pn

anodekTou a1oONTIKG TONioU, NPOOCITOU oTnNV KoIvih Béa» (Meveydkn, 2003).

v EAMGOa, n npwtn eubeia avagopd oto Tonio yiverar to 1950, pe 1O
1946/50 didTraypa Tou Ynoupyeiou [MoAimiopod yia Tnv npooTaocia Toniwv
1Id1aiTepou  kAMoug. Apydtepa, 10 NA 996/71 6a oupnAnpwoer OTI OTIG
KOTNYOPIEG  TwV  MPOOTATEUOPEVWY  (QUOIKWY  MEPIOXWV  MNPENEl  va
oupnepIAngOoUv  kal OAOIKEG EKTACEIC MOU N OIkoAoyikA  Toug ouUvBeon
ONMIOUPYE( TOMIAKEG eVOTNTEG e 101aiTeEPN a1oONnTIKA agia. ‘Ooov apopd otnv
anokatdoTaon Tou Toniou and TIC ENINTWOEIG TNG PETAMEUTIKAG KAl AATOPIKAG
dpaotnpidtnTag, n MoAiTeia B€onioe vopoBeTiIkd péTpa yia npwtn opd TO
1976, pe Tnv ékdoon Tou NOpou 274/76, o onoiog opidel TNV UNOXPEwon Tou
ekheTaMeUT yia  anokatdoTtaon. Tpia xpdévia apydétepa, pe 170 N. 998/79
«[epl npootaoiag daowv kal dACIKWY EKTAOEWV», kabopidovral yia npwrn
Popd peTa&y dAwv, oto Apbpo 45 nap. 5, Ta nepiexOpeva  «TEXVIKWV

Mpodiaypapwyv Meletwiv EninToewv kal Anokataotdoswg Tou MNepIBAAovToc»

> Apbpo 1, N. 3827/2010, ®EK A/30/25.2.2010, KUpwon Tn¢ Eupwnaiki¢ TUuPaong Tou
Tonfou: http://www.unesco.org/culture/natlaws/media/pdf/greece/gre_law3827_10_eurlandsca
peconv_greorof
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and TNV gykatdotaon PETAMEUTIKWVY KAl AQTOPIKWY dpaoTNPIoTATWY PEoa O€
ddon kai OAOoIKEG eKTAOEIG. 101aiTEPN €uaocn OiveTal oTnV evOTNTA «TOMIOAOYIKA
oToixgio» TOOO KATA Tn (Aon TnG €peuvac 600 Kal katd Tn gdon Tng

eKMETAMEUONG AaTopeiwy Kal eETaMEIwY, N onoia avagepel:

«[péner oto xdptn (nNpooavatoAiopou) va aneikoviCovtal o1 (WVEQ
eualoOnoiac Tou Toniou. Q¢ TéTolEC (WveC BewpouvTal ekeiveg nou anod
dedopéva onpeia ava@opdc n.x. KUpIol dEoveg NPooneAdoew, OIKIOHOI,
apPXAIOAOYIKOl  XWPOI, TOUPIOTIKEG MNEPIOXEG,  (PUOIKEG MNPOOTATEUTEEG
neploxéc (eOvikoi dpupoi, k.AM.) kal oe ouvdpTnon pe TNV andotaon
dfvouv Tnv onTikn TonioAoyikn napouciaon Tou xWpEou. AlakpivovTtal e o€
TPEIG (WVEG ONTIKEG AvAAoya Pe TNV andoTaon ToU xWpPou and Ta onpeia i
XWPOUG ava@opdg, dnAadn: a. Kovrivd (wvn 0-2 Km, B. Meoaia {wvn 2-5

Km, y. Makpivii {ovn 5 Km - dvw.»

Mapd 10 yeyovog OTI o1 avapopEg TNG eAMnvVIKAG vopoBeoiag oTny npootacia
TOU Toniou, ka1 On and PeTAAMEeUTIKG €pya, eival eKTEVEIG, TO anoTeAéopaTta dev
unnpé&av 1kavonoinTikd. Or aitiec eivar noikidec (Kaliampakos & Damigos,
2000), aAAG TouhdxioTov oe Beopikd eninedo pia and TIC PACIKOTEPEG QITIEG
unnpée n éNeyn ocapws kabopiopévng peBodoioyiag. To OUYKeEKPIPEVO
npoPAnpa  ndviwg dev  xapaktnpidel pévo Tnv  eMnviki  nepifaliovTiki
vopoBeoia. Touvavriov, avrioToixeg duoxépeleg napouciddovrar d1ebvwg, napd
TIG Ouvexel¢ npoondBeieq yia Ofomon Koivd  anodekTwy pebBodoloyiwv

ekTipnong. ‘Onw¢ avagépel o Williams (1974):

«Otav yiveral pia npoondOeia eniBoANG VOUIKWY KUPWOEWY O OXEON ME
TNV a100NTIKA, NpokUnTel éva anhd aAAd NoAd onpavTikd epWTNUA: Nwe Oa
opioBei 70 T €ival eAkuoTiké kal To TI gival doxnpo. To npéfAnpa Tou
nPoodIopIopoy Tou alobnTikd OPopP@Pou, To onoio unNNPE&E avTIKEIYEVO
dlapdxnG PeTa&U Twv PIA0cOPwy, €xel 1I01aiTepn onpaocia otn B€onion
vopikoU nAaiofou. AIOTI OTavV  €UNAEKOVTAl  VOMIKEG KUPWOEIG, €ival

anapaitnTo va npoodiopideTal ue akpiBela T eMTPENETAI KAI TI OXI...».
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To id10 npéPBAnua ouoiaoTikG emonpaivouv kal ol Miller et al. (1994), or onoiol
avagepopevol  otnv  Eupwnaikn  Odnyia 85/337 Ttoviouv 6T «av  Kal
dleukpividovral Ta  xapakTNPIOTIKG Tou nNePIBAAOVTOG nou  npéner va
dlepeuvivTal, oupnepAauBavopéviy  kal TwV  ONTIKWY  ENIMTWOEWY, OgV

kaBopidovTal o1 01adIKACIEC EKTIHNONG».
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1.4 [NpoodlopIoPo OEIKTWY YIA TOV _MOOOTIKO MPOOJIOPIOUS TNG

yeTaBoAic  Ttou avayAugpou (TRA - Topographic Relief
Alteration, ané yeBoodolovyia LETOPID)

1.4.1 H onpacia Tou npocsdiopiopoU TG peTafoAng Tou avayAipou

H avdAuon tou avayAdgpou €xel wg Baoikd okond TNV avayvwpion eKEVWY Twv
OTOIXEIWV NOU NEPIYPAPOUV KAAUTEPA TN YEWPETPIKA NOAUNAOKOTNTA TNG YAIVNG
em@dveiac. O Litton (1984) avagéper 611 n pop@oloyia Tou avayAdpou
anoTeAel TN onpavTikéTepn PeTaBANTA yia Tn digpedvnon TNG AVTOXA¢ evog
Toniou, yiati kabopier TNV opatdTNTA, TIC ANOOTACEIG KAl TIGC OMNTIKEG YWVIEQ
napatipnong, akéun kal Tov TPpOno nou OAa Ta dAMa otoixeia Tou Tomniou
yivovrar avriAnntd andé Tov napatnpnti. XapaktnpioTiké eivar 6T oTn
peBodoloyia Tagivounong nou aventuée dev oupnepiéhafe dAec petaBAnTE.
Mapd 10 yeyovog OTI 6Aa Ta enipgépouc oTtoixeia oupBdAouv ouciaoTiKd oTnv
AVTOXN €VOC OUYKEKPIYEVOU ToMiou, n onTikA eviunwon nou npokaAouv oTov
napatnenth e&aptdtar and Tnv ekAoTOTE Pop@PoAoyia Tou avayAdpou Kal

eNopEéVWG NPENel va eAéyxovTal oe endpevo oTddio (Meveydkn, 2003).

O1 KNiOEIG, 01 KOPUPOYPAPUEG, Ol EEAPOEIC KAl Ol UPEODEIG, OI NAPATNPOUMEVEG
UPOMETPIKEG OIAPOPEG, O KAPNUAGTNTEG, N CUMPMETPIO TWV OTOIXEIWV KABWE Kal
Ol YPOMMEG andToung aAaynig Twy kKAloewv eival pepikd and ta Baocikd oToixeia
yla TNV NePIypapn TnG HOPPNG KAl TOU ONTIKOU XAPAKTAPA Tou avayAdgou,

EVW N €peuva og auTo To avTikelpyevo ouvexicetal (Meveydkn, 2003).

1.4.2 MNpoodiopiopdég Twv NapapéTpwy peTaBoAng avayAipou oTo povTédo
eKTiHNONG

Eneidn undpxel éva nAnbo¢ napapérpwy nou pnopouv va xpnalponoinfouyv yia
TNV avdhuon Tou avayAdgou, n emhoyn Toug Ba npénel va PBaociCetal oTIC
I010ITEPEG avdAYKeG Kal anaithnoels kdbe epappoyns. H Meveydkn (2003),
e€etdlovrag TNV EKTiUNON TwV E€NINTWOEWV Mou npokalolvralr and Tn
METAMEUTIKA dpaoTNPIOTNTA OTO APXIKO avAYAUPO TNG NEPIOXNG AVAPEPEL:
«..0ev  evdlagEépel dueoa n Ta&ivopnon Tng noiétntag Tou avayAdgou
kabautoU, aMd o Pabudg peraBoAng Tou. O u@ioTApeveEG NAPAUETPOI
nePIyPagpn¢ kal Tagivopnong Tou avayAdgou Ogv pnopoulv va anodwoouv To
pEyeOoC TNG peTaoAni¢ nou npokaAeitar and Tnv ekyeTdAAeuoN.»
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Me Bdon 1o napandvw OKeNTIKO, ME Yia NPWTOTUNN NPOOEYYIoN TOUu B€uaTog, n
Meveydkn (2003) avéntuée TOUG akOAouBoug VEOuC OEiKTEC yia  Tnv

noooTikonoinon TnG NPokaAoupevng HeTABOANG:

- O dgiktng poppoAroyiag - Landform Index

- O ouvreheotnig uPopéTpou - Altitude Index

- O d10pBwpévog deikTNG popporoyiag - Adjusted Landform Index
- O deiktng KAiong - Slope Index

- O deikTng npooavaToAiopou - Aspect Index

O1 napandvw OeikTeG, eival NOOOTIKEG NAPAPETPOI Nou AauBdvouv undéyn 1600
TIG Baoikég npounobéoeig nou nepiypdgovrar and tov Hubson (and Ayeni,
1978) yia Tnv ekTipnon Tou avayAd@ou, 600 Kal TOUG KavOveG Nou OIENOUV TNV
Ta&ivopikn  d1adikaoia, kabw¢ xpnoigonololvral yia TV Ta&gvopnon  Tou
avayAdpou. To OewpnTikd undBabpo Twv OeIkKTWY nePIyPAPeTal NAPAKATW

onw¢ avaAdovral and Tnv Meveydkn (2003).

1.4.2.1 Aeiktng Mopgoloyiag (AM) - Landform Index (LI)

O Aeiktng Mop@oloyiag Tou avayAdpou (AM), anotelel éva pé€rpo Tng
OUOXETIONG TNG €NIPAVEIAG TOu apxikoU Me Tnv enm@dvela Tou TehikoU
avayAdpou, onw¢ auti dlapoppwveral and Tnv  ekuetdAheuon. Ta  Tov
unohoyliopd Tou OelkTn xpnolponoleitar N dlakUpavon Tng dIaPopdg Twv
UPONETPIKWY ONPEIWY TNG apxIKAG Kal TNG TEAIKAG enipdvelag, pe Tn Boribeia Tng

Bewpiag Twv TUXaiwy PETABANTWV.

H diakdpavon (dlaonopd) Tng dlagopds dOUo Tuxaiwv peTaBAnTwy 1couTal pe
T0 dOpoiopa Twv Olakupdvoewy (dlaonopwyv) Meiov To  dIMAdoIo  TNg

ouvodlakUupavong autwv (Kiviig, 1999), dnAadn:

var(X-Y) =var(X) + var(Y) - 2cov(X, Y) (1)
onou:
var(X-Y) = n diaonopd tng d1apopd¢ Twv dUOo Tuxaiwv heTaBANTwY
var(X) = n dilaonopd TnG PeTaBANTAG X
var(Y) = n diaonopd Tng peTaBAnTriq Y

cov(X, Y) = n ouvdlakipavon Twv petaBAnTwv X kar Y
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H dlaonopd anoteAel €va PETPO TNG PEONG TETPAYWVIKAG ANdOTAONG TWV TIMWV

TNG PETAPBANTAG and TN péon TIPN TNG Kal diveral and Tn oxéon:
1 )
var(X) ==~ )’ (2

Katd tnv extipnon tng diakipavong AapBdvovtal unéyn ol NANPoPopIies Tou
uPopéTpou and OAeG TIC Yn@idec Tou Ynpiakod xAPTN TNG APXIKAG KAl TENMKAG
em@dveiac. Eniong, pe tnv UYwon Twv dlapopwyv (X-M,) OTO TETPAYWVO,
anodideTal  peyaAdtepn  otdOupion / Bapdtnta  OTIC NAPATNPACEIS  NOU
eMpavidouv peydheg anokAioeic and Tov PEOO, yeyovoG Mou €xel PeydAn

onpaocia katd TNV eéaywyn oupnNEPAcPdTWY.

H ouvdiakUpavon Twv petafAntidv X kar Y anotehel Tnv kevrpiki ponni Tng
OUYKATAVOUNG TOUg, ONAadN TOV PEOO OPO TWV TIHWV TOU YIVOuEvou (X-

M) *(Y-py) kai diverar and Tn oxéon:

COV(X,Y) = E(X = ) *(Y = 1) = 3%~ 1) * (i~ 1) B)

H ouvdiakipavon 0o peraBAntwv X kar Y eivar duvatév va  eival
onoloodnnote aplBuog - OeTIKOG, apvnTIKOG N PNOEV - kal ekPppAdeTal oTO

YIVOUEVO TwV pOoVAdWY Twv e&eTaldpevwy petaBAntwy (ABavacdnoulog, 1989).

Edv o1 petaPBAnTég, o1 onoieg e€etdlovral, petadAovTal yevikd opdppona, oe
au&non dnAadn TnG piag avTtioToixel kaTd kavéva augnon Tng AMNG kar oe
Meiwon Tng piag avriotoixel peiwon TnG dAANG, n ouvdlakUpavon Toug gival
OeTikd¢  apiBudg.  Avriotpoga, €dv o ouvefeTaldpeveg  pETABANTEG
peTaBdMovTtal yevikd avrippona, oe avénon dNAAdNA TNG HIAG AVTIOTOIXES
MElwon TNG AAANG, o1 dlagopEq (xi-y,) (yi-y,) Ba eival katd kavéva eTepOoNEG,
Ta yIVOPeEVA TOUG apvnTIKG KAl OUVENWG N ouvdlakUpavort Toug Oa eival

apvnTIKOG apIBuOG.

Ané Ta napandvw eival gupaveég 6Tl TO NPOONPO TNG OUVOIAKUPAVONG
xapaktnpi¢elr katd PBdon TOV TPONO e TOV onoio o1 peETABANTEQ
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ouppeTaBdAovTal,  Oeixvel enopévwg Tn  popepn  Tng  eg&dptnonc. ‘Ooco
peyaAUTepn katd andAutn Tiun eivar n ouvolakdpavon OUo PeTaBANTWY, T60O0
oapE£oTePN gival N TAoON TOUG YIa AVTIOTOIXIO KAl TOOO 10XUPOTEPN N CUOXETION -
Oemikn N apvnTikA - nou undpxel PeTagU Toug. AvtiOeta, TIMEC TNG
ouvOlakUpavong Kovtd oTo pndgv unodnAwvouv o1 Oev undpxel Kapia
vopoTéAela oTov TPONO pe Tov onoio ouppetaBdlovTarl or duo petafBAntég. H
apIOuNTIKA TIPN, €NoPévwe, unodnAwvel Tnv évtaon Tne e€dptnong. ‘Otav dUo

METABANTEG eival yPAPMIKG QOUOXETIOTEG, TOTE:
cov(X, Y) =0
onoTte n oxéon (1) yiverar:
var(X-Y) =var(X) + var(Y)

Z0ppwva pe Ta napandvw, yia ToV NoooTIKG npoodiopiopd Tou Baduoul
OUMMETABOANG Tou apxikoU kal Tou TeAikoU avayAdpou XpNnolponoleitalr n
akéAoubn e&fowon:

Var(Zopx) + Var(ZTE)\) - ZCOV(Zopx/ ZTE)\)

va r(ZGPX-ZTE)\) - va r(ZOpx) +va r(ZTE)\) (4)

énou:

1 . ,
Var(zap;(.) = ; Z(Zap;(.l - /’Ingapl.)z

1 o ,
Var(zrgl.) = ; Z(ngxl.l - ,USOUZTM.)

13 ., L
COV(Zap;(_ ' ngi.) = ; Z (Zap;(.l - lu’ngapz.) * (ngi.l - lungrsﬂ.)

Zopxi = TO UPOMETPO TNG APXIKAG EMIPAVEIAG OTO ONPEIO i, JE OUVTETAYMEVEG X,Y

Z.. = T0 UPOPETPO TNE TEAIKAG ENIPAVEIAC OTO ONUJEIO i, JE CUVTETAYUEVEC X, Y
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O napavopaoTng oTnv e&iowon XPNOIPONOIETAl yIa TNV KAVOVIKONoinon Tou
anoteAéopaToc. Me Tov Tpdno autd gpdooetal n dlakUpavon Twy unod eégraon

METABANTWV.

Mo ouykekpipéva, 6tav ol enipAveleg eival NANPWG AoUOXETIOTEG [ONnA. OTav

COV(Z,p Zrep) = 0], TOTE 0 ouvVTEAEOTAG AapPBAvel T pgyIoTn TIpn:

Var(qux) * Var(ZTe)\)
Var(zopx _ZTE)\) = =1
var(Z,.,) +var(Z,,)

apx

Eniong, 6tav n ouvdiakdpavon AapBdver apvntiki Tipn (OnA. undpxer apvnTikn
OUOXETION MPETA&EU Twv em@avelwyv) AapBdverar oupBaTikd pndevikn Tiun yia

TNV €V A\Oyw NApAPETPO, WOTE N oxéon va AdBel Tn péyiotn TIPA.

Otav o1 emipdveieg  eival  NAAPWE OUOXETIOPEVEG, MOU  onpaivel  OTI

peraBdAovTal opoidpopgpa, TOTE:

Var(Zupx) = Var(ZTE)\) = COV(ZapX/ ZTE)\)

onaoTe:

var(Z,,) + var(Zteh) - 2cov(Z,p, Z:)

va r(Zapx - ZT£)\) =

var(Z,.,) +var(Z.,)

apx

2CoV(Zopns Zien)- 2COV(Zos L)
var(Z,.,) +var(Z.,)

apx

AuTO NpakTIkd onpaivel OTI, o pia 10avikA nepinTwon énou n ekpeTdAeuon
peTaBdMel opoidpoppa Tnv enmipdveia pévo kab’ Uyog, akoloubBwvrag TIG
YPOUMEG TOu apxikoU avayAdpou, o Pabudc ouppeTaBoAi¢ TnG TEMIKAG

ENIPAVEIAG PE TO apxIKO avdyAupo Ba nTav pundev.

20



O odeiktng peTaBoAnc Tng pop@oloyiag Tou avayAdpou xwpicetar og 10
katnyopieg (6nou, katnyopia 1: BéATIoTn nepinTwon kar katnyopia 10: xefpiotn

nepintwon), énwg gaiverar otov livaka 1-1.

Mivakac 1-1 Katnyopie¢ AM Tou avayAdgpou

Karnyopie¢ AM Tipég

1 0-0,15

2 0,16 - 0,25
3 0,26 - 0,35
4 0,36 - 0,45
5 0,46 - 0,55
6 0,56 - 0,65
7 0,66 - 0,75
8 0,76 - 0,85
9 0,86 - 0,95
10 0,96 - 1

1.4.2.2 Yuvteheotng Yyopérpou (ZY) - Altitude Index (Al)

‘Onwg avapépdnke, 0 AM anotelei éva PHETPO TNG PETABOAAG TWV YPAUHPWY TOU
TeEANIKOU avayAUpou o€ oxéon Pe To apxikd. TNV nepintwon nou o AM Aapfdvel
TNV TIUA Pndgv, undpxel getaBoAn Tou apxikoU yewpop@oloyikoU avayAdgpou,
n onoia ogeiAeTal oTnv UPOPETPIKA dlapopd Kkal agopd oTn dnuloupyia PIag
VEaG popPn¢ oto Tonio. H petafBoAn autni €xel pikpdTepn PBapuTtnta oe oxéon

ME TNV NEWTN, KOBWG Oev OIAKOMTEI TN CUVEXEID TWV YPAUMWY Tou avayAugpou.

Mpokeipévou va npoodiopiodel 0 TpdNog pe Tov onoio ennpeddel n peTaBoAn
TOU uyopétpou  Tn dlapdppwon Tou avayAdgou, unoloyidetar n Tunikn
andkAlon TNG TEMKAG eNIPAVEIOG WG NPOG TO HPECO UYOPETPO TNG APXIKAG
em@dvelag, und Tnv napadoxn OTI N apxikn  em@dveia  peratonideral
opoIdpoPPa KATA TO pEoo AZ peta&l TG APXIKAG kal TNG TEAIKAG eM@AveIag.
Katd ouvéneia n povn perafoAn nou uneioépxeral eival anotéAeopa Tng

MElwong Tou UYopETPOU.

Mpokelpévou va npoodioplofei o TPONOG pe Tov onofo ennpeddel n PeTaBoAn

TOU UYoOMETpOU TN dlapdppwon Tou avayAdgou, unoloyideTal n Tunikn
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andékhion TnG TeAIKAG enIPAVEIOG WG NPOG TO MECO UYPOPETPO TNG APXIKAG
em@dvelag, und Tnv napadoxn OTI N apxikn  em@dveia  Petatonideral
opoldpoppa katd 1o péoo AZ peta&l TNG apXIKAG Kal TNG TEANIKAG eMIPAVEIQG.
Katd ouvéneia n povn perafoAn mou uneioépxetal eival anoTéAeopa TG

MEiwonNg TOu UYOUETPOU.

H Tunikin andékAion 1oodtar pe Tn OeTikn TeTpaywvikn pida TnG dlaonopdc.
AnoTeAel éva TunonoiNPévo PETPO yia Th PETPNON TNG Jéong andkAiong and Tnv

KevTPIKA TAoN kal diveTal and Tn ox€on:

1 Al 2
S Z\/V—_lZ(Xi —u, )

210 ak6Aoubo oxripa (Xx. 1-2) aneikovi¢etal n petafoAn nou npokaAeital o€ pia

MEMOVWHEVN PNPida Tou povTéhou eddpoug and Tn peiwon Tou UPOPETPOU.

Z-Axis

Ixnpa 1-2 Metafohi og pia gneida Tou avayAddpou AOyw uPopeTpIkig dIaPpopdq
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H enidpaon tn¢ uPopeTpikng Olagopd¢ oTtn peTaBoAn Tou avayAdgpou
unoAoyideTal dIAPOPPWVOVTAG €Va VEO OUVTEAEOTH, TO ZUVTEAEOTN YPOMETPIKNAG

Alapopdc (ZY), oupgpwva pe Tnv akdloudn oxéon:

|4

\/i(zrsﬂi _:uéovzapz)z _\/Z(Zapzi _'u‘éo-ozapz)z
2Y =

| x100 (6)

\/Z(Zapli - wovzapz)z

énou, yia Tnv nePIMTWwon TNG OpoISHOPPNG METABOARG, Z ,i=2Z, I — 1EcoAZ

O XY xwpiCetar enionc oe 10 kartnyopie¢ (6émou, katnyopia 1: BéATioTn
nepntwon kar karnyopia 10: xeipiotn nepinTwon), 6nw¢ ¢aiverar oTov

Mivaka 1-2.

Mivakag 1-2 Katnyopieg Y

Katnyopigg LY Tipég
1 0-10%
2 11-20%
3 21-30%
4 31-40%
5 41-50%
6 51-60%
7 61-70%
8 71-80%
9 81-90%
10 >91%
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1.4.2.3 Aiopbwpévog AeikTng MoppoAoyiag (AAM) - Adjusted LI (ALI)

Me dedopEVO OTI 0 ZuvTeAeoTnG YYopETpou w¢ npog 1o Agiktn Mop@oloyiag
gival  PIKPOTEPNG oONPaoiag, O NPWTOG XPNOIPONOIETal  w¢g  OloPOWTIKOG
ouvteAeoTi¢  otn  petaBoAr  Tng  pop@oAoyiag  Tou  avayAdgou. Tlio
OUYKEKPIPEVA, O AlopBwpévos AeikTnG Mop@ohioyiag (AAM) Tou avayAdgou
npokuntel and 1o dBpoiopa Tou AM kal Tou XY AapPdAvoviag ouvTeAEOTEG

BaputnTtag 80% kai 20%, avrioToixa:

AAM =0,8*AM +0,2*3Y  (7)

‘Etol, n peTaBoAn Tou uPopETpou cuvunoloyidetal otov TeAIKG OeikTn, 0 onoiog
MEIWVETal A napapével oTabepdq yia NoAU xapnAn kal xapunAn petaBoAn tou XY,

avrioToixa, evw au&dvel 6tav n petaBoAn Tou XY eivar uPnAn.

Ytov Mivaka 5.7 divovral o1 10 TeAikéG kaTnyopieg Tou Alopbwpévou AegikTn

Mop@pohioyiag, (6nou, 0,1: BéATIOTN nepinTwon kai 1: xeipiotn nepintwon).

Mivakag 1-3 AAM Tou avayAdpou

KATHIOPIEX AEIKTH MOP®OAOTIAX

1 2 3 4 5 6 7 8 9 10
> 1{o17 02 03 03 04 05 06 07 07 08
o
= 2|01 02 03 04 04 05 06 07 08 08
§ 3017 02 03 04 05 05 06 07 08 09
> 402 02 03 04 05 06 06 07 08 09
5 5/02 03 03 04 05 06 07 07 08 09
E 6|02 03 04 04 05 06 07 08 08 09
A 7]l02 03 04 05 05 06 07 08 09 09
E 8|02 03 04 05 06 06 07 08 09 1,0
g 9/03 03 04 05 06 07 07 08 09 1,0
5 10/03 04 04 05 06 07 08 08 09 1,0
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O npoodiopiopdg Tou AAM aneikovi¢etal oxnpatikd oto Aidypappa 1-1.

AropBuwpivee Acikme Moppohoyiag (AAM)

TIMEZ AAM

09
05

07

0B
05

04

03

(4X) nodizdahn Sluoxvzisnz

02

OO0 @ NENEEDNNBN

01

1 2 3 4 5 ] 7 8 9 10
Acikme Mopporoyias (AM)

Aidypappa 1-1 Mpoodiopiopds Alopbwpévou Agiktn Mopgohoyiag

1.4.2.4 Aeiktng KAiong (AK) - Slope Index (SI)

O Aeiktng KAiong (AK) npoodiopicel Tn péon peraBoAn Tng kAiong peta&y Tou
apxikoU kal Tou TeAikoU avayAdpou, og kd0e Ynpida Tou povrélou eddpoug. H

péon peTafoAn Tng kAfong S, diverar and Tn oxéon:

1 . .
Su = VZ\SWJ -s_il (8

6nou: S,,.' = n KAlon TNG APXIKAC EMQAVEIAC OTO ONUEIO i, HE OUVTETAYHEVEC X, Y

apx .

S.r =N KAfon TN TEAIKAG ENIPAVEIAC OTO ONUEID i, JE CUVTETAYPEVEC X,Y
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210 2xnpa 1-3 aneikoviCetal n petafoAr nou npokaAeital og pia Yneida and T

peTaBoAn Tng kAiong.

Ixnpa 1-3 Merafolni og pia Ygneida Tou avayAddpou Aoyw PeTaBoAi¢ TG kAfong

Eneidn n kAion unoloyidetal ndvra w¢ npog 10 opI¢ovTIo eninedo n péyiotn
kAfon nou pnopel va napatnpnBei oe éva oToixelwdes TUAPa (YnPida) Tng
enipavelac eivar 90°. Mpokeipyévou va kavovikonoinBouv Ta anoTeAéopaTa Kal

va dnpioupynBei pia eviaia kAipaka and 0 €w¢ 1, n napandvw oOxéon €xel

dlapopPwOEl wg e&NG:

1S, 1—S,,1
Sﬂzvz% (9)

O AK xwpiletal og 5 katnyopieg (6nou, katnyopia A: BEATIOTN nepinTwon kal

katnyopia E: xeipiotn nepintwon), é6nwg¢ gaiveral otov Mivaka 1-4.

26



Mivakag 1-4 Katnyopieg AK

Karnyopieg AK Tipég
A 0-0,05
B 0,06 - 0,15
r 0,16 - 0,30
A 0,31- 0,60
E 0,61-1,00

1.4.2.5 Aegiktng MpooavatoAdiopou (AM) - Aspect Index (Al)

O Aeiktng lMpooavatodiopod (Al) npoodiopiCel Tn péon peraBoAn Tou
npooavatoAiopou, n onofa npokaAeitar and tnv ekpetdMeuon, petaéy Tou
apxikoU kal Tou TeAikoU avayAdgou, og kd0e Ynpida Tou povredou eddpoud. H
péyloTn peTaBoAn Tou npooavaTtoAliopoU nou pnopel va napatnpndei oe pia
gnepida eivar 180°. H peraBoAn autri pnopel va eivar apiotepdotpopn n

oegidoTpoPn.

210 Xxnipa 1-4 aneikovietal n petaBoAn nou npokaAeital og pia Yneida and tn

peTaBoAn Tou npooavaToAiopod.

IxApa 1-4 Metafohni og pia gngida Tou avayAdpou AOyw PeTaBOARG Tou
nPooavaToMNopou
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H péon petafoAn Tou npooavatoAiopou divetal and Tn oxeon:

As, = %Z?:‘Asw_i ~As,i| (10)

6nou: As,,' = o npooavatohiopdg TNG APXIKAG ENIPAVEIAG OTO ONPEIo i, pE
ouvTETaYMEVEG X, Y
As.' = 0 nNPooavatoMopdc TNC TEAIKAC empAvelac oTo onueio i, pe

OUVTETAYMEVEG X, Y

Mpokelyévou va kavovikonoinbouv Ta anoteAéoparta, WOTe va OnpioupynOef
Mia kAfpaka andé 0 éwg 1, o npooavatohiopdg kdbe Yngpidag ekppdderal o€

TIHEG and -180° €wg +180° ka1 n napandvw N oxéon dIAPOPPWVETAl WG EENG:

As i1—As

apy. re/l.l

s, =1y amn

V4 180

O ANl xwpicetal oe 4 katnyopieg (6nou, katnyopia A: BEATIOTN nepinTwon Kal

katnyopia A: xefpioTn nepintwon),6nwg¢ gaiveral otov MNivaka 1-5.

Mivakag 1-5 Katnyopieg All

Kartnyopieg Al Tipég
A 0-0,25
B 0,26 - 0,50
r 0,51-0,75
A 0,76 - 1,00

28



“Yotepa and Tnv NoooTIKOMNO/NON KAl TNV KATNyOoPIONoinon Twv enipgéPOUS
QeIKTWV €xel npaypatonoin®el n 1ehdikA  Ta&ivopynon TnG peTaBoAng Tou
avayAUpou. XuvoAikG €xouv  dlapoppwdei 5 katnyopie¢ Tou Babpou
MetafoAri¢ (BM) Tou avayAdgpou. H enihoynt Twv 5 katnyopiwyv éxel BaoioTel
oTou¢ Onmikoug [oloTikoUg XTéxou¢ Tou povrédou V.M.S. kar oTic KAdoeig
Ontikn¢ EuaioBnoia¢ Tou povrédou V.LA., olppwva pe Tnv  akéloudn

avtioToixia (Miv. 1-6):

Mivakac 1-6 AvtioToixia B.M. - O.M.%. kal K.O.E.

BaBpo6g MeraBoAng O.MN.X. katd V.M.S. K.O.E. katd V.I.A.

MOAU xapnASG - XapnAdg  XuykpdTtnon YynAn euaiobnoia
METpiog Mepikn Tpononoinon  Mérpia euaicbnoia
YPnAog Tpononoinon Xaunhn evaiodnoia
MoAU uPnASG Mégyiotn Tpononoinon oAU xapnAni evaioBnoia

Onwg @aiverar otov napandvw [livaka, o1 kaAtNyopieq «XuykpdTnon» Kal
«YYnAi  euaioBnoia» Twv povréAwv V.M.S. kar V.LA. avtioToixa, €xouv
dlaxwploTel og dUO enipépoug kaTnyopieg otn pebodoloyia LETOPID. Autd éxel
yivelr  npokelyévou  va  dlagoponolodvral  KANoleG  €I0IKEG  NEPINTWOEIG

eKpETAMEUOEWY, 6nw( eival ol daveloBdAapol.

O1 katnyopieg Tou BM ToUu avayAdgpou napouociddovral pe tTn Popepn evog
TehNkoU nivaka (Mivakag 1-7), yia Tn dnpioupyia Tou onofou o1 eNIPEPOUS

OeikTeC BOewpriOnkav 100Bapeic.
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Mivakag 1-7 Katnyopies BaBpod MetaBoArig Tou avayAugpou

AEIKTHX METABOAHZX KAIXHX

KATHTOPIA A KATHTOPIA B KATHTOPIA T KATHTOPIA A KATHTOPIA E
0-0,05 0,06-0,15 0,16-0.30 0,31-0.60 0,61-1
., lo1fo08 017 025 033[011 019 028 036015 023 032 04 [023 031 039 048[034 043 051
T |02[012 02 028 037014 023 031 039[018 027 035 043[026 034 043 051[038 046 054
= uwlo3|015 023 032 04 (018 02 034 043|022 03 038 047|029 038 046 0,41 0,49 0,58
< £/04/018 027 035 043|021 029 038 046(025 033 042 05033 041 049 0,44 0,53
© §[05]022 03 038 047|024 033 041 049|028 037 045 036 0,44 0,53 0,56
L 8lo6|o2s 033 042 05028 036 044 053[032 04 048 039 0,48 0,56
G ©lo7]028 037 045 053|031 039 048 056|035 043 0,52 0,43 0,51
208|032 04 048 034 0,43 0,51 038 0,47 0,55 0,46 0,54
% 09| 035 043 052 0,38 046 0,54 042 05 0,58 0,58
11038 047 055 0,41 0,49 0,58 0,45 0,53
Al B | T Al Bl r ] al aAlB

AEIKTHX METABOAHZX NMPOXANATOAIXMOY

KATHTOPIEX BAOMOY METABOAHZ ANATAY®OY TIMEX
MoAU xapnAn peTafoAn 0,08-0,15
XapnAn peTafoAn 0,17-0,25
MéETpia peTafBoln 0,26-0,40
YPnAn petafoAn 0,41-0,58
_ MoAU uPnAr peTaBoAn 0,59-0,89
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KepdAaio 2

Avdantuén autopartonoinpévou povréAou oe nepifdAhov arcGlS
10.71 yia TNV ekTignonN TwV ENMTWOEWY OTO TOMIO ANo
METAAMEUTIKA €pya.

2.1 Eiocaywyn ota l'ewypaoikd Yuotnuata MNAnpo@opiwy (IXM)

2.1.1 loTopikd XToIxeia

O Roger Tomlinson yia npwtn gopd tTnv dekaeria Tou ‘60 xpnoipgonoinoe Tov 6po
Fewypapikd Xuotipata MNMAnpogopiwv (MM i GIS - Geographic Information Systems)
oTnv gpyaoia Tou «’Eva Xuotnpa Mewypa@ikv MNMAnpo@opiwy yia Xwpikd XxedIAop6»,
yla va nepiypdPelr 1O NpwTo AsIToupyikd olotnua  avdAuong XxapToypa@Ikwy
oedopévwy, nou avantuxbnke and Tov (010 yia TO OpOoOoNovOIakd UNoupyeio

daoOoKOPIag Kal aypoTIKAG avANTUéNG TNG KavadIkng KUBEpvnong.

Tnv dekaetia Tou ‘80, napdAAnia pe Tnv paydaia avdntuén Tng Texvoloyiag ta GIS
egpavidovral. H enavdotaon nou €@epav ol UNOAOYIOTEG OTn  dlaxeipion TNG
nAnpogopiag dpynoe va ayyi&el Tov Topéa TNG xwpIkAg nAnpogopiag, Kupiwg yia
TEXVIKOUG AOYOUG, Nou OXETICOVTal PE TIGC auénuéveg analtnoelg o ypaPikd. ‘OTav Spwe
Tn OekaeTia ToUu 1990 &enepdotnkav Ta Texvikd eunddia kal 6tav To KOOTOG TwV
OUOTNPATWY NAEKTPOVIKWY unoAoyloTwy €naye va eival anayopeuTikd, N eupeia
xprion Tou¢ odnynoe otnv avdantuén twv GIS kar otn otadiakn dnpioupyia Twv
anapaitnTwy XwpIkWy OedOPEVWY yIa Tn AgiIToupyia Twv ouoTNPdTwWY autwy. H
TEXvoAoyia auTh yvwpioe pia eupdtatn oelpd epapuoywy, oxedov oe kd0e ¢iTnua
Onou N NAPAPETPOG TNG YEWYPAPIKAG NANPOPOPIAG UNEICEPXETAl EUPECA N GUEOT
(F'kayiaAng, 2008).

2.1.2 Opiopdg

‘Eva TZMN eivar pia noAdnhokn, noAueninedn kar noAukAadiki oeipd d1adIKACIWVY KAl
anoPAocewy, €101 WOTE N HOPPN TWV TEAIKWV NPOoIOGVTWY Tou (MN.x. XAPTEG) va gival To
anoTéAeopa pIag oelpdg aluoidwTwy anopdoewyv. Mia onoladnnote alayn oe auti
TNV aAucida anopdoswy n diadikaoiwy, Ba gixe avand@eukTa oav anotéAeopa kdnola

AAMn popen xdpTn (Koutodnoulog, 2006).
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[MoAhoi epeuvnTéG, anodidouv dIAPOPETIKOUG OpPIoPOUG yia Ta X, XapakTnpioTikd

avagEépovrat:

«Ta T2 eivar €éva autonoinPévo oUVOAO AEITOUPYIV MOU MAPEXEl OTOUG
ENAYYEAMOATIEGC MPOXwPNMEVEG dUvVATOTNTEG yia Tnv anoBrikeuon, avdkrnon

dlaxeipion kar napouciaon XxwPIKWV OeOOPEVWY and TOV MPAYHATIKO KOOUO».
(Ozemoy, Smith kai Sicherman, 1981)

«Ta TXM avrinpoownedouv €va 10xupd oUvoho epyaleiwv yia Tn ouAhoyn,
anoBrikeuon, avdktnon katd BouAnon, HETAOXNPATIOPO KAl EUPAVION XWPIKWV

OEOOPEVWY ANO TOV NPEAYMATIKO KOOUO».
(Burrough P., 1986)

«Ta TZI eivar éva ovotnpa pe efehiypévec duvatoTnTes yew-e&opoiwong (Geo-

modeling)».

(Koshkariov, Tikunov kai Trofimov, 1989)

ZUpgpwva pe Tov XaAkid X. (2003) oto 4° ZuveEdpio «EMnvikn Thwooa kal Opoloyia» o
0po¢ GIS anodideral wg eGN¢:

«GIS - Geographical Information System: (Fewypagikd MAnpo@opiakd uotnua
- MX A Zvotnpa Tewypagikwyv MAnpogopiwy - IMX, A Fewypadikd ZUoTnpa
MAnpogopiwv 2M), To (ouo.). ZUvoho UAikoU, Aoyiopikod, kal OIadIKAoIWY TO
onofo pe TNV kAatdMnAn xprion unooTtnpiel Tn ouMoyn, diaxeipion, avdAuon,
povteAonoinon kal napouciaoon OedOPEVWV PE XWPIKA ava@opd. AnoTeAel
enfong onpavtikd epyaieio unooTnpigng Anyewv anopdoeswv otnv enfluon
noikiAwv npoBAnpudTwy dlaxeipiong kal oxedlaopou. TeAeutaia xpnolgonoleiTal
kar n andédoon Tou Opou w¢ Geographical Information Science (Emiotripn

Fewypa@ikwv MANPoPopIwV).»

And Toug napandvw opliohou oupnepaiveral Nwg éva MZM €xel TIg ENG TPEIC I010TNTEC:

e va anoBnkeloel, va dIAXEIPIOTEN KAl VA EVOWUATWOEI £va PEYAAO OYKO XWPIKWV

OTOIXEIWY,
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e anoteAel TO KATAMNASTEPO epyaleio xwpIknNg avAAuong, eoTIa(OPEVO €10IKA OTN
XWPIKA O1GOTACN TWV OTOIXEIWV Kal

e anotelel éva noAd anoteAeopatikd pnxaviopd yia Tnv  enfAuon  XwpIikwy
npoPAnpdTwy péoa and Tnv opydvwon, Tn OIOXEIPION KAl TO YETAOXNPATIONO
peydhou dykou OToIXeiwy, YE TETOIO TPOMO, MOU N NANpogopia va sivar NPooITh

o€ 6houc (Koutodnouhog, 2002).

‘Evag nio oAokAnpwpévog opiopdcs diatunwbnke and Tnv Federation Internationale de

Geometres (1983) oUppwva Pe Tov onoio:

«Ta GIS anotelolv éva epyaleio yia Tn AMPn anopdoewyv VOUIKAG, OIOIKNTIKAG
KOl OIKOVOMIKNAG UPNG Kal éva Opyavo yia TO oxeDIAONO Kal TNV avanTuén, To
onofo ané tTn pia anoteAeitar and pia Bdon dedopévwy NOU NEPIEXEl YIA HIa
€KTOON OTOIXEIO NMPOODIOPIOPEVA OTO XWPEO KAl Ta onofa oxeridovral hJe TN yn
kar and Tnv AAAn, anoteAeital and d1adIKACIEG KAl TEXVIKEG Y1 TN CUOTNHPATIKA
ouMoyn, evnpépwon, eneéepyaoia kal diavoun Twv oToixeiwv. H Bdon evég GIS
givar €va eviaio oUoTnpa YeEwyPAPIKNG avagopdg, To onoio OleUkoAUvEl Tn
ouvdeon Twv oOToIxeiwv PeTAEU TOouc KaABWC kal pe AAAa ouoTApaATA MNou

NEPIEXOUV OTOIXEIQ yIA TN yN.»

O napandvw opiopog Kpiveral Mo oAoKANPwPEVOG and Toug NPonyoupevoucs OI0TI
yivetar yia npwtn @opd avapopd oTnv VoK, OIOIKNTIKA, OIKOVOPIKA aAAG Kal

KoIvwVIKNA O1doTtaon Twy MX1.

Ze oUykplion PE TOuG anAoucg xdpteg, €éva ouotnpa GIS €xer To nAeovéktnpa 6T n
anoBrikeuon Twv OedOMEVWY YiIVETaI XwPIOTd and TNV avanapdoTacn TouG. AuTO éxel
oav anotéAeopa Ta idla dedopéva va pnopouv va avanapaotabouv pe dIaPpopEeTIKOUG
TPONOUG M.X. NOPOUME va peyeBUvoupe Tov (Pn@iakd NAéov) xdpTn, va ePPAvioOoUpE
OUYKEKPIMEVEG HOVO  MEPIOXEG, VA  KAVOUPE unoAloylopols anootdoewv  HETa&U
TOMOBEOIWY, VO ONPIOUPYNOOUME NIVAKES NOU Va OgiXxvouv Ta d1IdPOoPa XaPAKTNPIOTIKA
Tou XxdpTn, va ungpbéooupe emnAéov nAnpogopia ndvw oto xdptn (KwoTtdpag,
2000).

Mépav TnG duvaTdTNTAG 0XeDIAONG KAl XEIPIOPOU XapTwy, €va ouotnpa GIS pnopel va
ouVvOEel eEWTEPIKEG BAOEIG OEOOUEVWV PE AVTIKEIMEVA MOU AVAKOUV OTO XdpTn. Autr n
oUvdeon eniTpénel Onoie¢ alayég yivovral oTi¢ Bdoeig dedopévwy, va ¢aivovral

apéowg oTo xdpTn KaBw¢ kar Tnv unoPBoAn epwtnoewv otn Bdon Oedopévwy
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aneuBeiag and To xdptn. Enfong, diabétel éva oldvolo and epyaleia nou pnopouv va
dlaxwpioouv Ta didpopa OedoPEVa Nou gival anoBnkeupéva oTI¢ eEWTEPIKEG PAOEIg
OedOUEVWY, €PPAVICOVTAC aVTIKEIUEVA N MEPIOXEG MOU  IKAVOMOIOUV OUYKEKPIPEVA

KQITAPIO PE OIAPOPETIKA XPWHATA N OXAPATA.

H nAnpo@gopia anoBnkevetar wg 1016TnTa (attribute) Tou ypagikd napoucialdpevou
XAPAKTNPIOTIKOU o€ pia Bdon Aedopévwv (BA). Tia kéOe xapaktnpioTikd (feature)
anoBnkevovTal Tpelc Baoikég nAnpogopie¢ otn BA: n yewypagikh nAnpogopia, n
npooAn (projection) ndvw oTnv onoia ekPPAdeETal N yewypaPikn nAnpogopia kal n
1016TNTA ToU, KABWG Kal NANPOPOPIEG Nou oxeTi(ovTal PeE TO TI XAPAKTNPIOTIKO gival,

nou Bpiokeral kar nwg oxeTideTal pe dAa xapaktnpioTikd (ESRI, 1990).

Ta dedopéva opyavwvovral oe Oepatikd enineda (layers, coverage) o6nou 1o KA&Oe
eninedo avanapiotd €éva koivd  xapaktnploTikd  (feature). ‘Eva  ouvorlo and
XapPaAKTNPIOTIKG (N.x. 6Ao TO 00IKG dikTUO) BewpouvTal wes eva otpwpa (layer) (ESRI,
1990; Maplinfo Corporation, 2009). TonoBetwvtac AuTeG TIG OIAPAVEIEC TN pIa NAVW
oTnv dAMn dnpioupyoupe évav nhnpn xdptn. To GIS ovotnpa ouvduddel didgopa
OTPWHATA YIA VO ANaviNoel O€ OUYKEKPIPEVEG XWPIKEG EPWTAOEIG. XAPAKTNPIOTIKA MOU
oxeTiCovral peTa&l Toug, ONwe n.x. NoTdpia kar kavdAia, 6a pnopouv va gugavidovral
o€ éva OTPWHA, ev) unodoun, Oonwg dpopol, va eugavidovral oe dMo oTpwpa. ‘OTtav
KANoIa XapakTNEIOTIKA Ogv evOIAPEPOUV TO XpHoTn ot Kdnola xpovikn oTiypn, Oa
Mnopel va T° anokpunTel gppaviovrag gévo Tnv nAnpo@opia mou Tov evOIAPEPE!
(Gillings & Wise 1990).

Ta dedopéva autd, ouvibwe Aéyovtal yewypagikd i xaptoypadikd i xwpikd spatial
data) kar pnopei va ouoxetiCovral pe pia ogipd and neprypagikd dedopéva (attribute
data) nou Ta xapakTnpiCouv povadikd. Ta xwpikd dedopéva eival ouvnbwg oe duo
Mop@EG. H npwTn gival og popen Ynpidwtou (raster data), Onwg dOPUPOPIKEG EIKOVEC,
agpopwToypagpiec kar dAMa €idn nAaiciwv 6nou n nAnpogopia ouvdéeTal Pe Ta
eikovooToixeia  (pixels) Twv eikévwyv. H dedtepn popepnt eivar Ta dlavuopaTikd

oedopéva (vector data), Ta onoia opyavwvovtal o YnPiakn popen:

* Xnpeiwv (points), n.x. agpodpdpia, onitia, NéAeIg, dEvTpa KA.

* Fpappwv (lines), n.x. dpdpol, NoTAPIa, CWANVWOEIG, KAM., Kal

* [loAuywvwv (areas), n.x. KOMPATIO VYNG OQOTIKEG NEPIOXEG, MEPIPEPEIEG  KAM
(F'kat¢éphiag, 2007).
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2to 2xnpa 2-1 napouoiddetal n apxn Aeiroupyiag Twv GIS, énou ol enipépoug
Oepatikég Pabpideg xaptoypagiki¢ nAnpogopiag ouvdudlovral oe pia kar Povo
onTikA aneikdévion, n onoia ouvdéeTal pe Bdon Oedopévwy yia To OUVOAO Twv

XAPAKTNPIOTIKWY Nou auth n aneikévion nepihapfdver (fkayiairig, 2008).
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IxApa 2-1 Apxn Aerroupyiag GIS (Mkayiairig, 2008)
Ye pia nmio yevikn popen, éva TZI eivar éva epyaleio "é€unvou xdptn', TO0 onoio
ENITPENEI OTOUG XPAOTEG TOU VA ANOTUNWOOUV Hia nepiAnPn Tou npaypaTtikou kGoUou,
va dnpioupynoouv d1adpaocTIKd €PWTNOEIS XWPIKOU N NePIypPaAPIKoU xapakTripa
(avadnTnoelg dnpioupyoUpeveg and Tov xpnaoTn), va avaAloouv Ta xwpikd OedouEva
(spatial data), va Ta npooapudéoouv kal va Ta anodwoouv o€ avaloyikd pEoa
(EKTUNWOEIG XAPTWV KAl OlAYPAPMATWY) N ot Yn@piakd péoa (apxeia XwpIkwy

O0edopEVWY, O1adPACTIKOI XAPTEG 0TO AIADIKTUO).

Ta ouotipata GIS, énwg kar ta ouotipata CAD, anoTunwvouv xwplkd 0edopéva o€
YEWYPAPIKO N xapToypa@ikd n kapteoiavd oloTnua  CUVTETAYMEVWY. Baoikd
xapakTNEIoTIKO Twv X[ eivar 6T Ta XwPIKG dedopEVa ouvOELOVTal KAl JE NEPIYPAPIKA
0edopéva, n.x. Jia opdda onpeiwv nou avanapioTolyv B€oeig NOAewyV oUVOEETal PE €va
nivaka énou kd0e eyypagpn ektd¢ and tn B€on nepiéxel NANPoPopieq dnwg ovopaoia,

NANBuop &G KAN.
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[MoANEG popEg N oAokAnpwpeévn €vvola Twy GIS (integrated GIS concept) enekreiveral
yla va oupnepiAdBer Téoo ta dedopéva (nou anoteholv ouoIaoTIKG TOV NMUPHvVa Toug),
TO AoyIopIKG Kal TOV pnxavikod eéonAiopd, 6oo kar TI¢ O1adIKaoieg Kal TO avOpwnivo
duvauikd, nou anoteAoUv avandéonaoTa THAPATA evOG Opyaviopou, 0 0Nnofog €xel oav

NPwTApPXIKA Tou dpaoTnPIdTNTa TNV diaxeipion nAnpogopiac pe Tnv BoriBeia GIS.

Opidovrag Aoinév 10 Tewypagikd Xvotnpa  [Anpogopiwy, PnopoUpe va TO
XAPOAKTNPIOOUPE WG €éva Oopyavwpévo oUvolo and névie OOPIKA OTOIXEA MNou
nepihapBdavouv  UuAik6d  eonhiopd  (hardware), Aoyiopikd  (software), yewypa@ikd
oedopéva, avbpwnivo duvapikd kal pebddoug, pe okond Tn ouAlhoyn, kataxwplion,
dlaxeipion, avdiuon, enefepyaoia kalr andédoon, k&Oe popPnri¢ nAnpogopiac nou
OXeTICETAI PE TN YEWYPAPIKA NAnpogopia. ‘Eva yewypa@ikd ocUoTnpa NANPOQOPIWY
eival éva gpyaleio xaptoypdenong kal avaAuoNng TwV OTOIXEIWY NOU UNAPXOUV KAl TwV
YyeEYovOTWY nou oupfaivouv oTo yewypapikd xwpo. H texvohoyia Twv GIS ohokAnpwvel
TIG A&IToupyieG Twv ouvhBwv epappoywy Bdoswyv dedopévwy, dnw¢ avadiTtnon kal
oTamioTikh - avdAuon, e Ta NAEOVEKTAPATA TNG OMNTIKAG ANEIKOVIONG KAl TNG
YEWYPAPIKNG avdAuong Nou NMPoopEPOUV o1 XAPTEG. AKOPaO, O€ OUYKPION HE TOUG
anhouq xdpTeg, €éva ouvoTtnpa TZI €xel To nAeovéktnua OTI N anobrikeuon Twv
dedopévwy yiveTal xwploTd and Tnv avanapdoTaon Toug ki auTd €xel 0av anoTéAeoua
Ta 010 dedopéva va pnopoulv va avanapaotabouv pe OlaPOPETIKOUG TPOMOUG.
EninAéov, éva ovotnpa XM éxel OAa ekeiva Ta nAeovektnpata and Tn xprion Twv H/Y
onwe,  Olaxeipion  peydAdwv  noooThTwyv  Oedopévwy  eUkoAa  kal  ypriyopa
(Koutodénouhog, 2002).

2.1.3 TlAeovekTApATA Kal PEIOVEKTApATA TwV XN

Ta TZMN o6nw¢ kar kdBe epyaleio peAéTNg €xouv TOOO nAgovekThpATA G600 KAl

pelovektripaTa. Autd eival Ta akéAouBa (Aotdpacg et al., 2007):

[MAgoveKTAUATA:

e Ta dedopgva diatnpolvral oe PYnPIaKN HOPPH PE ANOTEAEOPa aPevog PeV va
KaTaAapBAvouy pIKpO XwPo, APeTEPOU OE va eival eUxpnaoTa.

o O yewypa®Ikeg Bdoeig dedopévwy eival NOCOTIKEG MANPOPOPIEG 01 ONOieG Eival
OuvaTdVv va KaTaxwpouvTal Katd onoladnnoTe yewypagikn povada i didraén,

yla napddelypa, katd Onpo, katd Tonoypagikd GUAAO xdpTn, KATG VOUO.
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lewypaikég Pdoeig dedopévwy  eival duvatdv va  onpioupynboulv  yia
OnolodNMOTE AVTIKEIPNEVO, XAPAKTNPIOTIKG, 1010TNTA 1 ouvOUAOUS TwV Mo NAVW
OedOPEVWY. YNAPXOVTa OeDOPEVA gival duvVATOV va evowpatwdouv — e i xwpig
aMayeg kar enefgpyaoia- otn Bdon dedopévwy epdoov gival KaTtd XwpPo
nPooavatoANiopéva.

Eivar epiktéc o ypriyopo¢ kar enavailapBavopevog avaluTikdG €Aeyxoc
OewpnTIKWV POVTEAWY yIa TNV EKTIUNON ENIOTNPOVIKWY KPITNPIWV.

O1 d1Idpopeg HOPPEC eEayopévwy anoTeAeopdTwy napdyovral NoAd ypriyopa,
anotelolvtal and pepovwpéva i olvBeta B€uata, yia onoladnnote B€on Tng
Bdong dedopévwy kal o€ onoladnnoTe KAIHaKa.

Eivar duvati n eUkoAn evnpépwon Tng Bdong dedopévwy, npdypa nou
ENITPENEI TOV ANOTEAEOUATIKG evioniopd Kal TNV avdAuon Twv aAlaywv nou
€yivav o€ dUo N NEPIOOOTEPEG NEPIOOOUG.

MoAEG poppEg avdAuong npaypaTonolouvtal he NoAU PIKPOTEPO KOOTOG and
OTI e TIC KAOOOIKEGC HEOBOOOUG N.X. O UMNOAOYIOPOG Twv KAOEwV €vOg
Tonoypagikou xdapTn.

‘ONec o1 avaAloelg yivovral KaTd avTikelhevikd TPOMNO Kal T anoTeAéopaTa

napAayovral autépara.

MelovekThpyaTa:

To apxikd KOOTOG aANOKTNONG TOU OUOTAPATOG KABWG KAl TNG TEXVIKAG
unooTtipIENG kal ouvtipnong autou, eival apkeTd uPnAo.

H anoteheopatiknh xprion Tou cuoTApaTOG NpolnoBétel TNy dpTia eknaideuon
TOU KatdAAnAou npoownikou.

Yndpxouv npoPAipara kaTd Tn  PETATPONNA KAl KATAXWPENON OPIOHEVWY

NPOUNAPXOVTWY OEDOPEVWY OE OUYKEKPIPEVN BAoN OeDOPEVWV.

2.2 Eicaywyn oto ArcGIS

2.2.1 Aoyiopikd ArcGIS

To ArcGIS €ival pia ohokAnpwpévn ouhoyri and npoiévra AoyiopikoU GIS Tng eTaipiag

ESRI. Zdppwva pe tnv ESRI (2010, ané Marathon Data Systems) napéxel pia

nAatpoppa  yia  Oladikaoieq  xwpIkng avdAuong, Olaxeipiong OedOPEVWY KAl

aneikéviong. To ArcGIS eival enektdoiyo kar pnopei va evowpatwOel oe non
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UNAdPXovVTa CUCTAPATA EMIXEIPNOIAKWY d1adIKAOIWY O6nws work order management,

business intelligence kar executive dashboards.

To ArcGIS pnopel va xpnoipgonon@ei navrou eite oe nepifdAov desktop eite péow
servers kal popNTwyY cUoKeUwv. Mnopel akdépa va xpnoipgonoinBei yia va npooneAdoel
online unnpeoie¢. Me yvwon npoypappaTtiopou, 1o ArcGIS napéxel epyalsia yia tnv

dnuIoupyia EpapPoywyV oUPPWVaA PE TIGC EKGOTOTE AVAYKEG.

To ArcGIS xpnoiponolgital og dIAPOPOUC Opyaviopous WOoTe va BeATIWooUV Th pon

TWV €PYACIWV TOUG KAl va AUoOUV Ta nio enfpova npoBAnpaTa Touc.
Xpnoipétnta Tou ArcGlIS:

e Alaxeipion Ogdopévwyv / nopwv: evowpdTwon ouoTnpdTwy, Odlaxeipion
unobéocwv/agiwoewy, odlaxeipion neploxwyv egunnpérnong/  eubuvng  kal
dlaxelpion neAatwv

e AvdAuon kal oxedlaopoG: NPoBAEYEIC kal avdAuon Kivouvou

e Enixelpnolakég O1adIKAOTEG: TNAEPWVIKO KEVTPO/ANOOTOAEG, napakohoudnon kal
ouMoyn dedopevwy and To nedio, eMBeWPNOEIG, CUVTAPNON KAl AEITOUPYIEG,
dpopoAdynon

e Eniyvwon kaTtaotdoswv: unootipién Aiyng anogdoswyv kar npéofaon and

neAdTec/koivéd

To ArcGIS napéxer didpopa Aoyiopikd 6nws Desktop, Server, Web, Mobile, yia tnv
dleknepaiwon dIaPOPETIKWY gpyaoiwy oe desktop, oto nedio n yia xprion «Kai
kolvonoinon nAnpo@opiwv oTo internet. ‘Exouv kukAopopnoel pia ogipd and ekddoeIg
TwV Aoylopikwv ArcGlIS, pe Tnv nio odyxpovn va eivai n ékdoon ArcGIS 10. Téhog, and
TNV KUKAogopia Tou ArcGIS 9 «kar €neira, unootnpi¢etar n  yAwooa Python
(eykaBioTaTal autépaTa Pe TNV eykatdotaon Tou AoyiopikoU ArcGlS) kai eivar duvatédv
yla k&noiov va ypdyer autdvouEeG EQAPPOYEGC OE AUTNV Tn YAWOOd, 6nou pnopouv va

xpnolponomBouv oav diadikaoieg and 1o ArcGlS.

2.2.2 ArcGIlS - Desktop

To ArcGIS Desktop (ESRI 2004, ané Marathon Data Systems) nepiAapfdvel pia opdda
and evonoIiNPEVeS EpAPUOYEC OTIG onoiec oupnepidapBdvovral Ta ArcCatalog, ArcMap,
ArcClobe, ArcToolbox kar ModelBuilder. H evonoinuévn a§ionoinon Twv epappoywyv

ArcGIS Desktop eniTpénel otoug XxpnoTeg TG Texvoloyiag Twv [ewypa@ikwy
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ZuoTtnpdtwy MAnpo@opiwyv va uhonolodv onoladnNoTe epyacia Pe eNKEVTPO TO XWPEO,
and Tnv nio anA €wg TNV Mo noAuniokn, nwg gival N xapToypagia, N yewypaikn
avdiluon, n eneéepyaoia TwV yeEWYPAPIKWY OeOOPEVWY, N peTaTponn peTady
OIOPOPETIKWY HOPPOTUNWY OEDOPEVWY, N AMEIKOVION, N JIAXEPION TWV OEOOHEVWV

K.d.

H dopnn tou ArcGIS Desktop eivar kAlpakodpevn w¢ npog TIGC OUVATOTNTEG TNG
NPOKEIEVOU VA eKNANPWOEI TIGC ANAITACEIC TWV OIAPOPETIKWY TUNWV  XPNOTWV.
AvdAoya pe TI XaPAKTNPIOTIKG XPEIAdeTal Kaveig, pnopel va emAé€el peta&y Tpiwv
ennédwv  adeioddtnong Ttou ArcGIS Desktop (Arclnfo, ArcEditor, ArcView). Ta
npoiovra tou ArcGIS Desktop poipddovral Tig idiec epappoyeg (ArcMap, ArcCatalog),
dlenagéc xpnoTwy kal nepifdMov avdantuéng. Kabwg o1 xprioTeg kivouvrar and Tov
ArcView otov ArcEditor kai otov Arclnfo diatiBerar emnpdoBern AeitoupyikétnTta. Ta

Tpia dlakpITd enfneda duvaTtoTiTwy Tou Aoyiopikou ArcGIS Desktop eivarl Ta e§A¢:

1. Aoylopikd aneikéviong, ene&epyaciag kal avaAuong TwY YEWYPAPIKWY OEQOUEVWY —

ArcView.

2. Noylopikd NARpouG DIOXEIPIONG KAl eNEEEPYAniag TWV YEWYPAPIKWY OEDOPEVWV -
ArcEditor.

3. NAoyiopikdé nAfipoug diaxeipiong, enefgpyaoiag kar avdluong Twv yewypapIKwV

dedopevwy - Arclnfo.

2.2.2.1 ArcView

To ArcView (ESRI, 2004) eivar pia desktop epappuoyn nou ouvavtdral oTa YEwYPAPIKA
nAnpogoplakd ouoTApPATa Kal XPNOIPoNoIETal yia Tnv Baociki  aneikévion, Tnv
dlaxeipion, TNV dnpioupyia kal TNV avdAuon yewypa@ikwy dedopévwy. Me Tn xprion
Tou ArcView yivetal karavontd TO YEWYPAPIKO NEPIEXOPEVO Twv OeDOMEVWY,
ENITPENOVTAG £TOI VA OEI KAVEIG TIG OXEOEIG METAEU TwV DEDOPEVWYV KAl VA AVayVWPIOEl

Ta NPAOTUNA PE VEOUG TPOMOUG.
Ta kUpia xapaktnploTikG Tou ArcView givai:

e Anpioupyia xaptwyv - Me Tn xpron npPokaBopiopévwy nEoTUNnwyY XapTwy
eEoIKOVOMEITal XpOvOog Kal yiveTal eUkoAa N napaywyr opoIOPOPPWY KAl CUVENWY

XAPTWV.
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o Xwplkd epwtipara - YnoBoAn epwtnudtwy ota dedopéva kal enfAuon nepinAokwy
npoPBAnudTwy  péoa and  pia  noikINa  gpyaAeiwv:  OladPAOTIKA  pETPNON
anooTdoewy, eUpeon OTOIXEIWV OTO xdpTn, enmAoyn Oedopevwy pe Pdon Tnv
TonoBeoia 1 kANOIO XaAPAKTNPIOTIKG Toug, anoenmdoyrn OAwv, npdofaon oOTIG
I010TNTEC TV eMNEOWYV pEoa and To kouTi diaAdyou Tou Identify, kar nOAAG dAAQ.

e Baoiki povrehonoinon kal avdAuon p€ow POVTEAWV dIadIKAoIWY, scripts Kal
dlaypapdpdTwy pong — Movtedonoinon XwpPIKWY OCUOXETIOEWY, PETPNON NWG TA

oToIxeia péoa oe pia ouhhoyn dedopEvwy oxeTiCovTal peTa&y TOUG OTO XWPO, KAl

onTikonoinon - napoucioon Twv aNOTEAEOPdTWY pE€oa and avagopEés Kal
dlaypdupara.
e AnAA ene&epyaocia oToixeiwv kal evonoinon dedopévwy - Anpioupyia  kal

enefepyaoia  ONPEIAKWY, YPAUMIKWY KAl MOAUYWVIKWY OTOIXElwv  KaBWG  Kal
ENe&EPYAOIa TWV XAPAKTNPIOTIKWY TOUG.

e Xprion piag¢ peydAnc ouMoyri¢ and €idn dedopévwy nou  nepiAapBdvouv
onpoypagikd oToixeia, eykaraotdoels, CAD apxeia, IKOVEG, OIKTUOKEG EPAPUOYEG,
Kal noAup€oa.

e ETOINEG NPOG Xprion oUAMoVEG dedopévwy — Apeon anegikdvion kal avdAuon pe Tnv
Borbeia Twv evowpatwpévwy dedopévwy TnG ESRI kar Tou Maps Media Kit, nou
evnuepwvovtal k&be xpdvo kal €éxouv npo-Olapoppwlel woTte va douledouv
OUYKEKPIPEVA Pe TO Aoyiopikd TnG ESRI.

e Auvatotnta enekTdoewv — [1pooOrikn NePICOOTEPWY OUVATOTNTWY KAl EMEKTAON
NG dUvapng Tou ArcView pe Tn xprion piag¢ N nepioodTepwy and TIG MOMEG
npoalpeTikéG enektdoel¢ Tou ArcGIS Desktop (ArcGIS Desktop extensions). Oi
ENEKTAOEIG AUTEG ENITPENOUV TNV MPAYPATONONON MIO ANAITNTIKWY AEITOUPYIWY,

Onwce yewene&epyaoia NAeyPaTIKWV apxeiwv kal TpiodidoTarn avdAuon.

2.2.2.2 ArcEditor

To Aoyiopiké ArcEditor (ESRI, 2004) anoteAei pia nAripn Adon Aoyiopikod GIS o€ oxéon
Me TNV ene€gpyacnia kal hge TN dlaxeipion Twy YewyPaPIKWY dedopévwy. MNepiéxovTag To
oUvolo Twv OUVATOTATWY MNou NpPoo®épel To Aoylopiké ArcView, 1o ArcEditor éxel
eninAéov evowpaTwpévo €va nAoldolo ouvolo gpyaleiwv eneepyaoiac kar enikUpwong

YEWYPAPIKWY DEDOPEVWV.
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To Aoyiopikd ArcEditor unootnpidel 7600 TN duvaTOTNTA ene&epyaciag TwV OeOOUEVWV
and povadikd xpnotn, 600 kKal TN OuvatdTNTa TAUTOXPOVNG enefepyaoiac Twv

dedopévwy anod noAoug xproTec.

O1 NA€ov avTINPOOWNEUTIKEG EPYAOIEG NOU PNopouv va uhonoinbouv Pe TO Aoyiopikd

ArcEditor givar:

e Anpioupyia kal enegepyaoia dedopévwy GIS pe Tn xprion gpyaleiwv ene&epyaoiag
0xed1A0TIKOU TUMOU.

e Anpioupyia nhoUoiwv o€ OUVATOTNTEG YEWYPAPIKWY PAoewyv OedOPEVWY  [E
QVTIKEIMEVA NMOU €XOUV EVOWMATWHEVN OUMPNEPIPOPA, OUVOOEUSHEVN AMNO KAVOVEG
eNkUPWOoNG.

e Movtehonoinon NOAUNAOKWY powv epyaciag KaTd TNy enefgpyacia Twv OEDOPEVWV
o€ nepifdrovra Tautéxpovng npéofaong and NoAAOUG XproTe.

e Anpioupyia kal ouvTAPNON TNG XWPIKAG AKEPAIOTNTAG TWV OEDOPEVWV.

e Anpioupyia, Olaxeipion kal digpedvnon  YeEWHETPIKWY  OIKTUWY, OnAadn Tou
TonoloyikoU POvTéAOU MOU  XPNOoIPoNoIE(Tal  oTnv  povtehonoinon  dIKTUwV
povodIGoTaTNG PONG, ONWG AUTWY TNG PHETAPOPAG N TNG OIAVOPNG TOU NAEKTPIKOU
dIkTUOU.

e AU&non Tng anddoong kal TNG NApaywylkOTNTag Katd Tnv enggepyaoia Twv
OEQOPEVWV.

e Alaxeipion Tou nepifdAlovrog ene&epyaciag MOAWY xpnoTwy P€ow Tou versioning.

e Anoouvdedepévn enegepyaoia (disconnected editing) Twv 0edopévwv and Tnv
KevTpIkN BAon ki evnuépwon Toug oTo nedio.

e Ynootipién TonoAoyiac otn PBdon dedopévwy ouvodeudpevn and KAvoveG Kal
oupnepipopd. Mnopei va npayuaronoin@eil o evroniopds kai n d16pbwon Twv
OPAAUATWY KATW aNd OUYKEKPIPEVOUG KAVOVEG enikUpwong nou diacpaiifouv Tn
XWPIKA aKeEPAIOTNTA TWV OEOOUEVWV.

e Ynootipién kavévwyv akepaIOTNTAG TWV MNEPIYPAPIKWY  XAPAKTNPIOTIKWY  TWV
OEQOPEVWV.

e Epyakeia enegepyaoiac annotation (ypagikwv oxohiwv eni Tou xdptn) TO onoio
MNOPEl va eival OUVOEDEUEVO HE OUYKEKPIMEVA XwpPIkG oToixeia (feature linked

annotation).
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2.2.2.3 Arclnfo

To Aoyiopikd Arclnfo (ESRI, 2004) epnepiéxel NANPWGE TIG AEITOUPYIKEG OUVATOTNTEG TWV

Aoyiopikwyv ArcEditor kar ArcView, npoo@Eépoviag €MMAEOV TEXVIKEG MPOXWPNUEVWY

XWPIKWV avaAloewy, OIOXEIPIONG XWPEIKWY OEOOPEVWY KAl UPNAAG XapTOyPAPIKAG

anédoonc.

Anotelel  Tnv o ohokAnpwpévn  Adon  Aoyiopikod  GIS-Desktop, €xovrag wg

AVTINPOOWMEUTIKG XAPAKTNPIOTIKA:

1.

Xto nedio TnG xwplkng avdhuong ‘Evag  peydhog  aplBuog  epyaleiwv
YEWYPAPIKAG eneéepyaoiag divel oto Aoyiopiké  Arcinfo 1t duvatdrnta
uAonoinong NPoxXwPNPEVWY avaAIoEWY TWV XWPIKWY OedOPEVWY. EVOEIKTIKA
avapépovTal ol eNOPEVEG OUVATOTNTEG:
i. Avaluoeic enikdAuyng 6nwe ‘Evwon, Alatopn, Analoipn.
ii. AvaAdoeig eyyutntag onw¢ Anpioupyia  dwvng enipponig,  Eyyutnta,
AndoTtaon onpeiwv.
iii. AvaAuoeig enipaveiwyv onwes ‘Oyng, Zxiaong, Kihiong.
iv. Enefepyaoia kal peratponn nAeypaTikwy OeOOPEVWV.
Y10 nedio TnNG dlaxeipiong Xwplkwyv OedopEévwy: XTo  Aoyiopikd - Arcinfo
NPOOPEPOVTAI  TEXVIKEG EKTETAPEVNG  OIOXEIPIONG TOU OXAPATOG KAl TWV
OedOEVWV TNG VEWYPAPIKAG PAong dedopévwy. EVOEIKTIKG avagépovral ol
ENOPEVEC OUVATOTNTEC:
i. Anpioupyia yewypa@ikwy Bdoswv dedoPEVWV EVOG N MOAMWY XpNOTWV.
ii. Eappoyn Texvikwv xwpIkng avdAuong yia Tn peTtapopd dedopévwy and
Kl NPOG TNV yewypagikn BAon dedopEVWY.
iii. Meratponn Twv Oedopévwy TNG Yewypagikng Bdong¢ oe noAhoug,
OIAPOPETIKOUG HOPPATUMNOUG.

iv. Yhonoinon padikwv ene&epyaoiwyv ota 0edopEVa TNG YEWYPAPIKAG BAoN.

. 210 nedio TnG xaproypa@ikng anddoong: To Aoyiopikd Arcinfo anAonoief

1d1aiTEPa TN dnpIoupyia xapTwyv UYPNAAG NoIdTNTAG, HEOW EUXPNOTWY EPYAAEiWV
KAl TEXVIKWV Onpioupyiag xaptwyv. EVOEIKTIKE avagépovral ol eNOUEVEG
OuUVaTOTNTEC:
i. AidBeon peydAou apiBuoU NPATUNWY XAPTWY, XAPTOYPAPIKWY OUMBOAWY
KOl OTOIXEIWV.

ii. EUxpnoTeg TeXVIKEG anddooNn cupBOAwY Kal xapTOyPAPIKAG OXEDIAONG.
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ili. AuvaTtétnTa Xpriong KAvovwy yia TNV autohaTn TonoBérnon KelPEvVou Kal
ETIKETWV OTO XAPTN.

iv. Evowpdtwon Tng enéktaonc Tou AoyiopikoU ArcGIS, Maplex yia Tnv
evioxuon TwV MNPOOPEPOPEVWV TEXVIKWY TOMOOETNONG  KEIPEVOU KAl

ETIKETWV OTO XAPTN.

2.2.3 ArcGIS Extensions

O1 enektdoelg Tou nepiBdhovtog Tou ArcGlS, anoteholv EexwploTd npoidvra Ta onoia
nPooBETouv eninAéov AeIToupyIkOTNTA OTO AOYIOHIKO MAKETO. AUTA Ta €&eIdIKEUpEVA
gpyaAeia enmTpénouv oTo Xxpriotn va aoxoAnBei pe npoxwpnpéva Ofuata, Onwg
TpIodIdoTaTn onTikonoinon, xwpEiki avdAuon, yewoTtatioTikh, avdAluon OIKTUwY, Kal
noA\G aképa. Mapakdtw neprypdpovral ouvonTikd, OUo and TIG KUPIGTEPEG ENEKTAOEI

Tou ArcGlIS, nou anarrodvral yia Tnv dieknepaiwon TG napoloag epyaciag.

2.2.3.1 ArcGlIS 3D Analyst

To ArcGIS 3D Analyst (ESRI, 2010) eival pia and Ti¢ BaoikOTEPEG €NEKTAOCEIC TOU
ArcGIS Desktop nou enTpénel Tnv anoteAecpaTiki  aneikévion kal  avdAuon
dedopévwy. H onpavtikdétepn Aeiroupyia Tou, eival n aneikdvion TnG TPITNG d1IdoTaoNg
and Yneiakd dedopeva Ta onoia éxouv otn Bdon Toug kdnola TP z (n.x: UYog,
dBoc). Eivar enfong n pévn enéktaon nou nPoo@épel TO OIKO TNG €EEIDIKEUPEVO
nepiBdaAov epyaoiag yia Tnv aneikévion, diaxeipion kar avdAuon Twv TpIodIGoTATWY

oedopevwy, To ArcScene.

Xpnoiponoiwvrag 1o ArcGIS 3D ArcGlS, eival duvath n aneikdévion piag enipaveia and
NOAMEC ONTIKEG ywvieg, N el0aywyn epWTNPATWY OXETIKG PE pIa EMPAVEIQ, PE TOUG
kaTdAMnAouc aAyépiBpouc va kaBopioTolv ol NEPIOXEG Mou eival opaTéG and pia
eniheypévn B€on og pia enipdveia, N dNPIoUPYIa PIaG PEAAIOTIKAG EIKOVAG MPOOMTIKAG
nou nepifdAer nAeypatikd kar dlavuopaTtikd oTtoixeia ndvw and pia em@dveia Kal

eninAéov va kataypdyPeTe 11 va ekTeAéoeTe TpiodIdoTaTn nAoriynon.
2.2.3.2 ArcGIS Spatial Analyst

To ArcGIS Spatial Analyst (ESRI, 2010) eivar pia enéktaon Tou ArcGIS Desktop nou
NapeExel 10Xupd epyaAeia  yia NEPIEKTIKA  XwPIKA  povTehonoinon kalr  avdAuon
Baolopévn kupiwg og nAeypaTikd (raster) dedopéva. Emrpéner Tn dnpioupyia, avdAuon

Kal  xapToypagikn  anddoon  nAeypaTIKWY  OedOPEVWY KAl TNV uAonoinon
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olAokAnpwpévng nAeypaTikig - dlavuopaTikig (raster - vector) avdiuonc. Eival
1I010{TEPA Xprioipo, 6TaV N anaitoUpevn PovTeAonoinon Tou XWPOou anaitel KaAng

noidTNTag XwpIkn avaiuon.

Xpnoiponoiwvtag 1o ArcGIS Spatial Analyst, pnopei kédnolog va e&dyel véa nAnpogopia
and Ta undpxovra OedOpEVa, VA AVAAUOEI XWPIKEG OXEOEIG, VA ONUIOUPYNOEl XWPIKA

MOVTEAO KAl va eKTEAEOEI MOAUMAOKEG AEITOUPYIEG MAEYHATIKWY OEQOMEVWV.

Ta povréha nou epapuodlovrar oto Spatial Analyst epnepiéxouv Tekpnpiwon pe
anotéAeopa va yiverar eUukoha katavonti n Oladikaoia XwpIkAg avdluong nou
epappoCeral, va efetdlovrar ta what-if oevdpia kar va emrpénouv Tn ouykpion

anoTEAEOPATWVY.
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2.3 Anpioupyia (kataokeuni) Tou povréhou - Model Builder

2.3.1 Eicaywyn

To Model Builder givar éva gpyaAeio Tng ESRI nou BonBd oTn dnpioupyia, ene&epyaoia
kar dlaxeipion xwpikwv poviéAwv. To Model Builder, pnopel va OewpnOei w¢ pia
ONTIKA YAWoOoO NpoypapuaTtiopoy yia Tn dnuioupyia powv gpyaoiag. Ta povréha nou
avantyooovTal gival PoEg epyaciwv nou ouvoudlouv akoloubiec Twv epyaleiwv
yewene&epyaoiag, TPoPodoTwVTAG TNV ££000 evOG epyaleiou (Output A) pe Tnv €i00d0

€vOC GAAOU.

Model Edit Insert View Windows Help

HS VAR X9 S BB ARN KRSV D

EA ———— 3
s P : N

Geoprocessing { R Geoprocessing
Tool A \ ) Tool B

IxApa 2-2 Mapddelypa anAoy JOVTEAOU EPYACIWY.

To povrého nou avantuxBnke, anoTeleitar and éva oUvolo OladIKaAoIWV
yewene&epyaoiag kal JeTaTpénel Ta elogpxOpeva Oedopéva oe éva apxeio  “feature
class” pe yewypagikd Oedopéva, OTO OMNofo €XOuv OUYKEVTPWOEI oI anaITOUPEVEG
nANPogopieg yia Tov unohoyiopd Twv JEIKTWY Nou xpelddovral yia Tov NPoodIopioud
NG peTaBoArig Tou avayAugou. Ta apxeia “feature class” anoteholv pia cuAhoyri and
YEWYPAPIKG Oedopéva e Tov (010 TUNO yewperpiag (6nwg onpeia, ypappég n
noAUywva), Ta d1a xapakTnPIoTIKA Kal TNV id1a xwpikn avagopd. Eniong, emtpénouv
TNV opadonoinon OPOIOYEVWYV XAPAKTNPIOTIKWY O€ pia eviaia povAada pe okond Tnv

anoBrikeuon Toug o€ €va apxeio.

MapakdTw 6a avaAuBouv Ta Pripata oto Aoyiopiké ArcGIS Desktop 10.1 yia tnv

xprion Tou Model Builder, kai mo ouykekpipéva yia Tnv Onpioupyia Tou JovTéAou.

2.3.2 To povrélo “TRAC” (Topographic Relief Alteration Calculator)
Apxikd Bripa yia TNV KATAOKeUn evog povTéAou, onwe kar oe k&be npdBAnpa, apou

éxel nponynOei 0 kaBopiopd¢ Tou NPoPANHATOC, €ival 0 NPOOdIOPICHOG TWV YVWOTWV
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oToIxeiwv* Kal 0 TPOMNOC PETATPONAC AUTWV TwV OTOIXEIWV Ot NAnpogopia. AnAadri
onw¢ neplypd@eral oxnpatikd: a) €iocodog oTtoixeiwy, ) diaxeipion, y) avdiuon,
0) €&odoc.

2TNV OUyKekpigeévn nepintwon, n nAnpogopia nou npénel va eaxBei and Ta
gloayopeva Oedopéva yia va gival Pkt N ekTipnon Tou PaBuol  peTaoAng

avayAUpou, NPENEl va NEPIEXEl TA NAPAKATW HOPPOAOYIKA XAPAKTNPIOTIKA:

o  YPOPETPO apxIKAG KAl TEANIKAG ENIPAVEIG
e KAion apxiki¢ kal TEAIKAG enipAveiag

o [lpooavatoAlopdg apxikig kal TEANIKAG enpAvelag

MapdAAnAa, Ta oToixeia 1 aANiG Ta dedopéva nou elocdyovTal kai givar IKavd va pag

NapExouv auTnv TNV NnAnpogopia PeTd and ene&epyaoia, eival Ta €§i¢ Tpia apxeia:

e Apxik6é avAyAupo eeTaldpevng NePIOXNG
o Telik6é avayAugo e€etaldpevng nepioxng (dlapopPwuévn em@pdveia AaToueiou)

o ‘Oplio ExperdMeuonc (Xwpog enéuPaong)

Ta napandvw gicaydpeva dedopéva eival Tng poppne shapefiles (*shp), doov apopd
TO apxik® Kkal TeAIKO avdyAupo nepiéxouv Tnv nAnpogopia uPopéTpou pe TUNO
xapakTnpioTikoU polyline (1ooUyei¢ pe 100didoTaon TouhdxioTov 20m kal 2m
avTioToIxa), evi) TO OPIO EKPMETAMEUONG NEPIEXEI TNV NANPOPOPIa TNG €KTAONG MOU

AapBdver xwpa n ekyeTdAAeUoN PE TUNO XapakTnNEIoTIKoU polygon.

Ma Tnv dnpioupyia Tou povTéAou Kal TNV eloaywyn Twv dedopévwy akohouBribnkav Ta

e€nc:
v' Geoprocessing > ModelBuilder
v Insert > Add Data or Tool...
v

EniAéyoupe Ta apxeia nou nepieypdpnkav napandvw

Map’” 6Ao nou Oev eival anapaitnTn n €l0aywyrn OUYKEKPIMEVWY APXEIWY yIa TNV
dnpioupyia povréhwv oto Model Builder, otnv napouoa nepintwon gicdyovrai yia va

enaAnBevetal n oupPBatéTnTa Twv TUNWV apxeiwv pe Ta gpyaleia yewene€gpyaoiac.

* Yav otoixeio, opideTal pia ogipd and apiBuNnTIKG, NOCOTIKG R NOIOTIKG XapaKTNPIOTIKG £vOC GuviAou,
Mn ene€epyaopévng poperig, Ta onofa otav eneggpyaoTtoly, péow piag dladikaoiag, YETATPENOVTAI OE
nAnpogopia (Koutoénouhog, 1990)
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MeTénemra agaipgdnkav xwpig va ennpedoouv TNV por Twv £pyaciwyv yia va Tebouv

WG NAPAPETPOI NMOU PNoPOoUV va nPoodIopioToUV KATA TNV EKTEAEON TOU POVTEAOU.

MNa tnv dlaxeipion kalr TNV peTaTponn Twv OedOMEVWY €yIVE gloaywyn piag oelpdc

gepyaleiwy 6nwg paiveral oTo NAPAKATW OXAPA:

e = 3 = N

Final
Surface
(Shapefile)

Create TIN (3) TIN to Raster (3)

x h
| N— — N

R_final_boun

Extract by Mask daries

( LS \ € * 2

Boundaries

Create TIN (2] TIN_bounda R_bounda
(Shapefile) @ g TIN to Raster (2) _rles
LY
P —— N %
Extract by Mask R_original_bo
. undaries

e = R e x

N~

Original
Surface
(Shapefile)

Create TIN TIN_original TIN to Raster R_original

~— —

IxnApa 2-3 Metatponn shapefile oe opioBeTnpévo raster
(anotehel pépog Tou povTéAOU)

1) Create TIN (3D Analyst)

Elevation

174,111 -188
| 160,222 - 174111
1 146,333 - 160,222
[ 132,444 - 146,333
[ 118,556 - 132,444
I 104,667 - 118,556
1 50,778 - 104,667
76,889 - 90,778
6376899

Create TIN

Eikéva 2-1 Mapddeiypa dnpioupyiag TIN and shapefile

Ané Ta shapefiles dnpioupyouvral apxeia TIN (Triangulated Irreqular Network). Ta
apxeia TIN givar yneiakd povréda eddpouc, Ta onoia pnopouv va avaluboulv kai va
napd&ouv xapakTnpioTikd UPoug, kAiong kal NpooavaToAiopoU TnG und HeAETNg

NePIOXNG.
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Na va eioaxBei oto povrého 10 gpyaleio “Create TIN” akolouBouUvral Ta napakdTw

Bripara.

210 napdbupo Tou Model Builder:

v
v

Insert > Add Data or Tool...

Toolboxes > System Toolboxes > 3D Analyst Tools > Data Management > TIN >
Create TIN > Add

Eiodyeral oto povrédo 1o epyaleio “Create TIN” kal enavahapfdvovrar TPEIG POPES Ta

napakdTw, pia gopd yia kd0e shapefile.

v
v

v

AInAS kAik oo Create TIN yia va avoi&ouv o1 I010TNTEG TOU epyaleiou.

OpiCetar 10 6vopa Tou TIN nou ©Oa OnuioupynBei (Output TIN) o€

$scratchworkspace%\TIN original vyia 710 apxiké shapefile

(avtioToixa kar yia Ta unéroina). H tonoBeoia anobrikeuong Tou TIN opideTar n
“scratch workspace”, €ro1 woTte oT10 TéAOG TnG diadikaoiac Tta TINs nou
onuioupyouvtal va diaypdgovtal, kKabwe dev xpeiddovral apou n anairoupevn
nAnpogopia éxel ueTaPePOE.

21o Input Feature Class dOnAwvoupe 10 shapefile ané to onoio Ba dnpioupynOel
10 TIN.

KpiOnke pn avaykaiog o opiopéds npofoiikod ouotripatog (Coordinate System),

yiati eniBapuveral n digpyacia xwpic vonua.

Output TIN ~ | Create TIN
=
X z Creates a triangulated
;(—:oordmte System (optonsl) == irregular network (TIN)
! | |7 dataset.
Input Feature Class (optional)
| = gl
Input Features Height Field SF Type Tag Field l + |
Ca Original Surface (Shapefile) Shape.Z Hard_Line <None> i'x ]
SO
1
R
< >
v
["] Constrained Delaunay (optional)

[ o [ cancel || mpy || <<tiderep | Tool Help

Eikéva 2-3 Enihoyég epyaleiou “Create TIN”
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210 napdBupo Tou Model Builder To epyaleio “Create TIN” ouvdgetal pe To shapefile

kal Onpioupyeital éva véo apxeio e§6dou Tunou TIN. (2x. 2-3)

To apxeio €€6dou nou dOnpioupyeital, kar 6Aa Ta undloina apxeia e§6dou nou Ba

akohouBrioouv gival eikovikd kKabwg To npaypaTtikd 6a dnpioupynBoulv oTav ekTeAeoTel

TO POVTEAO.

2) TIN to Raster (3D Analyst)

Elevation
174111188
] 160,222 - 174111
A 1 146,333 - 160,222 —
I 132444 - 146,333 . Low: 63
I 118,556 - 132,444
I 104,667 - 118,556
I 90,778 - 104,667
76,889 - 90,778
63-76,889

TIN to Raster

»

Value
High: 128

Eikéva 2-4 Mapddeiypa dnuioupyiag raster and TIN

Ané Ta TINs Onpioupyouvrtal apxeia raster, yia Tnv avanapdotacn TNG XwPEIKAG

nAnpogopiag yneionomnugva.

Ta apxefa raster avanapiotolv TNV nAnpogopia w¢ pia pATpa KeMWv og pia
ouvexdpevn nepioxn. To péyebog Twv keAiwv (cells) ennpeddel Tnv akpifela Tng
avdéAuong kal Tnv OYn Tou xdpTn Kal Npénel va eival Baciopévo otny apxikn KAIUakd
Tou. To peydAo péyeBoc keAlwv pnopel va odnyrioel oe anwAeia OedOPEVWY, eV
avTifera 10 NOAU pIkpd péyeBog Tou keEAIOU 0dnyel og peydAe anaimioeig anoBrikeuong

kal Ba “Bapuvel” To NPOypaApPa, XwPIG va €xel a10ONTd kKaAUTeEpa anoTeAéopaTa oTnV

avdAuon (Meveydkn, 2003).

Me Bdon Ta napandvw, yia Tov unoAoyiopod Twv JEIKTWY Npoodiopiopol Tou Babuou

LETABOARC avayAupou, €xel emAexfel w¢ kaTdMnAo péyeboc kehihv 70 10 x 10 m?,
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lNa va eloax0ei oto povrédo 1o epyaieio “TIN to Raster” dpola pe NPONYOUPEVWG:

210 napdbupo Tou Model Builder:

v

Insert > Add Data or Tool...

v Toolboxes > System Toolboxes > 3D Analyst Tools > Conversion > From TIN >

TIN to Raster > Add

EiodyeTar oto povrého To epyaleio “TIN to Raster” kar enavalapdvovrar TREIG POPES

Ta NapakdTw, pia gopd yia kade TIN.

v
v

v
v
v
v
v

AnAS kAik oto TIN to Raster yia va avoiéouv ol 1010TNTeG TOu epyaAeiou

Opicerar oav Input TIN 10 apxeio e€6dou and 1o epyaieio “Create TIN”

OvopartiCeTal To Raster nou Ba dnpioupynOei avrioToixa pe nponyoUueva o€

%scratchworkspace%\R original yia 1o “TIN_original” (k.0.K.).

Output Data Type: (integer)

Method: NATURAL NEIGHBORS)

Sampling Distance: CELLSIZE 10

Z Factor: 1,

Input TIN TIN to Raster
”I'IN_originaI _'_] @
Output Raster preates a raster by
rrrrr = — = interpolating its cell values
| %escratchmorkspace % R _original | from the elevation of the
Output Data Type (optional) N input TIN at the specified
[INT v sampling distance.
Method (optional) .
| NATURAL_NEIGHBORS v
Sampling Distance (optional) y
| cewLstze 10 v
Z Factor (optional) -
| 1

[ [ cmm |[ Aoy | [ <cierep | [ toaneo |

Eikéva 2-5 Enidoyég epyaieiou “TIN to Raster”

210 povTélo, dnpioupyolvTal Ta véa apxeia e€60ou TUNou raster (2x. 2-3), Ta onofa Ba

nePIEXOUV 0€ KADE TOUG KeAT TNV apIBUNTIKA TIPA TOu UYOUETPOU.
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3) Extract by Mask (Spatial Analyst)

Value
Value
High' 188 High: 175

Low: 63
Low: 63

Extract by Mask

+

with Boundaries:

Eikéva 2-6 Mapddelypa epappoyng epyaieiou “Extract by Mask”

To “Extract by Mask” €&dyel Ta keMd evdg raster nou avTioTOIXOUV O€ MEPIOXN MOU
opietal ané pia pdoka. Me autdv Tov TpéNO, oploBeToldvTal Ta raster Tou apxikoU Kal
TeENkOU avayAdgpou pe Bdon Ta 6pia Tng ekpeTdMeuonc. MNMapdAnAa, Ta raster nou
onuloupyouvTal €xouv koIvii apxn kai TEAOG og kABe Toug KeAi, dnAadn koivh xwpIkn
avagpopd.

lNa va eloax0ei oto povtéAo To epyaleio “Extract by Mask” opoia pe nponyoupévwg:
210 napdbupo Tou Model Builder:

v" Insert > Add Data or Tool...

v Toolboxes > System Toolboxes > Spatial Analyst Tools > Extraction > Extract by
Mask

Eiodyerar oto povrého 1O epyaleio “Extract by Mask” kai enavalapBdverar n

d1adikacia nou akoAouBei pia popd yia To apxikd raster kal pia yia 1o TeAIkO raster.

v' AinAé kAik oTo Extract by Mask yia va avoiouv or 1816TnTe¢ Tou epyaheiou

v' 210 “Input raster” eiodyetal To raster nou npokeITal va oploBeTnBOei, dnNAadn
oTnv napouoa nepinTwon 1o apxeio e€6dou and To epyaieio “TIN to Raster”,
nou oxeTiCeTal pe TIG eEETACOPEVES ENPAVEIEG,

v evy o1o “Input raster or feature mask data” eiodyeTtal 1o raster nou O€tel Ta
6pia yia To napandvw raster, dnAadn 1o apxeio 600U Nou €xel NPokUPel and
TO TIC NPONyoUMeVeG OIEPYAOIEC Kal OXETI(eTal PE TO OPIO TNG eKPETAAEUONG.
(Zx. 2-3, “R_boundaries”)
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v OvoparieTal TO Raster nou Oa dnuIoupynOel o3

%scratchworkspace%\R original boundaries/ oTnv Aoyikr Twv

npoavagepOevTwy yia 1o “R_original” (k.o.k.).
v OK

Input raster Extract by Mask
[R_final =~
Tnputraster o feahize mask data Extracts the cells of a

-~ raster that correspond to
|R_boundaries | EI the areas defined by a
Output raster - mask.
‘ “scratchworkspace%\R_final_boundaries \

Loc || concel [[ ey || <<tiderep | | Toolnep |

Eikéva 2-7 Emhoyég epyaheiou “Extract by Mask”

MAéov, oTo povrédo €xouv OnpioupynBei OUo apxeia eEGdou TUMOU raster
(Zx.2-3, ”R_final_boundaries”  xar  “R_original_boundaries”), 1a onoia eivai
oploBeTnpéva oUPpwva Pe Ta Opla TnG ekPeTdAeuong, pe {00 apiBuo keAiwy, PE TO
KAOe KkeAl oe kd&Oe raster va €xel TNV NAnpo@opia Tou UYPOPETPOU Yia TO APXIKO Kal

TeAIkG avdyAugo.

Epooov éxel ohokAnpwBei n diaxeipion Twv apxeiwv €10600u, akoloubel n avdiuon
TOUG £TOI (OTE VA OUYKEVTPWOOUV 01 anaiTOUPEVEG YEWYPAPIKEG MANPOPOPIEG.
MapakdTw NeEPIYPAPOVTAl OUYKEKPIYEVA TA €pyaAeia mou xpnolyonoindnkav yia tnv

avdAuon Twv OEDOOPEVWV.
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R_final_bound
aries

Raster to Point Z_points_final Spatial Join Z_Points_Join

R_original_boun

Z_points_origi
daries

Raster to Point (2) nal

Yxfpa 2-4 Anpioupyia Feature Class kar npéodoon nAnpogopiag uPopérpou
(anoTeAel pépog Tou povTéAou)

1) Raster to Point

Value
High: 175

Low:63

Raster to Point

+

Eikéva 2-8 Mapddelypa epappoync epyaleiou “Extract by Mask”

To epyaleio “Raster to Point” petatpénel To oUvoAo Twv OeDOHPEVWY EVOC APXEIOU
raster oe apxefo TUNou feature class, To onofo 6nw¢ €xer onpelwOel emTPénel TNV
opadonoinon NANpogopIwy og €va povaxa apxeio. Ta napaydueva onpeia (points)

TonoBeToUvTal 0TA KEVTPA TWV KEAIWV NOU EKMPOCWMNOUV.
Enopévwg, eloaywyn Tou epyaleiou “Raster to Point” oto povréAo:
210 napdbupo Tou Model Builder:

v" Insert > Add Data or Tool...

v Toolboxes > System Toolboxes > Conversion Tools > From Raster > Raster to
Point > Add
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Apou eloaxBel oTto povrého OUo @opéc To epyaleio “Raster to Point” (yia Ta
oploBeTnpéva raster apxikoU kar TehikoU avayAdgpou) enavalapfdverar n o €&ng

oladikaoia:

v" AinAé kAik oTo Raster to Point yia va avoi&ouv o1 1I016TNTEG TOU £pyaAeiou

v Input raster: R original boundaries yia TO Npwro epyaieio kal

R final boundaires yia 1o delTepo.

v" Field: VALUE

v Output point features:

%scratchworkspace%\Z points original yia To NpWTO €pyaAeio

Kal  %scratchworkspace%\Z points final avrioToixa yia To

OeUTEPO.
v OK

Katd autév Tov Tpodno eiodyovral oTo poviédo dUo apxeia eE6dou Tunou feature class
pje onpeia avd 10m otnv efgtaldpevn nepioxn (2x.2-4, “Z_points_original” kai

“Z_points_final”).

Input raster .| Raster to Point
|R_ﬁna|_boundaries | @
Field (optional) Converts a raster dataset
[WUEi vl to point features.
Output point features
f Yoscratchworkspace %\Z_points_final ‘\ @

[ ok || cencel || mpply || <<HdeHep | | Toolhep |

Eikéva 2-9 Enidoyég epyaieiou “Raster to Point”
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2) Spatial Join

Spatial Join

Eikéva 2-10 Mapddeiypa epappoyng epyaieiou “Spatial Join”

Ta kdBe apxeio feature class, a&i¢el va onpeiwBel nw¢ anapti¢etar and évav nivaka
nANpo@opIwyY, pe k&GOe onpeio (point) va éxel EexwploT TaUTOTNTA OTO €NiMEDO MOU
npoPdMerar (ObjectlD) kar kdnoia/eg 1816TNTA/EC Nou o€ aAuTAV TNV NepiNTwon

nePIEXel TNV aplBuNTIKA TIUN TOU UPOPETPOU.

To epyaieio “Spatial Join” npaypatonolei xwpikn oUvdeon/oUleuén peTa&l Twv
nivékwyv ol onofol nepihapBdvouv Ti¢ 1016TNTEC OUO xwPIKA aMnAenikaAuntépevwy
ennédwv. O1 1016TNTEG avTioToixiCovral n pia otnv dAMn Bdon Tou xwpikou ennédou
avagopdc. Apa, Mde Pdon Ta napandvw, w¢ Xxwplkd eninedo  avagopdq
XPNOIYOMOIEITAI N 0PI0OETNUEVN NEPIOXN KAl AVTIOTOIXICOVTAl OI APIOPNTIKEG TIMEG TOU
upopETpou, napéxovrag pia Bdon OedOPEVWV PE CUYKEVTPWHEVN TNV NAnpogopia yia

TO UYPSHPETPO TOOO TOU apxikoU 600 Kal Tou TEAIkoU avayAdpou.
Eioaywyn Tou gepyaleiou “Spatial Join” oT1o povTélo:
210 napdbupo Tou Model Builder:

v" |Insert > Add Data or Tool...

v Toolboxes > System Toolboxes > Analysis Tools > Overlay > Spatial Join > Add
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Eiodyeral oto povrélo To epyaleio “Spatial Join” kar akohouBouvta Ta napakdTw:

v AinAé kAik oTo Spatial Join yia va avoi§ouv o1 1016TNTEG Tou epyaieiou

v' Target Features: 2 points original

v' Join Features: Z points final

v' Output Feature Class: $scratchworkspace%\Z Points Join

v' Join Operation: JOIN ONE TO ONE

Target Features A Field Map of Join A
[7_points_original =] Features (optional)
Join Features Control ek stk
e ontrols which attribute
|Z_points_final = fields will be in the output
OutputFeature Class feature class. The initial list
| %scratchworkspace%\Z_Points_Join | @ contains all the fields from
: 7 SR ' both the target features and
Join Operation (optional) P :
F 1IN e 0GR vl the join features. Fields
‘ St ‘ can be added, deleted,
Keep All Target Features (optional) renamed, or have their
properties changed. The
Field Map of Join Features (optional) o selected fields from the
E-GRID_CODE (Long) I+ target features are
i - %scratchworkspace%\R _points_arxiko.GRID_CODE (Long) e transferred as is, but
= GRID_CODE_1 (Long) \;‘ selected fields from the join
- Yscratchworkspace%\R _points_teliko.GRID_CODE (Long) L features can be aggregated

= by a valid merge rule. The
| f! V| default value is an empty WV
- strina. in which case. all

[ ok |[ cancel |[ ooy || <chiderep | [ ToolHel

Eikéva 2-11 Enihoyég epyaleiou “Raster to Point”

To apxeio €&6dou and Tnv Odigpyaoia Tou egpyaleiou  Spatial Join  (Xx.2-4,
“Z_points_join”) énwg éxel onpelwdel, NEPIEXEI OUYKEVTPWHEVN TNV NANPOPopia Tou
UPopETPOU, PE TNV onoia eival EPIKTOC 0 UNOAOYIOPOG Tou OelkTN HopPoAoyiag kal Tou

OUVTEAEOTN UYPOUETPOU.

Avdloyo okenTikd akoAouBeiTal yia TNV ouykévTpwon TnG nAnpogopiag éoov agopd
TOV NpooavatoAiopd kai TNV kAfon Tou apxikoU kal TeAikod avayAdgou, €10l WoTe va
givar duvatdég o unoloylopd Twv OeIKTWV MNpooavatoAlopyoU kal kAiong. OnoTe

avTioToIxa yia Tov npooavatoAiopd kal Tnv kAion eiodyovTal Ta €§1¢ epyaleia:
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R_final_bound
aries

R_original_boun
daries

Aspect_final

Aspect_origin
al

Raster to Point (6)

Raster to Point (5)

A

- S,

A

e

As_Points_fin
al

L
A

As_Points_ori
ginal

As_Points_Joi
n

Spatial Join (3)

IxApa 2-5 Anpioupyia Feature Class

kal npéodoon NAnpo@opiag NPooavaToAicpoU

(anoTeAel pépog Tou povTéAou)

R_final_bound
aries

R_original_boun
daries

Slope_final

Slope_original

( LN
A

Raster to Point (4)

|

( ~
A

Raster to Point (3)

~—

x
A

S Points_final Spatial Join (2) S Points_Join

S_Points_origi
nal

Ixripa 2-6 Anpioupyia Feature Class kai npéodoon nAnpogopiag kAiong
(anotehel pépog Tou povTéou)

1) Aspect (Spatial Analyst)

Value
High: 175

Low:63

Value

[ -1 - -0,000001

1 -0,000000999 - 22,5
[ 22,50000001 - 67,5

[]67,50000001 - 12,5
[ 112,5000001 - 157,5
[ 157,5000001 - 202,5
I 202,5000001 - 247,5
[ 247,5000001 - 292,5
[ 292,5000001 - 337,5
1l 337,5000001 - 360

Eikéva 2-12 Mapddelypa epappoync epyaheiou “Aspect”

To epyaleio “Aspect” dnuioupyel TNV nAnpogopia OXeTIKG PE TOV a1s 0 a5
npooavatoAiopd Twv keAIWv Tou raster. O1 TIHEG nou divovral og KEOe
270 90
KeA, avrminpoownedouv Tnv kaTtevBuvon Tng nuéidag nou €xel n
225 135

eNIPAVEIO OTNV OUYKEKPIPEVN B€on. XTIC eninedeq NEPIOXEG diveTal n

TIpn -1.
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MNa Tnv eloaywyn Tou gpyaleiou “Aspect” oTo povTéAo:

210 napdbupo Tou Model Builder:

v" Insert > Add Data or Tool...

v Toolboxes > System Toolboxes > Spatial Analyst Tools > Surface > Aspect > Add

Eiodyetal oto povrého OUo @opéc To epyaleio “Aspect” kal akohouBoulvta Ta

NapakAaTw:

v AinAé kAik oTo Aspect yia va avoi&ouv ol 1I016TNTEC Tou epyaAeiou

v Input raster:

R original boundaries/ 070

R final boundaries oTo Mo

v' Output  raster:

éva  epyaleio

%scratchworkspace%\Aspect original

Input raster

|R_original_boundaries
Output raster

[ ‘;/u;&é{&av;orkspace%\Asped_original

Eikéva 2-13 Enihoyéq epyaleiou “Aspect”

Aspect

Derives aspect from a
raster surface. The aspect
identifies the downslope
direction of the maximum
rate of change in value from
each cell to its neighbors.

Aspect can be thought of
as the slope direction. The
values of the output raster
will be the compass
direction of the aspect.

Kdl

Kal

$scratchworkspace%\Aspect final avrioToixa pe 1o Input Raster

‘Etol, ouykevtpwbnke n nAnpogopia oe oxéon PE TOV NPOOCAVATOMOMO  Twv

eCeTaldpevwy enipavelwyv. AvrioToixa pe Tnv napandvw pebodoloyia (Raster to Point -

> Spatial Join), and Ta raster Aspect_original kar Aspect_final dnpioupyeitar éva apxeio

ecodou feature class, To As_Points_join (Zx. 2-5), nou €xel ouykevipwuévn OAa Ta

anairoUpeva dedopéva yia Tov unoAoyiopd Tou OeikTn NPooavaToMopod.
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2) Slope (Spatial Analyst)

Value
[0 - 3.450605744
[ 3,450605745 - 10,35181723
10,35181724 - 17,99244424
[ 17,99244425 - 25,3865994
- [[]25,38659941 - 32,04133905
9 ‘ [ 32,04133906 - 38,20313502
[ 38,20313503 - 46,00023387
[ 46,09023388 - 54,71674823
| 5471674824 - 62,85031891

Value
High: 175

Low: 63

Eikéva 2-14 Mapddeiypa epappoyng epyaieiou “Slope”

‘Ooov apopd TNV NAnpopopia OXeTIKA Pe TOV npooavatoAiopd n enefgpyaoia yiveral
ME To epyaleio “Slope”. Xuykekpipéva, unoloyicetal yia kA0e keAi n petaBoAn TG TIUAG
UPONETPOU TOU, OUVAPTACE! TWV TIHWY TWV YEITOVIKWY keMv (Burrogh and McDonell,
1998). Katrd autdv Tov Tpdno, Oivovrar apiOunTikéG TINEG ot KABe KkeAi Tou
napayopevou apxeiou pe TNV nAnpogopia tng kAiong oe poipes (0° [eninedo] - 90°

[kaTakOopuPpO]).
MNa tnv elcaywyn Tou epyaieiou “Slope” oTo povTélo:
1o napdbupo tou Model Builder:

v Insert > Add Data or Tool...
v Toolboxes > System Toolboxes > Spatial Analyst Tools > Surface > Slope > Add

Eiodyetalr oto povrého dUO popéc TO epyaleio “Slope” kar akoAouBouvra Ta

NapaKAaTw:

v' AinAé kAik oTo Aspect yia va avoi&ouv ol 1I016TNTEC TOU epyaAeiou

v Input rasterr R original boundaries oTo éva epyaleio  Kal

R final boundaries oo dMo

v' Output  raster: $scratchworkspace%\Slope original] KQl

$scratchworkspace%\Slope final avrioToixa pe To Input Raster
v" Outpout measurement: DEGREE
v’ Zfactor: 1
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Input raster . Slope
IR_originaI_boundaries LI

Outptcasler Identifies the slope
e = — (gradient, or rate of

{ Yoscratchworkspace % \Slope_original \ EI maximum change in z-
Output measurement (optional) value) from each cell of a
| DEGREE v/ raster surface.
Z factor (optional) .

\ 1]

[ ok || concdl [ mmy || <criderep | | Tooleh

Eikéva 2-15 Enihoyég epyaleiou "Slope”

ZUYKEVTPWVOVTAG KAl TIG TIMEG TNG KAIONG yia To apxikd kal TeAIkG avdyAugo,
onuioupyeital pe pebodoloyia nou avaliBnke napandvw (Raster to Point -> Spatial
Join) éva napaydpevo apxeio feaure class, To S_Points_Join (Zx. 2-6), TO onoio
OUYKEVTPWVEI TNV nAnpogopia TnG kAiong, nou anaiteitar yia Tov unoAoyiopd Tou

OeikTn KAiong.

2TNV OUVéxela Tou HovTéhou, Onwg paivetal kal NAPAkdTw oTo 2X. 2-7, JEOW TOU
epyaheiou Spatial Join, and Ta apxeia Z_Points_Join, S_Points_Join kar As_Points_Join,
e&dyeral To apxeio Z_S_As_Points_Join, nou eival To TeMiké apxeio feature class pe 6An
TNV anairoUpevn NAnpogopia ouykevipwpévn (UPOUETPO, KAIon kal npooavaToAiopd

apxikou kal TeAikoU avayAupou).

=
\

Spatial Join (4)

Z_S_Points_J
oin

L

IxApa 2-7 Anpioupyia TeAikoU Feature Class: Z_S_As_Points_Join
(AnoTehel pépog Tou povTéou)
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TéNog, npoodidovral oto TeAikd feature class o1 ouvTeTaypéves XY, yia Tnv eukoAdTEPN

avayvwpion i e§aywyn nANPoQopIwV and CUYKEKPIPEVO ONEID.

(3,6)
] ]
> (5.2)
] ]

INPUT OuUTPUT

OBJECTID OBJECTID | POINT_X | POINT_Y
1 1 3 6
2 2 5 2

Eikéva 2-16 Aneikévion Aeiroupyiag epyaieiou "Add XY Coordinates" (ESRI, 2014)

To epyaleio dotra.py anotehei éva apxeio script nou dnpioupynBnke yia Tnv
dleknepaiwon TnG napovoag epyaociag (N avantuén Tou NepypA@PeTal OTO ENOPEVO
kepdAaio). Eiodyeral oto povrého apou npwrta éxel eloaxbei oto Catalog Tou ArcGIS
Ka1 NPoodiopIioTouV oI I010TNTEG Tou. ‘OTav npoodiopioTouv ol 1I010TNTEC Tou (Eikdva 2-
17) To Model Builder avrihapfdveral To ouykekpIPévo script oav epyaleio mou otnv

NPOKeIYEVN NeEpiNTwon éxel pia eloodo kal pia €60do.

Gereral | Soucs | P Valdation | Help | | General | Source | P | Valdation | Help |
Display Name Data Type Display Name Data Type
@ InputFC Feature Class put FC Feature Class
Output Table Table [ 4] @ OutputTable | Table T
E3
< > <
Click any parameter above to see its properties below. Click any parameter above to see its properties below.
Parameter Properties Parameter Properties
Property Value o Property Value
Type Required Type Required
Direction Input Direction Qutput
Multivalue No MultiValue No
Default Default
Environment Environment
Filter None Filter None
Nhtzinad fam bl Nhtzinad &am
To add a new parameter, type the name into an empty row in the To add a new parameter, type the name into an empty row in the
name column, dlick in the Data Type column to choose a data type, name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties. then edit the Parameter Properties.
OK | [ Concel ||  Aoply

Eikéva 2-17 1816TnTeC apxeiou script "dotra.py”
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Eicodog Tou “dotra.py” opiCetar To TeAikS feature class nou napdyerar and TIG PEXPI

TWPA dIEPYAOieC TOU pPOVTEAOU dnwG neplypdgpnke napandvw (Z_S_As_Points_Join).

‘E€0do¢ Tou “dotra.py” Oev opileTar oe ouykekpipEvo apxeio, kabw¢ n TonoBeoia
anoBrikeuong Tou Napayouevou apxeiou opileTal xelpokivnTa KaTd TNV ekTéAeon Tou
MovTéhou. H €&odog Tou “dotra.py” eival €vag nivakag nou NePIEXel TIG TIMEG TwV
OEIKTWV YIa Tov NPoodiopiopd Tou Babuol petaBoAng Tou avayAdeou, Tov {d1o Tov

aBpd petaBoAig avayAUgpou kal TNV KATNyopIonoinon auTwy TwV TIPWV.

MNa tnv oAokAripwon Tou povTéhou Kal TNV enavekTéAeon Tou avd ndoa oTiypn and
onolodnnote Aoylopikd  ArcGIS 10.1 (1 vedtepa €kdoon), npoodlopifovral ol

NApPAPETPOI TOU POVTEAOU.

Yuykekpipéva oto napdbupo Tou Model Builder: Model > Model Properties... opidovral

ol NaPAPETPOI dNw¢ napouoidlovrar otnyv eikova 2-18.

General | Parameters | Environments | Help | eration |

Parameters used by this model:

Name Data Type Type

Original Surface (Shapefile) Shapefile Required
Final Surface (Shapefile)  Shapefile Required
Boundaries (Shapefile) Shapefile Required
OutputX, Y, Z, As, S Feature Class Required
doTRA Table Required

Eikéva 2-18 Mapduerpol povrédou TRAC
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To povTého anoBnkeleTal kal pnopei va ekteheiTar nAéov og éva nio giAikd nepifdilov
npog Tov xprioTn, oav epyaleio onw¢ akpIfwg ekteholvtal kal Ta undloina epyaleia
evtog tou ArcGlS. Xtnv eikéva 2-19 napouoidderar o TPONOG nou aneikovi¢erar To
MovTéAO KaTd TO dvolypd Tou, vy oTnv gikéva 2-20 n TeAiki poper Tou povTrélou (0To
napdptnua Il éxel evowpaTwOel n TeEAIKA poppri Tou povTéhou o€ peyeOupgvn

KAfpaka).

@ Original Surface (Shapefile)
|

@ Final Surface (Shapefile)

© Boundaries (Shapefille)

|

© OutputX, Y, Z, As, S

[

© doTRA

l

Eikéva 2-19 Aneikévion napdBupou diaAdyou "TRAC"
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Eikéva 2-20 Movtého "TRAC"
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KepdAaio 3

[MpoypappaTiopdg og nepifdAlov Python

To “Zen of Python”, nou napouociddeTal NAPAKATW, OUVIOTA OPIOUEVEC BAOCIKEC apxE
’

TnG Python kai eivar ypappévo and tov Tim Peters. Ztnv npwtdtunn €kd00N Tou OTa

ayyAikd, pnopeil va Bpedel ypdgovrac oe nepiBAAAov dIEpUNVEUTN:

>>> this

The Zen of Python, by Tim Peters

Beautiful is better than ugly.

Explicit is better than implicit.

Simple is better than complex.

Complex is better than complicated.

Flat is better than nested.

Sparse is better than dense.

Readability counts.

Special cases aren't special enough to break the rules.
Although practicality beats purity.

Errors should never pass silently.

Unless explicitly silenced.

In the face of ambiguity, refuse the temptation to guess.
There should be one-- and preferably only one --obvious
way to do it.

Although that way may not Dbe obvious at first unless
you're Dutch.

Now is better than never.

Although never is often better than *right* now.

If the implementation is hard to explain, it's a bad idea.
If the implementation is easy to explain, it may be a good
idea.

Namespaces are one honking great idea -- let's do more of

those!
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3.1 HvAwooa Python

3.1.1 XapakrnpioTikd TnG Python

H Python eival pia edkoAn otnv ekpuddnon, 1oxupn yAwooa npoypappatiopoul. “Exel
anoOOTIKEG DOMEC OedOMEVWY UPNAOU eninédou kal pia anAn aAd anoteAeopatikn
NEOOCEYYION OTOV AVTIKEIYEVOOTPEPN Npoypappatiopd. H kopyn ovvragn tng Python
Kal ol duvapikoi TUnol Tng, padi pe TN Aeitoupyia TNG w¢g dleppnveudpevng (avri
peTayAwTTI(OpEVNG) yAwooag, Tnv kaBiotodv Tnv 10avikin yAwooa yia dnpioupyia
oevapiwv evioAwv kal yia Taxeia avdntuén epappoywy o NoAAOUG TOMEIG Kal OTIG

nNePIOOOTEPEC NAATPOPHEG.

Baoikn apxn 1ng Python eivar 611 o xpdvo¢ Tou npoypapuatiotd eivar noAu
ONMPAVTIKOTEPOG and Toug KUKAOUG pnxavig kal Tov analdoer and Ti¢ xapnAou

eNINEdOU AenTopEpeles nou npénel va gpovrioer otn C/C+ 1, we éva Babud, otn Java.
YUppwva pe Tov Swaroop (2008), Ta kUpia xapakTnpioTikd Tng Python eivai:
AnAn kai ebkoAn oTnv ekpGOnon

H Python eivar pia anAn kai pivigaMioTikh yAwooa. To didBaocpa evéds kahou
npoypdupatog oe Python eivar cav 10 didBacpa Twv AyyAikwy, aAAd noAd
«aQuUOTNPWV» AyYAIKWV. AuTh n opoidéTnTa TnG Python pe YPeudokwoika eival éva and
Ta M0 10XUPd onpeia TnG. ‘ETo1 enITpénel oTov XprioTn va CUYKEVTPWVETAl 0TN AUon
ToU NpofAripaTog avri otnv idia Tn yAwooa. H aouviBiota anAl oUvtaén Tng, kAvel
TNV Python eUkoAn otnv ekpdBbnon kai e€alpetikd anhd va &ekiviioer kaveig va Tnv

XPNOIYOMOIE.

«Programs should be written so that people, not just computers, can understand them»
(Knuth, 2006)

EAeGOepn kai AvoiktoU Kwdika

H Python eivar éva napddeiypa EAAAK (EAelBepo Aoyiopikd kal Aoyiopikd AvoiKToU
Kwdika). Me anAd Adyia, pnopouv va diavepnBolv avtiypaga autol Tou
Aoyiopikou, va dlaBaocTel 0 nnyaiog kwdIkAG Tou, va npayuatonoinbouv arayég o'
auTév Kal va xpnolpgonoinbouv kopudTia Tou o€ véa eAelBepa npoypdupara. To
EAAAK Baoietal otnv 10€a piag koivoTnTag nou poipdderal Tn yvwon. AuTtog eival

¢€vac and Toug Adyoug yia Toug¢ onoioug n Python eival 1600 npwrtondépa kai
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avepxOpevn. AnploupynOnke kal BEATIWVETAI OUVEXWG NG pIa KOIVOTNTA MOU TO

MOvo nou B€Aer eivar pia kaAutepn Python.
Nwooa uPnlrou eninédou

‘Otav dnuioupyouvral npoypdppata otnv Python, o xpnoTng dev xpeiddeTal noTé
va voliddeTal yia TI¢ XapgnAoU enimnédou AenTopépeleg, dNwG N diaxeipion TNG PVAPNG

NouU XPNOIPONOIEITAl and To eKAOTOTE NPOYPAPHA KAN.
®opnTti

ASGyw Tou avoIkToU TNG KWoIKa, N Python éxel uhonoinBei (dnAadn aAAdxOnke yia va
Aertoupyel) oe noAAéG nAat@oéppec. ‘OAa Ta Python npoypduparta pnopouv va
OouAéYouv oe onoladrinote and autég TIC NAATPOPHEG Xwpic va xpelddovral
kaBdhou aAMhayéc av undpxel npoooxn WOTe va anogelyetal N xprion

XAPAKTNPIOTIKWYV Nnou g§aproudvTal and kde ovoTnua.

H Python xpnoiponoieitar oe Linux, ota Windows, oto FreeBSD, oe Macintosh, oTo
Solaris, oto OS/2, otnv Amiga, oto AROS, oto AS/400, oto BeOS, oto OS/390, oTo
z/OS, oto Palm OS, oto QNX, oto VMS, oto Psion, oto Acorn RISC OS, oto VxWorks,
oe PlayStation, oto Sharp Zaurus, ota Windows CE aképa kai oe PocketPC kai

Android Smartphones.
Aigppnveudpevn

‘Eva npdypappa nou ypdeeral o pia getaydwtti(opevn yAwooa énwgn C i n C+
jeTaTpénetal and tnv nnyaia yAwooa, yia napddeiypa tn C 1 tn C++ og pia
yAwooa nou piIAdel o unoloyiotig oag (duadikdg kwdikag, dnAadn O kar 1)
XPNOIMOMNOIWVTAG éva PETAYAWTTIOTH Pe OIAPOPEG onpaieg kal enidoyég. ‘Otav TpEEE
TO NEOYPAPHA, O CUVOETNG avTiypdPel TO NPOYPAPPA OoTn PvApn kal apxi¢er va 1o

TPEXEL.

H Python, ané tnv dAAn, de xpeiddetal petayAwTTion oe dUAdIKO apxeio. AnAd
ekteAeiTal and Tov xpriotn TO nNEdypappa an' eubeia¢ and Tov nnyaio KwoIKa.
Eowtepikd, n Python peratpénel Tov nnyaio kwoika o€ pia evoIAueon PHoPen nou
ovopdetal bytecode. Ev ouvexeia, To peTappddel otn yA\wooa Tou unoloyioTr Kal
META TO Tpéxel. ‘ONo auTd, otnv npaypatikdétnta kdvel Tn xprion TnG Python noAd
nio eUkoAn apou o xprioTng Og xPelddeTal va AvVNOUXEl yia TN PETAYAWTTION TOU

NPOYPAPHATOC, TN oUvdeon PeE TIGC KATAAMNAeS BiBAI0ONKkeg, k.An. AuTd eniong KAvel
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Ta npoypdpparta TnG Python e&aipetikd opnTtd, apou eéaopaliCeTal pe TNV anhn
avtiypagpn tou npoypdupatog Python and Tov unoAoyiotri nou dnuioupynonke, o€

€vav dMo unoloyioti n opBn Aeiroupyia Tou.
AVTIKEIHEVOOTPEPNG

H Python unootnpidel T6oo TO OIADIKACIOOTPEPN Mnpoypapuatiopd (procedure-
oriented) 600 Kal TOV QVTIKEIUEVOOTPEPN NPoypappaTiopo (object-oriented). 10
d100IKOOI00TPEPN NPOYPAPMATIONO, TO NPOypaAppa dopeiTal ndvw o€ d1adIKaoieg N
OUVaPTAOEIG 01 Onoieg dev eival Tinote dAAo and enavaxpnolyonoInoiIpga KOPPATIa
and npoypdPPaTa. XTIGC AVTIKEINEVOOTPEPEIG YAWOOEG, TO npoypdppaTa dopouvral
ndvw o€ avTikelpeva Ta onoia ouvdudlouv dedopéva kal Aeitoupyikétnta. H Python
éxel €vav noAU 10xupd aAAd  noAU  anAd  TPOMO  yIa  QVTIKEINEVOOTPEPN

NPOYPAPPATIONOS, EI0IKG OTAV OUYKPIVETAI PE peydAeg YAwooeg 6nws n C+H 1o n Java.
Enektdoipn

H id1a n yA\wooa eivar enektdoign kabwg éva Baocikd oUvoro TG yYAWooag anoTeAel
TOV nupriva Tng, evd 0Aa Ta unodAoina eival apbpwpata (modules) nou enekreivouv

TNV AEITOUPYIKOTNTA TNG.
Evowpatwoipn

H Python, pnopei va evowpatwOel péoa oe npoypduparta C/C++, divovrag pe autd

TOV TPOMNO duVATOTNTEG 'scripting' yia TOUG XPNOTEG.
ExteTapéveg BiBAI0ORAKkeS

H Mpdétunn PiBAocOrikn Tng Python eivar npaypatikd tepdotia. Emtpéner Tnv
npaygaronoinon  OIGGOPwWY  NPAYMATWY  OXETIKG  HPE  KAVOVIKEG  eKPPAOEIC,
onuioupyia  TekpnNpiwong, OOKIPEG MOVAdWY, vNpdTwon, Pdoeig dedopévwy,
nepinynté¢ 1otou, CGI, FTP, email, XML, XML-RPC, HTML, apxeia WAV,
kpuntoypdgnon, ypagikég oienagég xpriotn (GUI - graphical user interfaces), Tk,
kal dAMa npdypata nou eéaptolvral and To odotnpa. ASyw TnG PIA0cOoPiag
'Batteries Included' tn¢ Python, éAa Ta napandvw eivar diabéoipa énote eival

eykataoTnuévn n Python.
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EninAeév and tnv npdtunn PBiBAoBrikn, undpxouv didpopeg dAec PBiBAIoOrKeg
uPnAAG noIdTNTag 6nw¢ n wxPython®, n Twisted®, n Python Imaging Library” kai

NOMEC AMec.

‘OlNa 1o napandvw, ouvnyopouv otnv duvatdétnta Tng Python va emitpéner tnv
TaXUTATN avAnTuén e@apuoywyv eidIkd oe oxéon e AMeG yAwooeg xapnAdTepou
emnédou (nx C, C++), evd Aéyetal 0T ouvnbwe Ta npoypdupata oe Python eivar 3-5
POPEC MIKPOTEPQ OE OXEON e Ta avrioToixa o€ Java. ‘Oco nio uPnAou enimédou pia
yAwooa npoypappatiopol eival, T600 Mo KOVId OTnv okéyn Tou avOpwnou
Bpiokeral. Auté onpaivel, OTI €ival nio eUkoAo va ypapTouv npoypdupata oe uPniou
ennédou  yAwooeg (UPnAd  eninedo agaipeong) kal ouviBws Aeiroupyouv o€
nNePIOOOTEPEG NAATPOPPEG. AUuTO SpwG yiveTal BuoiddovTag pépog TNG TaxuTNTag Twv
NPOG EKTEAEON NPOYPAPPATWY. XTIC HEPEG YOG NAPATNPEITal pia oTtadiakn oTpopri and
YAWOOEG Mou eNIKeVTpwvOVTOUOAY OTNV anddoon Twv npoypaupdtwy (efficiency),
NPoG YAWOOEC MOU  EMIKEVIPWYVOVTAl oty andédoon Tou  MPOYyPAPMATIOTA

(productivity).

XapaktnpioTikd o Kernighan éxer ypdyer: «OAol yvwpilouv nwg yia va KAVOUUE
anoo@aApdTwon o€ €va KOPPATI KwdIKa XpelalduaoTe Tnv dinAdolo euguia and étav
TOV YPAdPape. ZUVENWG av YPAPEIG 600 Mo «EEUNVO» - OUOKOAO KWOIKA PNOPEIG, NWG

Oa Tov anoopaAuaTwoEIg »

“Everyone knows that debugging is twice as hard as writing a program in the first place. So if
you're as clever as you can be when you write it, how will you ever debug it?”

(Kernighan, 1974)

5 http://www.wxpython.org
5 http://www.twistedmatrix.com/products/twisted
7 http://www.pythonware.com/products/pil/index.htm
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Mapddeiyua: To npdypappa “Hello World” og Tpeig y\wooec:

>e C++:

#include <iostream.h>
void main ()

{

cout << "Hello, world!" << endl;

2¢€ Java:

public class HelloWorld ({
public static void main (String[] args) {

System.out.println ("Hello World!");

2e Python:

print "Hello World!"

3.1.2 H iotopia Tng Python

H 1otopia Tn¢ yAwooag npoypappatiopold “Python” xpovoloyeital and ta Té€An Tng
OekaeTiag Tou 1980. Enivonbnke and tov Guido van Rossum oto CWI otnv OAavdia
oTta TéAn Tng dekaetiag Tou 1980 kar n epappoyn Tng &ekivnoe Tov Agkéuf3plo Tou
1989, w¢ andyovoc (aAG kal di1ddoxo¢ dNwe NPOKUNTEl and Tnv 10Topia) TNG YAWooag
npoypappatiopgou ABC. “Exel avagepBei, nw¢ oav yAwooa npoypappatiopgol polddel
pe TIG Perl, Ruby, Scheme kai Tcl, evw daveietal otoixeia andé Tn Modula-3. ‘OAa autd
Ta Xxpovia, NoAol NPOoypapPaTIOTEG TNV €xouv UIoBeTAoEl Kal €xouv OnpioupynOel
noMéc  BiIBMoBrikec yia aut. Télog, éxel &nepdoel naidIkéG aoBgveieg  Kal
oupnepidapBdver noAAG xapakTnpioTikd 6nw¢ autd npoBAndnkav and Ti¢ avAaykes Twv

XPNOTWV TNG.

O Guido van Rossum, o dnpioupyog TnG yAwooacg Python, ovépaoce Tn yAwooa and
Tnv eknopnn "Monty Python's Flying Circus" Tou BBC kal 6x1 ané 10 opyWVUPO YEVOG

P1d1V. MdMioTa, éxel OnAwoel nw¢ Ogv Tou apéoouv Ta Pidia 101aiTEpa AuTd, nou
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OKOTWVOUV dMa dwa yia ¢ayntdé Tuliyovta¢ To Owpa Toug yUpw TOUug Kal

ouvTpiBovrdg Ta.

Onwg avagépbnke kar nponyoupévwe, n Python undpxer and 1a T€An TNG OeKAETIAG
Tou 1980. AuTé onpaivel NwWG eKTOC ANO TNV gUNEIpia KAl TNV wpipgavon oTov Kwolka
nou eixav ano@épel 6Aa autd Ta xpovia, unfipxav kal Bdpn and To napeAdév nou Tnv
eMNOdICaV VO NPOoXwPENOEl PNPOOTA ONwG eMNITACOOUV KAl O APXEC NAVW OTIC OMOIEG
givar onpioupynpévn (Zen of Python) kar tautdxpova va kaAUnTel TIG OUYXPOVEG
avdykec. a va &negpaoTolv Ta npofAnpaTta nou unfipxav aAd kar xapakTnpioTIkd
nou Bewpndnkav pn @PINKG NPOG TOV XPAoTn KUKAOPOPNOAV VEEG EKOOOEIC PE TNV
Python 2.0 1o 2000 kar Tnv TeAeutaia Python 3 (aMiwg py3k 1 3000) To 2008. MoMdG
and Ta kaivoupyla xapaktnploTikd TnG Python 3.0 éxouv peta@epdei oTIC ekdOOEIG 2.6

kal 2.7 nou eival Npog ta niow oupPaTég.

H Python avantuooerar we avoixtd Aoyiopiké (open source) kal n OlAXeipion TNG
yiverar and tov pn kepdookonikd opyavioud Python Software Foundation. O kwdikag
dlavépetal pe Tnv ddeia Python Software Foundation License (PSFL), n onoia eivai
oupPBarn pe tnv Tevikn Adeia Anpdoiag Xpriong GNU (GNU General Public License,
N GNU GPL i anAd GPL).

A&iCel va avagepOei, nwg 1o ArcGIS 10.1 Tng ESRI nou xpnoipgonomOnke yia va

dleknepalwdei N napovoa gpyaocia, unootnpidel scripting pe Tnv Python 2.7.

3.1.3 Xpnoeig Python

H Python oloéva kal nepioodTePO pe TNV NAP0odO Tou XPOvou dleupuUvel TO pAOHA TV

XPNOTWV TNG:
Mepikol and Toug xproTeG TNG €ival oI NAPAKATW:

ArcGlIS, Google, NASA, YouTube, Yahoo!, original BitTorrent client, Maya, Blender,
peydha naveniotipia (6nwg MIT, Stanford), 6Aeg o1 diavopég Linux kar nAé¢ov Mac OS

X, k.Q.

To kUpio nAeovékTnua TnG Python eivar 611 0 NPOypPaApPATIOTAG ENIKEVTPWVETAI OE AUTO
nou Oéher va ypdyger kal Oxi oTic 10101TEPOTNTEG TNG yAwooag. Or  €uneipol
NPOYPAMPMATIOTEG eival og B€on va pdBouv kal va goikelwBouv noAd ypriyopa tnv

Python kai va eival dueoa napaywyikoi.
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F\wooeg MpoypappaTiopou
AnpoTiKOTNTO 0TO community Tou codeeval
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Ixrpa 3-1 Thwooeg MNpoypappatiopoy - AnpoTikdTNTa 0Toug XproTeg Tou codeeval (YvwoTh KoiveTnTa
and Kopupaioug NPOYPAPMATIOTEG Nou e&aokoUvtal kal avraywvifovial o€ npokAfoeglg avanTugng
kwdIka) [www.codeeval.com]

3.1.4 XupnAnpwpaTtikd otoixeia yia Tnv Python

3.1.4.1 Python: ‘OAa givar avTikeipeva

H Python eival évrova avTIKEIUEVOOTPEPNG PE TNV €vvoia OTI oTIdnnoTe eival €va
avTikeipevo oupnepihapBdvovrac apiBpolg, oupPoAooelpég akOua Kal OUVAPTAOEIG,
yevvntopes (generators), eaip€oeic kAn. XapakrtnpioTikd o Swaroop C H (2008)
avapépel: «Na Oupdote, n Python avridapfdveral oTidrinote xpnoipyonoleital o éva
NPOYPAPMO WG €Va AVTIKEINEVO, PE pIa Yevikh €vvola TNG AéEnc. Avri va nodpe 1o

KATI”, A€PE “'TO QVTIKEIUEVO' ».

‘Etol, npoo@éperal €vag dIaioONTIKOG TPOMOG ouyyPaAPNG TwV MPOYPANPATWY HE
OUVENEIQ OTNV QVTIKEINEVOOTPEPEIQ, NapoAo nou unootnpidovral kar dAor Tpénol

npoypappaTiopoy (6nws ouvaptnolakog, d1adIkaoTIKOG K.a.). (TasPython, 2008)
3.1.4.2 Python kai oToixion (indentation)

‘Eva Baoikd xapaktnpioTikd TnG Python, nou anoteAel &vo oTtoixeio yia noAoug
NPOYPAMMATIOTEG NOU NPOoEPxovTal and AMeG YAWooEG, ival n onpacia TG oToixiong
- TnG €00xn¢ Tou kWodIka (indentation). Xtnv Python kd&Be Tpripa kwdika kabopideTal
and Tnv oToixion Tou, yeyovos nou avaPabuidel Tnv avayvwoipgdtnta Tou kwodika. O

KEVOC XaPAKTAPAG OTNV apxn TNG YPAPUNG ival onpavTikoG. AuTd anokaAeitar eooxn
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KWOIka. O1 apxikoi kevol xapakTripeg (kevd kal oTnAoBETEG) oTnv apxn TNG AoyIKAG
YPAMPNG kaBopiCouv To eninedo €00XNG TNG AOYIKAG YPAUMAG, Kal auTd pe TN ogipd

TOU NPOOOIOPICEl TNV OpadONOINON TWV EVTOAWV.

Auté onpaivel 0TI o1 evTOAéG nou ndve padi npénel kal oPeilouv va €xouv To (010
eninedo eooxng. KdaBe Tétoia opdda evioAwy, kaAeital turnpa (block) evw or AddBog

€00XEC MNopel va npokaAéoouv opAApaTa.

Katd autd Ttov Tpéno, oI NPOYyPAPMATIOTEG NPENEl VA TNPOUV TOUG KAVOVEG «KAANG
OuUpPnEPIPOPAC»  Onw¢  autoi  emPBdAovrar  and  TIC  undloineG  YAWOOEG
NPOYPAMMATIONOU, AAAG KAl VO EVOWHPATWYOUV OTOV TPOMNO NOU YPAPOUV TOUG KWOIKEG
TOUG, pia ouvéneia otov kaBopiopd TnG oToIXIONG Toug. a TNV Mo anoteAeopaTiki
ouyypapn kwolka, éxouv ypa@tel Ta éyypaga PEP (Python Enhancement Proposal),
nou napexouv nAnpo@opieg otTnv koivétnta Tng Python kal npoTeivouv €vav enionpo
TPONO OUYYPAPAC kWdIKa. Ta PEP 8% kal PEP 257° katanmidvovtal Pe Ta OUYKEKPIPEVA

O¢pata otoixiong.

3.1.4.3 Python kar opdApaTa katdTpunong (segmentation faults)

Ye avriBeon pe kdnoie¢ yAWOOEG NPOYPAPMATIONOU, O MPOYPAMMATIOTAG Ogv
xpelddetal va avnouxei yia Ta segmentation faults. O digpunveuti¢ (interpreter) Tng
Python, pag¢ evnuepwvel pe pia eéaipeon nou «netder» (throw), €ror wote va
evronieTal o€ nola ypappn undpxel To NPOPANPa WoTe va anacPalpatwverar kal va

avTipgeTwnideranl.

3.1.4.4 Python ka1 diaxeipion pvipng

‘Onw¢ avapepOnke nponyoupévwg, pia and Ti¢ Baoikég apxég Tng Python eival nwe o
NPOYPAMMATIOTAG NPénel va anaAdooeral and xapnAoU eninédou AeNTOUEPEIEG yIA VA
givar nio dnpioupyikdG kal napaywyikog. Me Tnv autépaTtn diaxeipion pvApng , o
NEOYPAMMATIOTEIG Oev XPeIAdeTal va avnouxel yia To note 6a eAeuBepwoel TNV pvipn
nou deopelel éTav PTIGxXvel avTikeipeva. Eninpdobera, n Python avridapBdverar néte
TO D10 avTikelpyevo avageépetal ndvw and pia gopd, kal €Tol dgv To anodnkedel oTn
MVAPN av dev xpeiddeTal. H Texvikn auti ovopddetar pérpnon avapopwy (reference

counting).

& http://legacy.python.org/dev/peps/pep-0008/
° http://legacy.python.org/dev/peps/pep-0257/
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3.1.4.5 Tunoi kai TIPEG

Tipn eivar pia akohouBia and bit n onoia eppnvederal oUppwva pe kanoiov TUNO
oedopévwy. Eivar duvatdv n idia akolouBia and bits va éxel dlapopeTikn gpunveia

avdAloya pe Tov TUno dedopévwy Bdon Tou onofou epunvedeTal.
Tunog dedopévwy gival €va oUVOAO TINWYV Kal Ol AeIToupyiec Ndvw O€ AUTEG.

Ztnv Python dev dnAwvoupe pntd TI TUNoG dedopévwy xpnaolponoleital. ‘Onwg Ba
Aéyape oe €vav dvBpwno évav apilBud yia napddeiypa, kar 0a kataAdBaive Ti
evvooUg, €101 yiveTal kal oTnv Python. Autrl n 1016TNTa ovopddeTal SuUVapIKOS TUNOG
(dynamic typing). ‘ETol yia napddeiypa, av kAvoupe NPA&eIg e apiBunTikoug TUNouUg,
n Python opidel autépaTa Tnv anairodpevn akpifeia woTte va yivouv owoTtd ol NPJdéerc.

AUTO KAVEI TOV KWOIKA PIKPOTEPO KAl MO EVEAIKTO.

3.1.4.6 KAdosIg kal avTikelpeva

O avrikelpevooTpapni¢ npoypappatiopos (Object-Oriented Programming - OOP)
anoTeAel pia NPOyPAPMPATIOTIKA TEXVIKA O6nou o npoypapparniotig Paoci¢etal ota
avTIKElPJeEVA Kal oTIC aMnAeNIdOpdoelc JeTaEU TOUG WOoTE va oxedidoel TO NPOypaApua
nou BéAel va avanTtué&el. ‘ETol, 0TOV QVTIKEINEVOOTPAPHA NPOYPAPPATIONS, HNOPOUE Va
OoUpE éva NPOYPAPMPA ENKEVTPWVOVTAG OTNV ONTIKA PIAG OUAOYAG QVTIKEINEVWY Kl
TwV aMnAenidpdoewv peTta&l Touq. KaOe avtikeipevo pnopel va alMnAenidpdoer e Ta
undéhoina otéAvovrag pnvipata i AapBdvovrtag, enegpyaldpevo dedopéva Kal YEVIKA
oav pia aveédptntn ovréTnTa Nou Spwe Bpioketal oe éva nepidAlov aAnAenidpaong
Kal ouvepyaoiag pe TIG undloineg nou anaptidouv 1o npdypappa. Fa autd Tov Adyo
Kal oI péBodol (N OUVAPTNOEIG) MOU XPNOIYONOIOUVTAl OTA AVTIKEIPEVA, gival oTevd
ouvOedePEVEG pE Ta (010 Ta avTikeipeva. OuolaoTikG npokeiral yia éva Tpono
NPOYPAMMPATIONOU Nou ouVOUAGlel OEdOPEVA KAl AEITOUPYIKOTNTA KAl TA EVOWMHATWVEI
o€ KATI nou ovopddeTtar avrikeipevo. KAAOEeIG kal avTikeipeva eival o1 U0 KUPIEG MTUXES
TOU QVTIKEIYEVOOTPAPN Npoypaupatiopou. Mo ouykekpiyéva n kKAdon dnuioupyei éva

V€O TUNO, 6nou Ta avTikelpeva eival oTiypiétuna Tng kAdong. (TasPython, 2008)

Ta Baoikd xapakTnEIoTIKA NoU NapaTNPouUvTal KaTd Tov oxedIaopd kal TNV uhonoinon

€VOC TUNIKOU NPOYPAPPATOG HEOW AVTIKEINEVOOTPEPEIAG eival:
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e KAdon (Class): KabopiCer T1a Paoikd xapaknpioTikd  (attributes)  kai
oupnepIpopec (methods) Twv avrikeipévwy nou neprypdgovral and auTth Tn
KAGon

o Avrikeipevo (Object): Mia ouykekpipévn pop@n piag kAdong, onAadn éva and
TA QVTIKEIPEVA NOU NEPIYPAPEI N KAGON Nou TO XxapakTNPIcel.

e Jmypiotuno (Instance): H katdotaon evog avTIKEIUEVOU KATA TNV EKTEAEON TOU
NPOYPAPHATOC HEOO and TNV CUYKEKPIPEVONOINON Tou.

e M¢€Bodo¢ (Method): H oupnepipopd kal o1 SuvaTdTNTEG EVOG AVTIKEIPEVOU.

e KAnpovopikétnta (Inheritance): ‘Otav pia kAdoel anotelel e&eidikeuon piag
AANG, kal €101 €xel OAa Ta XaPAKTNPIOTIKA Nou Neplypd@pouyv Tnv kKAdon and Tnv
onoia kAnpovopel, kabw¢ kal kdnoia 101AITEPA Nou NePIYPAPOUV EIDIKA TNV

OUYKEKPIMEVN OPAOA AVTIKEIMEVWV.

Oa pnopoUoape va AVTIOTOIXNOOUMPE TIG KAAQOEIC OTIG YEVIKEG OMAdEC Mou
neplypdgouv ta avrikelpeva. O1 kAdoeig nepiéxouv nedia (fields) kal pedddoug
(methods). Ta nedia avdAloya pe TNV TIPA Toug unodeikvdouv TNV KatdoTaon Tou
avTIKEINEVOU, TO onoio givar oTiypidTuno TnG kKAdong. O1 pébodol neprypd@ouy TiG

OIAPOPETIKEG CUMNEPIPOPEG TOU AVTIKEIPEVOU.

Me anAd Adyia, pia kAdon eival €vac Tpoéno¢ kataokeung avrikelpévou. ‘Eva
avTikelpgevo eival évag Tponog¢ va xelpi{OpaocTe Mo €UKOAG XAPAKTNPIOTIKA Kal

OUMNEPIPOPEG OPAdOMNOINMEVA.
3.1.4.7 KuploAekTIKEG ZTOOEPEC

Me Tov Opo KUPIOAeKkTIKEG oTaBepéc  (literal constants) avagepdéuaote o€
NPOKAOOPIOPEVEG TIMEG MOU NAPAPEVOUV AUETAPRANTEG 0e OAN TN diIdpKela eKTEAEONG
evoG npoypdupaToq. ‘Eva napddeiypa KUpPIOAEkTIKAG oTaBepdc eival évag aplBuédg
6onwg 8 , 2.48 , 4.07e-1 A pia oupPorooeipd onwe “oauth” n
‘axkodpa kol outh . ANOKOAEITal KUPIOAEKTIKA OIOTI KUPIOAEKTEN -n TP TNG
opiCeTar kupIoAekTIKA. O apiBudg 2 avanapioTd Tov eauTtd Tou Kal Tinota dAho - ival
otaBepd OI16TI N TIun TNG Oe pnopeil va aMdéel. Apa, 6ha autd avagépovtal wg

KUPIOAEKTIKEG oTaBePEG (Swaroop, 2008).
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Ap1Bpoi

O1 apiBpoi otnv Python 2.7 eival Teoodpwyv TUnwv: o1 aképaiol (plain integers - int), ol
dekadikol (long integers - long), o1 apiBuoi kivnti¢ unodiaoTtoAn¢ (floating point -

float) kar o1 piyadikoi apiBuoi (complex numbers - complex).
YupBolooelpég (Strings)

Mia oupPBolooeipd eivar pia akoloubia and xapaktipeg. O1 XapakTAPEG N o1 AEEEIG,
Mnopel va eival oe kdBe aApdfnto kal y\wooa, apkel va unooTtnpifetar and To

npotuno Unicode, ouciaoTikd 0xedOv kG0e yYAWOOa TOU KOOHOU.
Movd gioaywyikd

MnopoUv  va opioTolv  oUpdPoAOCEIPEG  pE  pova  gloaywyikd,  yia
napddeiypa ‘Babpuodc MetaBorfc AvayAUeou’. H pyopgonoinon, mn.x.

kevol xapaktripeg (Whitespace) kar oTnAoB€tec (Tabs), napapével wg €xel.
AInAG eicaywyikd

O1 oupBolooelpéc pe OINAG elocaywyikd AeiToupyouv akpIBwe OnNwe Kkal he povd

eloaywyikd. Na napdderypya “Omt Lk PUnovon”.
TpInAd elcaywyikd

MnopoUv va opiotolv oupBolooelpeég noANamAwyY  ypappwy pe  TPINAG
gloaywyikd - (""" A """ ). Avdueoa og TPINAG glcaywyiké pnopoly va

xpnoigonoinBouv eAedBepa pova kar OINAG eloaywyikd.

3.1.4.8 MetaBAnTéq kar avayvwploTikA

K&Oe peraPBAntri (variable) eivar pia ©éon otn pvrApn tou H/Y nou anoBnkelel kai
ene&epydlerar nAnpogopiec. Me anAd Adyia, n petaBAntr eival éva évopa nou
avapéperal og pia TipA. O TIPEG Twv PeTaBAnTwV noikiMouv kal ynopouv va aré&ouv
o€ onolodrinoTte onpeio Tou Nnpoypdupatog. " autd 1o Adyo ovopdlovral petaBAnTEc.
AvTIBeTO PE TIGC KUPIOAEKTIKEG 0TABEPEC, xpelddeTal kanoia pébodog (method) yia va

kKaAeoToUv auTég oI PETABANTEG, KAl wé €k TOUTOU va Toug 0oBoUv ovouara.

O1 peraPBAntéc eival napadeiypata avayvwpioTikwy. Ta avayvwploTikd (identifiers)
givar  0oB¢évra ovépata yia va avayvwpioouv kdT. la  Tnv  ovopaTtodooia

avayvwpIOTIKWY, UNAPXOUV OPIOPEVOL KaVOveG. O KuplOTEPOG Eival NWEG O NPWTOG
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XQPOAKTAPAG TOU avayvwploTikoU npénel va eival éva ypdppa Tng aAgafritou

(kepahaio ASCII i ne¢6 ASCII i xapakTripag Unicode) A pia kdtw navha ()

O1 petaPAnTéG pnopouv va dIatnPouv TINEG OIAPOPETIKWY TUNwV Oedopévwy. Ol
Baoikol Tunol eivar apiBuoi kar oupPBoAooEIPEG, eV XPNOIPJONOIWVTAG KAAOEIG, €ival

duvaTtn n dnuioupyia VEwV TUNWY OcOOPEVWV.

3.1.4.9 Ekppdoeig Boolean

O1 ekppdoeic Boolean eival ekppdoeic nou N anoTiunon Toug eival €ite aAnBNi¢ eite
Peudng (nx 7 == 8, Weudni¢kal “this” == “this”, AAnONAc). And PIKPOTEPES
ekppdoelg Boolean pnopouv va dnpioupynBoulv peyaAUTEPEG XPNOIPONOIWVTAG TOUG
AoyIKOUG TeEAEOTEG. 2uvnOwg Opwg, eival nio emBupnTé and TIGC PeyaAUTEPEG eEKPPAOEIG
va dnuioupyouvTal PIKPOTEPEG WOTE va yiveral nio anAd autd nou neprypdgeral. Ol

Baaoikoi TEAEOTEG yia ekppdoeic Boolean eivar: didleuén (o r), ouleuén (and), dpvnon

(not).
3.1.4.10 Baoikol TeAeoTEC

O1 nepIooOTEPEG €VTOAEG MOou ypdgovTal NePIEXOUV ekPpAoel (expressions). Mia
€kppaon pnopei va diaxwploTel oe TeAeoTEG (operators) kal TeAeoTéoug (operands). Ol
TEAEOTEG eniTeAOUV pia AeiToupyia kal pnopouv va avanapaotadoulv pe oUpBola onwe
To\ + \ N pe €1dIKEC AEEeIG - KAeIDIA. O1 TeAeoTéC anaitodv kdnola dedopéva ndvw oTa
onoia Ba Aeitoupyrioouv kal autd Ta dedopgva ovopdlovTtal TeAeoTéol. XTn Python yia
TNV ekTéAeon Twv PBacikwyv apiOunTikwy Npdéewy xpnaolgonolodvral ol NG kUpIol

TEAEOTEC:

e + MNpbdobeon

- Agaipeon

* MoAanAaciaop6g

/ Aiaipeon

**Ygwon og dYvaun

% Ynéhoino (modulo)

// Aiaipeon oTpoyyulonoinpévn npog ta kdtw (Floor Division)
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MNapakdTw akohouBouv ol TEAEoTEG oUykpIong, 01 onoiol ekTOG and TNV AeIToupyia Toug
oTnv ouykpion apiOunTikwy Oedouévwy, €gival duvati n avrioToixion o autoug

EIOIKWYV AEITOUPYIWV KAl VIO AVTIKEMEVA OIKWV HAG KAAOEWV.

e =="loo pe

! = Aidpopo and

> MeyaAdtepo and

< Mikpdtepo and

>= MeyaAUTepo 1 ioo pe

<= MikpdTeEPO 1 (00 pE

KdBe Tteheoti¢ Oéxetar OUO TeAeoTéoug, €vav oe kAOe nAeupd Tou TeAeoTn. ‘Otav
xpnoigonololvral nepioodTepol and €vag TeheoTéc oe pia €kppaon, n Python
BaoieTal og pia npokabopiopévn npotepaidétnta'® yia va kabopicel TN ogIpd pe TNV
onofa anoTIHWVTal Ol TEAEOTEG. Xe MOMEC NeEPINTWOEIG, AUTA N NPOTEPAIOTNTA
kabopiCer Tnv TEAIKA TIUR TnG €kppaong. Tia va yivovrar o1 ekPpPAoEIG NIo
euavdyvwoTeg, alMd va aAAddel n ogipd unoloyiopou énou autd eivar emBupnTo eival
duvati n xprion napevbéoewv. TéAog, o1 TeAeoTéG ouvriBwe ouoxetiCovral and
Ta aploTEPd  NpPog Ta  Oe€ld OnAadn o1 TeAeoTéC pe Tnv  idla  npotepaidTnTa
unohoyiovrar  andé 1o  aplotepd  npo¢  Ta  Og&id. Na  napddeiyua,
T02 + 3 + 4 unoloyiCetTal w¢ (2 + 3) + 4. Mepikol TEAEOTEC OpWE, dnNwe ol
TEANEOTEC avdBeong éxouv ouoxétion and 1a Oggid npog¢ Ta AploTePd ONA. TO

a = b = cavngegtwnieTaiwga = (b = c).

3.1.4.11Tpoypappa kar EAeyxog pong

MNpoypappa eivar pia akohoubia evroAdwv npog évav unohoyloT nou Npooodlopidel pia
Aerroupyia (1 éva odvolo Aeitoupyiwv). To NPOypappa €xel pia ekteAéoign popen nou
Mnopei va xpnoigonoinoel aneubeiag o unohoyioti¢. Ta Bacikd xapakTNEIOTIKA eVOg

npoypdupaTog eival:

e Eicodog: Ta dedopéva and 1o nepifdrov ta onoia xpelddetal To NPOYPAPHa

yla va napdyel Tnv enbupnti €6000.

19 (5.15.) Operator precedence: https://docs.python.org/2/reference/expressions.html#operator-
precedence
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e Tpono¢ EkréAeong: O Tpdno¢ pe Tov onoio yiverar n enegegpyaoia Twv

dedopevwy (pon ekTéheonc, ahyopiOuol, povréAa unoloyiopou)

e ’'E&odo¢: Ta TeMkd anoteAéoparta.

O éheyxoq poni¢ agopd Tnv Oeglpd PE TNV onoia ave&dpTnTeG ONAWOEIG, €VTOAEG
KANO€IG ouvaptioewy ekTehoUvral 1 anoTigwvTal. XTnv  akoAouBiakn  exTéAeonN,
ouvnlwg o deikTNG evioAwv au&dveral autéuata PETd TNV NPOOKOPION MIAG EVIOANG
npoypdppaTog, kKabwe ouviBwg o1 evioAég oe €va npdypappa  ekTeAoUvTal
akohouBiakd and tnv pvrAun. ‘Etol, éva npdypappa nou kdvel akoAouBiakn ekTéAeon

evioAdwv (sequential), ektehel kGOe popd TNV eNdPEVN EVTOAN OTNV PvARN.

‘Eva andé ta Baoikd oToixeia onolaodnnote yAwooag npoypappaTiopou eival o Tpénog
pe Tov onoio diveral o’ éva npdypappa n duvatétnta va AapBdvel anopdoeic. ‘Etol,
TO NPOYPAPHMA PNOPET va «NPooappoleTal» oTIG OUVONKeG Tou nepIBAAAOVTOG Tou Kal
va akOAOUOEl dIaPOpPETIKA nopeia avdloya pe 1o TI Tou ¢nTeiTal. YNApxouv  €10IKEG
EVTOAEG Onw¢ dlakhadwoelc und ouvOrikn, dApaTa kal UNOPOUTIVEG Nou dIAKONTOUV
TNV (PUOIOAOYIKA pon ToNnoBeTWVTAG pia kalvoupyia TIUA oTov PeTPpNTA NPOYPAPUATOC

(program counter).
Ta €idn eAéyxou porig eivai:

e Juvéxela o€ dIAPOPETIKA dnAwon (statement) (unconditional branch or jump)

e ExTéAeon evog ouvolou dnAwoewv POVO av IkavonoleiTal kanola ouvonkn.

o ExkTéAeon evO¢ ouvohou evioAwv Kapia 1 NePICOOTEPEC POPEG PEXPI KAMOIa
ouvOrikn va ikavonoinoel.

o ExkTéAeon evdG ouvOAOU AMOPOKPUOPEVWY eVTOAWV OMou MPETA TNV ekTéAEoN
TOUG, 0 éAeyxo¢ pori¢ ouvnbwe enoTpéPel (ouvapTnoelg, pEBodor).

e JYrapdTnpa &vOG NPOyPAUMATOG,  AMnOTPEMOVTAG  OonoladnnoTe  NEPAITEPW

ekTéAEON.
H evroAn if

H evroAil 1 £ xpnolyonoieitar yia va eheyxOei pia ouvOrikn kai €dv (if) n ouvBrikn auti
givar aAnBng, TéTE eKkTEAeiTal €va ouUvoho (Tpripa) eviohwv (nou ovopddletal if-
block), diagpopeTikd (else) yiverar ene&epyaoia evdc dAou ouvolou evioAwv (nou
ovopddetal else-block). H xprion Tou 6pou e lse gival npoaipeTikn, KABWCS anaiTeiTal

pia ehdxioTn €ykupn evioAn if. EmumpooBeta, unmdpxel kat 0 6pogelif, o onoiog
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oTnV  NEAyuaTikOTNTA  ouvOuddel OUO  OUOXeTICOPEVEG eVIONEG 1f. .else -
if..else o€ pia evioMiif..elif..else. AuTé kdvel To npdypapua

EUKOAOTEPO KAl PEIWVEI TOV apIOPO TwV E00XWV MOU anairouvTal.
H evroAn while

H eviod while emTpénel TNV enavelAnuuévn ekTéAeon evog THAPATOG eVTOAWY, 600
MIa npoUndBeon napapéver aAnOnig. H evioAl while eivar éva napddeiypya autou
nou anokaAeital evioA Bpdxou (looping statement). Mia evioAri while pnopel va
€xel évav nNpoalpeTikd 0po else. To TpApa else ekTeAeiTal étav n npoUlnddeon Tou
Bpdxou while anoktd Tv Tipn False (Peudéc). Edv undpxer évag 6pogelse yia
éva Bpoéxo while, exteAeital ndvrote, ekTOC kI av Olakonel o PPOXo¢ PE TNV

eviold break.
O Bpodxo¢ for

H eviodd for .. in eivar dMn pia evrodd Bpdxou, n onoia enavaAlapBdverar o
Mia akohouBia avTikeipévwy, dnNAadn ekTeAeiTal oe kABe avTikeipevo o pia akohoubdia,

Y10 OUYKEKPIPEVO NANBOG popwV.
H evroAn break

H evrohl break xpnoipyonoieitar yia tn diakonn piag eviohig Ppdxou, OnA. Tn
dlakonn TNG ekTEAEONG TNG EVTOANG Bpdxou akéun ki av n npoUinéBeon Tou Bpodxou dev
éxel yivel False (Peudnc) n dev éxel enavaAn@Bei o' 6An Tnv akohoubia Twv

AVTIKEIMEVWV.
H dnAwon with

H kUpia xprion Tng dridwong with eivar yia Tnv andéktnon kar aneAeubepwon népwv.
Me Tnv with g€aopaliCeTar n katdAMnNAn déopeuon kal anodéopeuon NOPwV HPOAIG

apxiCel kal avtioToIxa TEAEIWVEI TO AVTIOTOIXO HEPOG KWOIKA.

3.1.4.12 YuvapTtioeig

Yuvdptnon eival pia ovopaddpevn akoAouBia dnAwoewy n onoia npaypaTonolel évav
OUYKEKPIPEVO unoloyiopd. AnoteAolv pia Texviki agaipeong péow TnG onofag pnopef

va 000ei évopa o€ pia oUvOeTN Asitoupyia kAl OTNV OUVEXEID VA MAPEXETAl N
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duvaTtéTnTa va avagepdpaoTe o auti Tn oUvOeTn Aeitoupyia wg povdda. Av pia

ouvdpTnon eQpappodeTal og avTIKEIPEVO, ovouddeTal H€B0dOC.

‘Opiopa eivar pia mip n onoia AapBdverar andé 10 Npdypappa otnv KAnon Tng
ouvdptnonG. Mnopel va xapaktnpioTel kal wg €i0o0do¢ TnG ouvdptnong and To

npoOypappa and To onoio KaAeiTal.

Eniotpepdpevn miyn eivar n Tiyn n onoia eniotpéperar and Tnv ouvdptnon oTo
nepifdAov nou Tnv kdAeog, péow piag dridwong return. ‘Otav ouvavtdral n dNAwon
return, TeppaTiCetal N ekTéAeon TNG oUVAPTNONG KAl N PON €KTEAEONG EMIOTPEPEI OTO

nepiBaAhov and énou KaAéoTnke.

O1 ouvaptioelg Aoindv, egivar enavaxpnoipgonomaoiya  Pépn npoypappdTwy, nou
ENITPENOUV PETA TNV OVOPATOOATNON €VOG OUVOAOU £VTOAWY, TNV EKTEAEON €KEIVOU TOU
oUVOAO €VTOAWV XPNOIPJONOIWVTAG TO OvOoud Toug, onoudnnote oTo NPOyPaPpd Kal

00€eG POPEG eival entBupunTd. AuTo eival yvwoTé oav kArion (calling) Tng ouvdpTtnong.

O1 ouvaptrioelg opidovral xpnolgonoiwvrtag Tn Aéén kAeidi def, perd tnv onoia
akoAouBel éva dvopa nou TauTonolel TNV eKAOTOTE oUVAPTNON KAl KATOMIV akOAOUOEl
éva Ceuydpl napevbEéoewy nou pnopouv va nepikAeiouv PepIkd ovopaTa PeTaBANTWY,

KAl N yPAPMA TEAEIWVEI Je avw Kal KATw TeAela (2 ).

3.1.4.13 Aopég dedOPEVWV

O1 dopég dedopevwy eival autd nou Aéel To Ovoud Toug, OnAadn eival dopéc mou
pMnopoUv va kpathnoouv padi pepikd dedopéva. Me dAa Adyia xpnoigonololvral yia
va anoBnkedouv dOedopéva NouU €xouv oxéon PeTa&U TouG. YNAPXOUV TEOOEPIG OOMPEG
dedopévwy evowpaTwpéveg otnv Python: o1 AioTeg, o1 nAeiddeg, Ta Ae§ikd kar Ta

oUvoAa.
Aiota (List)

Mia ANiota eival pia dopnn dedopévwy nou ouykpaTel pia dlaTeTaypévn ouAoyn
oToIxelwv, dNAadN pnopel va anodnkeuTel pia akohoubia (sequence) aAvTIKEIYEVWY OTN
AoTta. H AioTta Twv oToixeiwv npénel va kAeivetal oe aykUAeg (dnAadn [ kal ] ) €101 woTe
va kaTtaAafaiver n Python 611 kaBopileTal AioTa. Apou €xer dnpioupynBei pia Afota pia
Popd eivar duvatn n npooBrikn, n perakivnon n n avaditnon oToIxeiwv oe auti Tn

Aota. Ané tn oTiypyrt nou pnopoupe va NpoocBEoOUNE KAl va PETAKIVAOOUPE OTOIXEIQ,

81



Aépe 6T n AioTa eivarl évag peTaAntég Tinog dedopévwy (mutable data type), dnAadn

auTOG 0 TUNOG PNopel va alaxOel.
MAeiada (Tuple)

O1 nAe1dde¢ xpnolponoiolvTal yia va ocuykpatrioouv padi noAanAd avrikeipeva. Eival
NapPOPOIEC PE TIGC AioTeG, aMd Xxwpic TNV ekTETAPEVN AeITOUPYIKOTNTA NouU N KAdon Tng
AoTag divel. ‘Eva kUp1o xapakTnpioTike Twy NAeiddwy eivarl OTI eival apeTdANTEG ONwG
ol oupPBoAooelpég, dnAadn o1 NAeiddeg Oe pnopouv va tpononoinBouv. O NAEIAdEG
opicovral kabopiCovrac otoixeia nou dlaxwpidovral pe kKOPpaATa, PEoa o€ €va
npoalpeTikd  Ceuydpl napevOéocwyv. Xpnolpgonolwvrag Hia nAeidda, ouolaoTiKd
OnpIoupyeiTal €va avrikeiyevo To onoio eival pia opdda dAwv avTikeIpévwy. Av yia
pia Aeitoupyia pnopouv va xpnoiponoinfouv eite NAeIdOeg eiTe NlOTeg, NPOTIPWVTAL Ol

NAEIAOEC OIGTI eival O Mo ypriyopog TPONog.
Ae&iké (Dictionary)

Me 1O Aggk6 pnopouv va avrtiotoixnBouv TIPEG o AEEelc kAe1dId. Me  évav
anhouoTeupévo Tpono, 6a pnopouoe va avapepOel nwg 1o Aegikd eivarl pia yevikeuon
TwV ANIOTWY, 6nou avti va OeIKTOOOTEITAI €va AVTIKEIUEVO PE €vav akéPalo, PMNOPE( va
OEIKTOOOTNOE( pE OMOIOdNMOTE AVTIKEIPNEVO, apkel autd va eival otabepd (va pnv

aMddel TiunR) kal povadiko.
X0volo (Set)

Ta ouUvoha e€ivar  pn  Ta&vopnpéveg  ouhloyeC anAwv — avTikelyévwy.  AuTd
xpnoigonolodvrar étav n unapén evog avrikelyévou oe pia ouloyn eival nio
onoudaia andé Tnv eviohn N néoe¢ popeg autht oupPaivel. Ta olvola dieukoAdvouv
oTnv opadonoinon NOAAWY QVTIKEIHEVWY KAl OTNV €EQAPHPOYN OTNV OUVEXEIa NPA&ewy,
Onwe n évwon Toug Pe anodoTikd Spwe TPono, eEaopaiidovrag nwe kABe oToixeio, av
nepiexeral oe ndvw and éva ouvolo, Tehkd Ba Ppebei pia pévo popd oto TeNkS

anoTéAeopa.

3.1.4.14 ApBpwpuarta

‘Eva dpBpwpa (module) eivar éva apxeio nou nepiéxel dONAWOEIG kAl OPIOPOUG
(ouvapTtrioelg, kAdoeig kTA). To évopa Tou apBpwpaTog avTinpoowneUel €va APXEio
python (nou gival To évopa Tou apOpwpaTog ouvodeuduevo and Tnv katdAnén “.py”).

Ta apOpwpara eivar NoAd xpriciya yia Tov NPOYPAPMATIOTA yIaTi ENITPENOUV TNV
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ENAVAXPNOIPONOINON KOPUATIWV KWOIKA MOU MEPIEXOUV OUVAPTNOEIG, Ol OMNOIEG EXOUV
YPAPTEl OTNV apXIKA YAWooa nou éxel ypa@Tel o dlepunveuTng Tng Python. “Etor dev
xpelddeTal kdbe gopd va «avakaAdnterar o TPoxoc» and Tnv apxn. TéAog, noAloi
NEOYPAMUMATIOTEG €xouv  NON  avantuéel nakéra apdpwpdtwy HPE  OUVAPTNOEIG
(noAUnAokeg paONUATIKEG OUVAPTAOEIG, OTATIOTIKA POVTEAA KAM) nou dlaTiBevral oTnv

avoikt koivoétnta Tng Python.

2TNV _napouocd gpyacia, dvo and T1a kKUplad apBpwuaTa Nou xpnoigonolnfnkayv givai

10 €ENC
ArcPy:

To ArcPy eivar éva nak€ro AsiIToupylv nou avrikaBiotd To arcgisscripting.
Zkondé¢ Tou efval n dnpioupyia pIac oglpds eviohwv nou Ba  dwoouv
MeyaAdTepn guxpnoTia oTnv yewypagikn avdAuon, peratponn kal dlaxeipion
0edOoEéVWYV ONWE KAl OTOV AUTOMATIONO dnpioupyiag xapTwy péoa and Tn

yAwooa npoypappatiopou Python.

To ArcPy divel dueon npdéofaon oTa gpyaleia geoprocessing, 6Nw¢ kal o€
nNPOoOeTeG eVTOAEC Kal avTikeipeva Tou ArcGIS pe okond tTn dnpioupyia anAwv

aM\d kal ouvBeTwy dladikaoiwy ypriyopa kal eikoha. (ESRI 2010-13)
NumPy:

To NumPy eival To Baocikd Nakéro yia enioTnpovikoug unoAoylopous oTnv
Python. ©a pnopouoe va napopolaoTel pe pia BiBAIOONKN pe pia noAU peydAn
ouMoyn ocuvapTioewy Kal TUNWY Nou anookonouv oTnv enfAucn padnpaTikwy
npoPBAnpdTwy. AlabgTel éva Baoiké TUno dedopévwy nou eival o NoAudIAoTATOG
nivaka¢ (multi-dimensional array, ndarray) ndvw oTtov onoio eival Baciopéveg
POUTIVEG yia apiBunTiki avdAuon, ypaupikn dAyeBpa, pryadikols apiBuoug,

avdAuon Fourier kAm.

Téhog, TO oulvoho Twv apPBpwpdTwy nou €xouv xpnolpgonoindei, nepidapBdvovral

npogykataoTnNuéva Pe TIG Baoikég ekdooelg Tou ArcGlS kai Tng Python.
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3.2 To npodéypappua “dotra.py”

3.2.1 Eicaywyn

MNa Tnv dieknepaiwon auTtng TG dINAwPATIKAG gpyaciag, OnAadn yia Tnv avAantuén
piag autopaTonoinpévng peBddou yia Tov unoAoylopd Tou Babuol  petafoAng
avayAdpou, kpiBnke anapaitntn n dnpioupyia evog kwdika (script) oe nepiBdAlov
Python, yia Tnv oTaTIOTIKA enegepyacia TwV YewypPaPIKWY OedopEvwy. O KWOIKAG Nou
avanTuxbnke anoteleital and 750 ypappéc. Me anAd Adyia, anoTtelel éva véo epyaleio
NOU EVOWMATWVETAI OTO POVTENO nou avanTuxOnke péow Tou Model Builder Tou GIS
(ke@.2.3), kal ekTeAEl TIC anaiToUpeveg NPAEEIC yIa TOV NPOOdIOPIOPS TV NAPAPETPWY
peTaBoAri¢ avayAUgou kal kat’ enékraon kar Tov (010 TOV PaBud  peTaBoAng
avayAdpou. Me autd Tov TpOno, péoa and Tnv ekTéAeon piag o€ipd¢ HadBNUaTIKWY
ouvapTACEWV BIVEPYEITAI N OTATIOTIKA avAAuon TV YEWYPAPIKWY XAPAKTNPIOTIKWY
Twv eéeTaldpevwy enigpavelwy. ‘Etor hoindv, dev xpeidletal nAéov ouTe efaywyn Twv
YEWYPAPIKWY Oedopévwy oe AoyioTikd pUAMo EXCEL, oute nepetaipw ene&epyaoia,
kaBw¢ Ta anoteAéopata unohoyidovral autépaTa kal elodyovral oto nepiBdAov Tou

arcGlIS nou gpydderal o xpnoTng.

3.2.2 O kwdIKag TOU NPOYPAPNATOG

Ma Tnv kKaAUTEPN avdyvwon Tou KWOIKA ava@EPETAl NWG Ol O€IPEG Nou apxidouv e
“#"” (XpWMPATIOPEVEG PE KOKKIVO) O€ peTayAwTTidovTal kal anoteholv enegnynuaTikd

OXOAIO TOU KWOIKA.

Eicaywyn anairovysvwy apbpwudtwyv:

# -*- coding: cpl253 -*-

Sys
traceback

arcpy
arcpy env
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[MpocdIopIoPdC 1000wV — £EGOWV:

## Arguments:
# argv[l] = input table/feature class path
# argv[2]= name of final table

path = sys.argv[l]
final table=sys.argv[2]

Anyioupyia nio @iAikoU nepiBAAOVTOC NPOC ToV XPNoTN:

### 1. Create more friendly environment
## 1.1 Delete unwanted columns:
# "Join Count", "TARGET FID"

arcpy.DeleteField management (path, "Join Count")
arcpy.DeleteField management (path, "TARGET FID")

i 1.2 Add New Fields:
# "7z orig", "z fin", "S orig", "S fin", "As orig",
"As fin"

arcpy.AddField management
arcpy.AddField management
arcpy.AddField management
arcpy.AddField management
arcpy.AddField management
arcpy.AddField management

path, "Z_orig", "LONG", "9")

path, "z fin", "LONG", "9")

path, "S orig", "FLOAT", "3", "1")
path, "S fin", "FLOAT", "3", "1")
path, "As orig", "LONG", "9")
path, "As fin", "LONG", "9")

o~ o~ o~~~ —~

i 1.3 Calculate New Fields:
# "z orig", "z fin", "S orig", "S fin", "As orig",
"As fin"

arcpy.CalculateField management (path,"Z orig","!GRID CODE!","PYTHON
9.3™M)
arcpy.CalculateField management (path,"Z fin","!GRID CODE 1!","PYTHON

9.3™)
arcpy.CalculateField management (path,"S orig","!GRID CODE 12!","PYTH
ON 9.3")
arcpy.CalculateField management (path,"S fin","!GRID CODE 12 13!","PY
THON 9.3")
arcpy.CalculateField management (path,"As orig","!GRID CODE 12 13 14!
","PYTHON 9.3")
arcpy.CalculateField management (path,"As fin","!GRID CODE 12 13 14 1
5!","PYTHON 9.3")

#i# 1.4 Delete 01d Fields:

# "GRID CODE", "GRID CODE ", "GRID CODE1", \

# "GRID COD 1", "GRID COD 2", "GRID COD 3"

path, "GRID CODE")
path, "GRID CODE_1")

path, "GRID CODE 12")

path, "GRID CODE 12 13")

path, "GRID CODE 12 13 14")
path, "GRID CODE 12 13 14 15")

arcpy.DeleteField management
arcpy.DeleteField management
arcpy.DeleteField management
arcpy.DeleteField management
arcpy.DeleteField management
arcpy.DeleteField management

~ e~ o~~~ —~
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#4# 1.5 Create new table == final table:

arcpy.Statistics analysis(path, final table, "OBJECTID FIRST","#'")
arcpy.DeleteField management (final table, "FIRST OBJECTID")

Eicavwyn apBpwparoc NumPy

### Import numpy module:

import numpy as np

Ynohoviopdc Agiktn Mop@oAoyiac

### 2. Calculate Landform Index
i 2.1 Import values for z orig, z fin:

data z orig=[]
data z fin=[]

with arcpy.da.SearchCursor (path, "Z orig") as sCursor:
for row 1in sCursor:
data z orig.append(row[0])

with arcpy.da.SearchCursor (path, "Z fin") as sCursor:
for row in sCursor:
data z fin.append(row([0])

#4# 2.2 Calculate Variance:
var z orig = np.var(data z orig)
var z fin = np.var(data z fin)

#i# 2.3 Calculate Covariance:

data z orig fin = np.vstack((data z orig,data z fin))
cov_1l=np.cov(data z orig fin, bias=1, ddof=None)
cov_2=np.array(cov_1)

cov = np.amin(cov_2)
#4 2.4 Calculate Landform Index (LI):
LI = ((var_z orig + var_z fin) - (2 * cov)) / (var _z orig +

var z fin)
arcpy.AddField management (final table, "LI", "FLOAT")
rows = arcpy.UpdateCursor (final table)

for row in rows:
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row.setValue ("LI", LI)
rows.updateRow (row)
del row

del rows

Ynohoviopydc Juvieheotnc YWou€rpou

##4# 3.Calculate Altitude Index

#4 3.1 Calculate average (z orig, z fin) and difference between
them (A z average):

# (for importing z orig, z fin see #2.1)

z orig average = np.mean(data z orig)

z fin average = np.mean(data z fin)

delta z average = z orig average - z fin average

i 3.2 Calculate (z orig - z orig average)**2:

z orig z 2= (data z orig - z orig average)**2

## 3.3 Calculate (z fin - z orig average)**2 = (z orig -
delta z average - z orig average)**2:

z fin z 2= (data_z orig - delta z average - z orig average) **2

#4# 3.4 Calculate sum[(z orig - z orig average)**2], sum[(z fin

- z_orig average)**2]:

sum z orig z 2 = sum(z orig z 2)

sum z fin z 2 = sum(z fin z 2)

#i# 3.5 Calculate sqgrt{sum[(z orig - z orig average)**2]},
sqrt{sum[(z fin - z orig average) **2]}

#4# and sqrt{sum([(z fin - z orig average)**2]} /
sqrt{sum[ (z orig - z orig average)**2]} as div sqgrt:

sqrt sum z orig z 2 = np.sqrt(sum z orig z 2)

sgrt sum z fin z 2 = np.sqrt(sum z fin z 2)

div_sqgrt = sgrt sum z fin z 2 / sqgrt sum z orig z 2

#4 3.4 Calculate Altitude Index (AI):

Al = (div_sqgrt - 1) * 100

arcpy.AddField management (final table, "AI", "FLOAT")

rows = arcpy.UpdateCursor (final table)
for row in rows:
row.setValue ("AI", AI)
rows.updateRow (row)
del row
del rows
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### 4.Calculate Slope Index
## 4.1 Import values for s orig, s fin:

data S orig=[]
data S fin=[]

with arcpy.da.SearchCursor(path, "S orig") as sCursor:
for row in sCursor:
data S orig.append(row[0])

with arcpy.da.SearchCursor (path, "S fin") as sCursor:
for row in sCursor:
data S fin.append(row([0])

## 4.2 Calculate (abs(s orig - s fin))/90:

delta S = np.subtract(data S orig, data S fin)
delta S abs = np.absolute(delta_S)
delta S abs 90 = np.true divide(delta S abs, 90)

#4# 4.3 Calculate Slope Index (SI):
SI = np.mean(delta S abs 90)
arcpy.AddField management (final table, "SI", "FLOAT")

rows = arcpy.UpdateCursor (final table)
for row in rows:
row.setValue ("SI", SI)
rows.updateRow (row)
del row
del rows

Ynohoviopydc Agiktn MpoocavaTohiopou

### 5.Calculate Aspect Index
i 5.1 Import values for as orig, as_ fin:

data as orig=[]
data as_ fin=[]

with arcpy.da.SearchCursor (path, "As orig") as sCursor:

for row in sCursor:
data as orig.append(row([0])

with arcpy.da.SearchCursor (path, "As fin") as sCursor:
for row 1in sCursor:
data as fin.append(row[0])
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## 5.2 Reduction from 360° to 180°:

reduction 1 orig = [x 1f x<180 else np.subtract(x,360) for x in
data as orig]
reduction 1 fin = [x 1f x<180 else np.subtract(x,360) for x in

data as_ fin]
## 5.3 Calculate abs(reduction 1 orig - reduction 1 fin):

abs delta reduction 1 = np.absolute(np.subtract(reduction 1 orig,
reduction 1 fin))

## 5.4 Reduction from 360° to 180°:

reduction 2 = [x 1f x<180 else np.subtract(360,x) for x in
abs delta reduction 1]

## 5.5 Calculate abs(reduction 1 orig - reduction 1 fin) / 180,
after reduction: reduction 2/180:

abs delta reduction 2 180 = np.true divide (reduction 2,180)
#4# 5.6 Calculate Aspect Index (AsI):
AsI = np.mean(abs delta reduction 2 180)

arcpy.AddField management (final table, "AsI", "FLOAT")
rows = arcpy.UpdateCursor (final table)
for row in rows:
row.setValue ("AsI", AsI)
rows.updateRow (row)
del row
del rows

YTpoyyuhonoinon AgIKTWYV

### 6.Round Values
#4# 6.1 Calculate round to fields:

arcpy.CalculateField management (final table, "LI","np.round (!LI!,
decimals=2)","PYTHON 9.3","import numpy as np")
arcpy.CalculateField management (final table, "AI","np.round (!AI!,
decimals=0)","PYTHON 9.3","import numpy as np")
arcpy.CalculateField management (final table, "SI","np.round (!SI!,
decimals=2)", "PYTHON 9.3","import numpy as np")
arcpy.CalculateField management (final table, "AsI","np.round (!AsI!,
decimals=2)", "PYTHON 9.3","import numpy as np")
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#4# 7.Final Table
## 7.1 Collect and Calculate Final Data
arcpy.AddField management (final table, "LI c", "TEXT")
arcpy.AddField management (final table, "AI c", "TEXT")
arcpy.AddField management (final table, "ALI", "FLOAT")
arcpy.AddField management (final table, "ALI c", "FLOAT")
arcpy.AddField management (final table, "SI c", "TEXT")
arcpy.AddField management (final table, "AsI c", "TEXT")
arcpy.AddField management (final table, "DoTRA", "FLOAT")
arcpy.AddField management (final table, "DoTRA c", "TEXT")
arcpy.CalculateField management (final table, "ALI"," (((!LI!*0.8)+ ((!A

I!/100)*0.2)))","PYTHON 9.3")

arcpy.CalculateField management (final table, "ALI c","!ALI! *

10", "PYTHON 9.3")

arcpy.CalculateField management (final table,"ALI c",'"np.round (!ALI
c!, decimals=0)","PYTHON 9.3","import numpy as np")

arcpy.CalculateField management (final table,"LI c",
"LI cat(!LI!)","PYTHON 9.3","""def LI cat(x):

1f 0<=x<=0.15:
return 'Class 1'
elif 0.16<=x<=0.25:
return 'Class 2'
elif 0.26<=x<=0.35:
return 'Class 3'
elif 0.36<=x<=0.45:
return 'Class 4'
elif 0.46<=x<=0.55:
return 'Class 5'
elif 0.56<=x<=0.65:
return 'Class 6'
elif 0.66<=x<=0.75:
return 'Class 7'
elif 0.76<=x<=0.85:
return 'Class 8'
elif 0.86<=x<=0.95:
return 'Class 9'
elif 0.96<=x<=1:
return 'Class 10'""")

arcpy.CalculateField management (final table, "AI c",
"AT cat (!AI!)","PYTHON 9.3","""def AI cat(x):

1f 0<=x<=10:
return 'Class 1'
elif 11<=x<=20:
return 'Class 2!
elif 21<=x<=30:
return 'Class 3'
elif 31<=x<=40:
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!AsI c!,

return 'Class
elif 41<=x<=50:
return 'Class
elif 51<=x<=60:
return 'Class
elif 61<=x<=70:
return 'Class
elif 71<=x<=80:
return 'Class
elif 81<=x<=90:
return 'Class
elif 91<=x<=100:
return 'Class

if 0<=x<=0.05:
return 'A'
elif 0.06<=x<=0.1
return 'B'
elif 0.16<=x<=0.3
return 'C'
elif 0.31<=x<=0.6
return 'D'
elif 0.61l<=x<=1:
return |E| mwmnn

1f 0<=x<=0.25:
return 'A'
elif 0.26<=x<=0.5
return 'B'
elif 0.51<=x<=0.7
return 'C'
elif 0.76<=x<=1:
return 'D'"""

10'""")

5:

O:

O:

)

0:

5:

)

if SI is "A" and AsI is
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return 0.12
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"AsI cat(!AsI!)","PYTHON 9.3","""def AsI cat (x):
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if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

if

SI is "D"

return 0.

SI is "D"

return 0.

SI is "D"

return O.

SI is "D"

return O.

SI is "D"

return O.

SI is "D"

return 0.

SI is "D"

return 0.

SI is "D"

return 0.

SI is "D"

return O.

SI is "D"

return O.

SI is "D"

return O.

SI is "D"

return 0.

SI is "E"

return 0.

SI is "E"

return O.

SI is "E"

return 0.

SI is "E"

return 0.

SI is "E"

return 0.

SI is "E"

return O.

SI is "E"

return O.

SI is "E"

return O.

SI is "E"

return 0.

SI is "E"

return 0.

SI is "E"

return 0.

SI is "E"

return 0.

SI is "E"

return O.

SI is "E"

return O.

SI is "E"

return O.

SI is "E"

return 0.
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AsI
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ALT
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if SI is "E" and AsI is "B" and ALI is 7:
return 0.63

if SI is "E" and AsI is "B" and ALI is 8:
return 0.66

if SI is "E" and AsI is "B" and ALI is 9:
return 0.69

if SI is "E" and AsI is "B" and ALI is 10:
return 0.73

if SI is "E" and AsI is "C" and ALI is 1:
return 0.51

if SI is "E" and AsI is "C" and ALI is 2:
return 0.54

if SI is "E" and AsI is "C" and ALI is 3:
return 0.58

if SI is "E" and AsI is "C" and ALI is 4:
return 0.61

if SI is "E" and AsI is "C" and ALI is 5:
return 0.64

if SI is "E" and AsI is "C" and ALI is 6:
return 0.68

if SI is "E" and AsI is "C" and ALI is 7:
return 0.71

if SI is "E" and AsI is "C" and ALI is 8:
return 0.74

if SI is "E" and AsI is "C" and ALI is 9:
return 0.78

if SI is "E" and AsI is "C" and ALI is 10:
return 0.81

if SI is "E" and AsI is "D" and ALI is 1:
return 0.59

if SI is "E" and AsI is "D" and ALI is 2:
return 0.63

if SI is "E" and AsI is "D" and ALI is 3:
return 0.66

if SI is "E" and AsI is "D" and ALI is 4:
return 0.69

if SI is "E" and AsI is "D" and ALI is 5:
return 0.73

if SI is "E" and AsI is "D" and ALI is 6:
return 0.76

if SI is "E" and AsI is "D" and ALI is 7:
return 0.79

if SI is "E" and AsI is "D" and ALI is 8:
return 0.83

if SI is "E" and AsI is "D" and ALI is 9:
return 0.86

if SI is "E" and AsI is "D" and ALI is 10:
return 0.89""")

arcpy.CalculateField management (final table, "DoTRA c",
"DOTRA cat (!DoTRA!)","PYTHON 9.3","""def DoTRA cat (x):
if 0.08<=x<=0.15:
return 'Very Low'
elif 0.17<=x<=0.25:
return 'Low'

elif 0.26<=x<=0.40:



return 'Intermediate'
elif 0.41<=x<=0.58:

return 'High'
elif 0.59<=x<=0.89:

return 'Very High'"""™)

### End of code
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KepdaAaio 4

Epappoyn Tou epyaieiou “TRAC”

H avdntuén Tou epyaleiou “TRAC” npaypatonombnke pe TNV TauTOXPOVN
dleknepaiwon dOKIPWY o pia oelpd and Yn@PionoiNPEVous xAPTEG €101 WOTE VA
d1aoPaAIoTEl N owoTh ekTéAeon TOOO Twv OIEPYACIWV YeweneEgpyaoiac 600 Kal Tou

KWOIKa Nou npaypartonolel Tov unoAoyiopd tou Babpou petaoAng avayAdgou.

Ye auTtd 1O KedAAalo, napouoidleTal pia epappoyn TnG diadikaoiag unoAoylopod Tng
peTaBoAnig Tou avayAdgou oe Tpia oTddia unaidpiag ekueTdAAeuoNng oTnNV NEPIOXA TwWV
AaTtopeiwv «KAMMOZL A.E.» otn nepioxn Tng Bdpng AtTikrig, oUpgwva pe Tn pébodo

“LETOPID” a&onoiwyvrag 1o avenTuypévo gpyaleio “TRAC”.

Ztnv napouoa epapuoyn, To epyaleio exTeAeiTal pia gopd yia 1o k&Oe éva and Ta

ak6Aouba oTddia:

A) Apxikn ExpeTdMeuon
B) TeAhikrl EkperdAeuon

N Enixwpdtwon

MapakdTw, neprypdgovtal avaAuTikd Ta Bripata nou akohouBribnkav yia 1o oTddI0
TNG APXIKAG EKUETAANEUONG:
o ExTéAeon Tou gpyaleiou “TRAC” pe dInAd kAik and 1o Catalog (Boribeia yia Tnv

eykatdotaon Tou gpyaleiou o1o ArcGlIS éxel evowpaTwOel oTo napdpTtnua |)

e-ooaly 3| E- 2%
Locaﬁon:lamTRAC

=l
B £ Calculate TRA N
= Database_TRA.adb

=l @ Toolbox_TRA

B | RAC

E' dotra.py

G
o

Le
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e Avaduetal To napdBupo diaAdyou Tou epyaleiou

"ex TRAC ] =(0] x|
=
© Original Surface (Shapefile)
|
¥ Final Surface (Shapefile)
I
& Boundaries (Shapefile)

© OutputX, Y, Z, As, S

» doTRA

o S e [

E|

oK Cancel | Environments... | ShowHelp >> |

e [lpoodiopidovral Ta apxeia nou nNEOKeITal va ene&epyaoTolv Kkal n Ttonobeoia

anofrikeuong Twy eéaydpevwy apxeiwv e TNV nAnpogopia Tng peTaBoAng Tou

avayAdpou
-lolx]
Original Surface (Shapefile) _I
| C:\Apxeia GIS\ammos\shape files kwstas xristopoulos\arxiko.shp E"I
Final Surface (Shapefile)
| C:\Apxzia GIS\ammos\shape files kwstas xristopoulos\arxikiekmet.shp
Boundaries (Shapefile)
| C:\Apxeia GIS\ammos\shape files kwstas xristopoulos\orio.shp E"I
OutputX, Y, Z, As, S
| C:\Apyeia GIS\Calculate TRA\Database_TRA.qgdb\fc_arxikiekmet_ E"l
doTRA
| C:\Apxzia GIS\Calculate TRA\Database_TRA.gdb\table_arxikiekmet_ gl
=
OK I Cancel I Environments... I Show Help >> I
e Apiotepd KAk oTo OK kal To epyaleio EEkIVA va «TPEXEN»
TRAC |
|
Executing TRAC... Cancel I
( ) Details >>
™ Close this dialog when completed successfully
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e ‘Otav n ektéAeon Tou epyaleiou oAokAnpwOei, Ta apxeia pe TNV ¢nTolpevn

nAnpogopia €xouv anodnkeutei otnv oplopévn Tonobeoia kal €lodyovTal

autépata otnv neploxn Tou nivaka neplexopévwy (Table Of Contents). To

feature class, nou eival o kAvaBog Twv onpeiwv Pe TIC NANPOPOPIEG UPOPETPOU,

kA\iong, kal npooavatoAiopol Twv OUo enipavelwy, npoBdAerar kal otnv

nePIOXN EPPAVIONG TWV OEDOPEVWV.

=
%:[0]G 8| & .&gﬁg&&tm
= £ Layers .ﬁ&ﬁ%ﬁﬁaaﬁa‘ﬁﬂu
B 3 C:\Apxeia gs\cdmlahe TRA\Database_TRA.gdb ﬁﬁ!&!ﬁ%lﬁ!ﬁaﬁiﬁﬁiiﬁ
B fasea e
& table_andkiekmet gt HR I R,
s R e,
SRR IR R R BRI,
manmaH i RN RN
e
SRR IR R R BRI
gmannan iR aR i
R
HEHRmEH R
SRR RR AR
T
HIRER R BRI =
TRRHIRERIRHRTHE
HEHE
P R ERIRS Iﬂl

e Me O¢g&f khik kar Open Attribute Table oto feature class nou €xer dnpioupynOef

anoktoUpe  npoéofacn  OTIC  NANPOPOPIEG

npooavatoAiopou yia kdbe onpeio Tou kavdafou.

'::@ & |

E =/ Layers
= C:\Apxeia GIS\Calculate TRA\Database_TRA.gdb

uopéTpou,

=]
o | Copy
EH table_a] X Remove

[F] Open Attribute Table

Joins and Relates

i) Zoom To Layer

B i

OBJECTID *

Shape *

POINT_X

POINT_Y

Z_orig

Z_fin

S_orig

S_fin

As_orig

KAfong

As_fin

Point

-12158.603203

8747.604965

148

151

5.051153

20.72256

278

172

Point

-12148.603203

8747604965

150

150

7.125016

21.19138

270

178

Point

-12138.603203

8747604965

151

152

7.667577

28.57163

292

189

Point

-12128.603203

8747.604965

153

154

8.984877

32.56238

288

183

niblW N —

Point

-12118.603203

8747.604965

155

153

8.984877

28.31608

288

176

Kdl
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e Me 0g&f kMhik kar Open oTov nivaka nou é€xel dnuIoupynOei anokToUpe

npooBaon otov Babud peraBoArig avayAipou

Table Of Contents
“[8]s 8|

[E = Layers
= C:\Apyeia GIS\Calculate TRA\Database_TRA.gdb
=] fc_arxikiekmet

@%m

Joins and Relates

X R;emove
Data 4
Ll Al st Asl Lic Al c ALl ALl_c Sl_c Asl_c DoTRA DoTRA_c |
0.33 42| 0.13| 0.34|Class3  |[Class5 | 0.264| 3B |B 0.26 |Intermediate

Me épolo Tpéno, ekTeleiTal To epyaleio yia 7o oTddIo TNG TEAIKAG eKPETAMEUONG Kal

Yl TO 0TAdIO TNG ENIXWHATWONG.

Ta anoteAdéopata nou npogkuPav and Tnv ekTéAeon Tou gpyaleiou yia Ta Tpia

d1aPopPETIKA oTddIa napouoiddovTal otov nivaka 4-1:

Mivakag 4-1 XuykevTpwTikd anoteAéopara and 1o gpyaleio TRAC

2tadlo LI Al ALl Sl Asl DoTRA DoTRA Class
Apxkn

EkpetalAevon 0.33 0.42 0.3 0.13 0.34 0.26 Intermediate
Telwkn

EkpetalAevon 0.45 0.65 0.4 0.17 0.40 0.33 Intermediate

Emywpdtwon 0.26 0.16 0.2 0.14 0.39 0.23 Low

O ouvoAIKOG anaItoUpevog XPOvog yia TNV ouykévipwon Tou Babpol petaoirig

avayAdgou kal yia Ta Tpia otddia TNG und PeAETNG neploxnig NTav 3.4 min, Nou evw

pnopel va diapépel and unoloyloti o unoloyiotd pe Bdon Tnv enefepyaoTiki Tou

loxU, eival gavepri n paydaia peiwon Tou anaitodpevou xpovou ekTéheong and Tnv

xelpokivntn péBodo.
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KepdAaio 5

YupnepdopaTa — 2XoMaouog

2kono¢ TnG napouoac dINAWHATIKAG €pyaciag nTtav n avdntuén gpyaleiou yia tnv
autopartonoinon Tng O1adikaoiag ekTiynong kal unoAoylopoU TnG MPETABOANG Tou
avayAdpou oe unaibpieq ekpetaledoelg, pe Bdon tn pebodoloyia “LETOPID”. H
peBodoAoyia autr, yéoa and Tov unoAoyiopod Tou Badpou petaBoAng Tou avayAdgou,
EMITPENEI TNV MOOCOTIKA EKTIUNON TWV EMNNTWOEWY OTN POPPN KAl TIG YPAUMUEG TOU

apxikoU avayAdpou and PeTaMeUTIKG €pya.

To epyaleio avantuxOnke oe nepiBdMov  ArcGIS xpnolgonoliwvrag Tn  yAwooad

npoypappatiopgod PYTHON, n onoia eival oupBatn pe 1o ev Adyw 2.

O xprioTn¢ kabopiCel pévo Ta dedopéva el00d0uU kal eE000U, xwPIG va enepPaiver oTIq
ouvOeTeC dlepyaoieq yewene&epyaoiag kal oTaTioTIKAG avdAuong Oedopévwy  OTa
evdidpeoa otddia, e&aopahiidovrac €rol Tnv Tunonoinpévn enefgpyaoia SAwv Twv
dedopévwy. H tunonoinon 6Awv Twv evoidueowy oTadiwy, dNAAdN Twv NAPAPETPWY,

npoodidel enavaAnPiudTNTa KAl AVTIKEIMEVIKOTNTA OTNV eKTEAeON TNG O1adIKAOIAG.

Ta evdidueoa otddla Tou povrédou, aplOuouvral oe 48 ek Twv onoiwv Ta 24
anotelolv gpyaleia yeweneéepyaoiag, Ta 23 npoowpivd apxeia dedoUEVWY dlIapOpwV
TUNWY PE TIGC analtoUPeveG NANPoopiec kal To Tedeutaio 1 anoteAsital and €vav
kKWOIka 750 ypappwy, dopnpévo oe yAwooa Python, nou ekteAei Tnv oTaTioTIKA
eneEgpyania Twy NANPOPOPIWV Kal unoAoyidel kar KaTNyopIonolel Toug OEIKTEG yIa TNV

ektipnon BaBud peraBoAng avayAdgou.
To epyakeio nmou avanTtuxOnke ovopdotnke “TRAC” (Topographic Relief Alteration

Calculator- Ynohoyiop6g Metafohng AvayAdgou).

Ta kUpia opéAn nou e&dyovTtal and Tnv avdantuén Tou gpyaleiou “TRAC” péoa and Tnv

napovoa dInAwpaTIKA epyacia eival Ta akdAouba:

- H anlonoinon tng peBodoloyiag péoa and tnv autopaTonoinor TNG kai TNV
napouoiaon TnG evrog evog giAikou nepiBdAlovrog. Katd autév Tov Tpdno,
xwpi¢ 101aiTepn epneipia oe Aoylopikd XM, o exkdotote xpriotng (1ID1LTNG,

gPEUVNTAG, ONPOOIOG POPEAG N EAEYKTIKOG INXAVIOPOG) Pnopel oe Aiyo xpoévo

104



va edyel Tnv nAnpogopia TnG peTaBoAng Tou Toniou and TNV APXIKA TOu
HoPPN.

- H paydaia peiwon Tou anairodpevou xpovou yia Tn OleknePaiwon Tou
ouvélou TnG dladikaoiag oe oxéon pe TN xelpokivntn pébodo (ndvw and 75%
Y10 €EOIKEIWPEVOUG XPNOTEG PE TN peBodoAoyia).

- Ta anoteAéopata nou e&dyovral and TO E€PYAAEio  evowpatwvovTal OTO
nepifdAov Tou T2, nou emiTpénel TNV NepaItépw eneégpyaocia Toug (oUykpion
anoteAeopdTwy, Onpioupyia kal aneikévion ypanudtwy, anobrikeuon o€
KOIVA yewypa@ikn Bdon OedoévwY).

- Aegv anaiteital n eykatdotaon — ayopd AoylopikoU unoAoyIoTIKWY GUAwY  yia

oTaTIoTIKA avdAuon.

Téhog, n  OAn  pebodoloyia  avdnTtuénc TOu OUYKeKPIMEVOU  gpyaleiou  OnNwg
napouoidderar otny napoloa €epyacia, QAVEPWVEI TIG OUVATOTNTEG MMOU  €XOUV
oUyxpova AoylopikG va  dleukoAUvouv kal va anAonolodv TIGC UMNNPECIEG Mou

NAPEXOVTal 0TO XPNroTn.
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Eykatdotaon tou gpyaieiou “TRAC” oto ArcGlS
&

ZUVONTIKN MEPIYPAPN XPNoNng
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MNa Tnv eykardotaon Tou epyaieiou “TRAC” npoteivovTtal Ta napakdTw Bripara:

1) Anooupnieon Tou apxeiou “TRAC.7z”

2) Metakivnon tou gakédou “TRAC” oe TonoBeoia Tou okAnpou diokou nou eival
«ouvOedepEvN» (connected folder) pe to Catalog tou ArcGIS 1 oe Tonobecia
TOou okAnpou diokou nou Ba «ouvoebel» pPeTENeITA.

3) Evrog tou ArcGlS, av n Béon Tou okAnpouU nou nepiéxel Tov pdkero “TRAC” dev
givar ouvdedepgevn, ouvdgetal pe Tnv eviodl “Connect To Folder”, kal o
PpAkeAo¢ NAéov pnopel va «diaBaoTei» and 1o Catalog.

4) To epyaheio eival €roipo yia exktéheon oto ArcGIS and to Catalog pe dInAS KAk
oto C:/.../TRAC > Database_TRA.gbd > Toolbox_TRA > TRAC

‘Ooov agopd Tnv xprion Tou epyaleiou “TRAC” €xouv ocuyypagel ota ayyAikd
NEPIYPAPEG yIa TNV Aeitoupyia Tou gpyaleiou kal ene&nynuatikd oxoAia yia kdbe
apxeio nou npgnel va eioaxfei (nx Eikéva [-1). Ta Tnv npofoAn Toug oTO
napdBupo OlaAdyou Tou epyaleiou eniAéyetar To “Show Help”, i ekteleitar n

evroAl “Item Description” (de&l kAik oT0 €pyaleio > Item Description...) and 1o

Catalog.

© Original Surface (Shapefile)

& Final Surface (Shapefile)

& Boundaries (Shapefile)

© OutputX, Y, Z, As, S

© doTRA

I

OK

| Cancel | Environments... I << Hide Help

_|0O] X

TRAC

Calculates Topograpfic
Relief Alteration, as
introduced by the method
named

"LETOPID" (Landscape
Evaluation Tool for Open
Pit Mine Design), from
contour data of the original
surface and the surface
under invesigation in
shapefile format. For the
measurement of the TRA
five indices are taken into
account [Landform Index
(L), Altitude Inex (Al),
Adjusted Landform Index
(ALl), Slope Index (Sl) and
Aspect Index (Asl)]

)

Eikéva M-0-1 Mapddeypa ektéAeong "Show Help" oto napdBupo diaAdyou Tou gpyaleiou
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Tool Name: TRAC

Description: Calculates Topograpfic Relief Alteration, as introduced by the method

named "LETOPID" (Landscape Evaluation Tool for Open Pit Mine Design), from

contour data of the original surface and the surface under invesigation in shapefile

format. For the measurement of the TRA five indices are taken into account [Landform
Index (LI), Altitude Inex (Al), Adjusted Landform Index (ALl), Slope Index (SI) and
Aspect Index (Asl)]

Parameters:
1. Original Surface (Shapefile)
2. Final Surface (Shapefile)
3. Boundaries (Shapefile)
4. Output X,Y,Z,AS,S (Feature Class)
5. doTRA (table)

Explanation:

1.
2.
3.

The shapefile with the contour data of the original surface
The shapefile with the contour data of the surface under investigation
The shapefile with the boundaries of mining activity (if not possible, it is
recommended to set as boundaries the final surface's shapefile)
The output feature class containing a mesh of coordinated cells (XY) with the
elevation (Z_orig, Z_fin), aspect (As_orig, As_fin) and slope (S_orig, S_fin) data
of both original and final surface
The output table containing the degree of Topographic Relief Alteration
(doTRA) as well as the following indices:

e LI: Landform Index

Al: Altitude Index
e ALl: Adjusted Landform Index

e Sl: Slope Index

e Asl: Aspect Index

e ALl_c: Adjusted Landform Index Class
e Sl_c: Slope Index Class

e Asl_c: Aspect Index Class

e doTRA_c: degree of Topographic Relief Alteration Class
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F'vwoTd opdAuara:

To napakdTw opdApa katd Tnv ekTéAeon Tou KWOIKA Tou gpyaleiou, oupPaiver éTav To
apxeio nou éxel opioTel oav 6pio TnG ekpeTdMeuoncg [boundaries (shapefile)] kai
avTinpoownevel éva noAlywvo nou oploBeTel Ta apxeia Tou apxikoU kar Tehikou

avayAugpou, katahapfdvel peyaAitepn €ktaon and Ta apxeia Tou apxikoU i TeAikou

avayAdeou (Eikéva M1-2).

Traceback (most recent call last):

File "C:\...\TRAC\python TRA.py", line 90, in <module>

var z fin = np.var(data z fin)
TypeError: unsupported operand type(s) for +: 'int' and
'"NoneType'

Failed to execute (Python Script).
Failed to execute (TRAC).

'Opia EkPeTaAAguong
- IooUyeig apxeiou Q

MAnpogopia UWopETPOU
ano 100UYEiG apyeiou

g

Eikéva -2 Tpagikn aneikdvion apxeiwv Pe Ta onoia dnpIoupyeiTal opdApa kaTd Tnv eKTEAEON TOU
gpyaleiou
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Aidypappa Pong Epyaoiwv Epyaieiou “TRAC”
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